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INTRODUCING MAGNIFI 4

The Ectane™ instrument is operated by Magnifi, a powerful and easy-to-use acquisition and
analysis software. It is designed for a wide range of nondestructive testing techniques dedicated

to tubing and surface inspections and relies on intuitive wizards to configure setups.

Magnifi has a graphical user interface (GUI) designed to simplify the inspection process and
enhance your experience. Through the GUI, all the functions associated to inspection project
management, the global settings, and the preferences are in what is referred to as the
backstage view. All inspection work, calibration, acquisition, and analysis is in what is referred
to as the front stage view. This is how Magnifi offers a streamlined and coherent interface that

makes the learning process easy.

BACKSTAGE OVERVIEW

At the opening of Magnifi, the backstage view is displayed. It is composed of eight sections that

supply different information.

The default section and first section of the backstage view is the General section, which

contains information about:

e Probe currently connected to Ectane

e Selected project and inspection folders
e Currently loaded setup and data

General

Project Folder:

General

Magnifi® 4.5RS - [Default setup]

Project / Inspection

. \Documents\| ifi\Projects\Default

Inspection Folder: C:\U- \Documents\Magnifi\Projects\Default\ Default
Acq. Summary Setup / Data

Setup Loaded:  Default setup

Setup Location:  Ci\User "Doc \Default
Report summary

Data Loaded:

Acquisition

Filename: Prefix -

-001.magdata

Material Database

Report

Name:

Documentation Table Profile:

Preferences

Start / Resume
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Report.mdb -

Generic Array v

[] Take screenshot with report entry

[ ] i
Inspection Transfer
R sub-folder Inspection
n . 1
—
Create Setup Open Setup Open Data
Create NewList| | Import List
:

Generate
Report

Export Report

Figure 1 Backstage

Information
Prabe: Unable to detect
Application: Generic
Surface Dimensions:

WE 211mm

Width: 1000 mm

Length: 1000 mm
Material:  Stainless Steel 316

Frequencies: 500.0 kHz

Width s+



This is also where you:

e Create or open a project folder

e Create, open or transfer an inspection sub-folder

e Create or open a setup

e Opendata

e Select the file naming format

e Create or import a list of file names

e Choose the report table profile and automatic screen capture option
e Generate or export a report

Under many circumstances, this is the only section that is needed to manage inspection
projects.

Other sections of the backstage are described below.

FRONT STAGE OVERVIEW

The front stage displays all the information about your current inspection. This is where you will
find all the tools to acquire, save and analyze inspection data.

Continue reading the following sections of the document for additional information on the
available tools and functions.

2 3 4
| Ei¥ | Magnifi® 4.5RS - [Default setup] =P =
1& Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Cuvren|\lizw| -nl
5 ® = o
L. B & 't o ST :
Setup Null  Previous Lead Next  Re-scan Lead Save  savefAs. Clear KSR Preferences | Content  Full Best  Center Mo Capture  Add palerte
Mode File File Setup Setup Extent Fit Defect Note
B BRIERE 1 ooV J=] [L] ] o )] [t ooy J) [ ] e JFl] T 00t [t 1000V,
- - 500.0 kHz
o
F=]
2|
10 ]
H
g
-
—5
EE2E R [er ] o7 )
Q— 0o center i Repnnl
T AT ) ) A AR (Hz)
8—e | ] T ] [0 va |

~ —
o

Figure 2 Front stage
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1. Backstage icon alternative method would be to use
Click to access to backstage view. the data tab (see 10).

2. Quick access toolbar 7. Information
Customizable toolbar to provide This area displays information about
access to the commands you use the cursor position, measurements and
most often. acquisition parameters.

3. Ribbon-style menus 8. Keyboard arrow mode selector
These nine menus allow you to Click to change the operational mode
perform several inspection operations. of the keyboard arrows.

4. Statusicons 9. Information tabs
These icons convey unit status Click on the tabs to display
information graphically. notification, information,

5. Data display area documentation or report content.
This area is where you see the 10. Data tabs
inspection data. Click on the tabs to display the list of

. . data, DQV tool, Screening tool and

6. File navigator
Use the file navigator to open and notes.
display files in the data area. An

VIEWS

Views vary according to the type of probe or technology you are using. You can select layouts
or set one up yourself. This section introduces the various elements of available views.

Note that some elements of a view are automatically removed when the view is resized smaller.
To display all the elements of a view, increase its size until they reappear.

(-] J e JelJl [ oo |owoov | [-]. [t o0oc |1 m0ov
500.0 kHz CIF1 500.0 kHz
| Vppf‘| ’ppf‘l ;:j“l 2P| M | | PIT ] PIT | [ Vppf‘l ’ppf‘| ;j'_‘l 2P| M | | PIT |

Figure 3 Elements removed/added depending on view’s size
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STRIP CHART VIEW

12 3 4 5 ¢ 1. Link button
l,l l.l A;” Fl%l i mlov T Views with the same number are linked. Changing
9—|Bo,okHz//_/[ the channel/C-scan or frequency of a linked view
also modifies all the other linked views.

2. Global channel/C-scan selector
Regroups the channel/C-scan and frequency
selectors in a single button.

Channel/C-scan group name selector
Frequency selector

Scale

. Signal component selector

Vertical arrow for the vertical component of the
Lissajous or horizontal arrow for the horizontal
component of the Lissajous.

o~ U AW

N

Data area

8. Cursor
Figure 4 Strip Chart Only the data within the dashed cursors are
displayed in a Lissajous.

9. Information
Operating frequency.

LISSAJOUS VIEW

1] I
ANIERES [t a0 Jr 200v [ ] e ] [t w00t T 3oov
19 —480.0 kHz \\ F1A26
80« —7
17 r
16 —q1.41v 59° \\‘ 76.6% ODp—8 1.89V 231° .
HEYEED [ cor .| cor $—9 EYEYEED [[or ] or ]
SRS
Iul
— ﬁ 10

15 14 1312 1
Figure 5 Lissajous (2 examples)
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1.

N

10.

Link button

Views with the same number are
linked. Changing the channel/C-scan
or frequency of a linked view also
modifies all the other linked views.

Global channel/C-scan selector
Regroups the channel/C-scan and
frequency selectors in a single button.

Channel/C-scan group name
selector

Frequency selector

Rotate

Warning: Displayed number
corresponds to the Lissajous’ rotation,
not the signal’s phase angle
measurement.

Scale

Data area

Displays data located inside the cursor
of the corresponding strip chart or C-
scan.

. Sizing measurement

Measurements available only when a
sizing curve corresponding to the
displayed channel has been created
and calibrated.

Report/Indication codes

Click to add an indication
corresponding to the selected code in
the report. Long click to edit.

Mini Strip Chart area

Displays two strip charts: Vertical
(left) and horizontal (right)
components of the Lissajous. When
mini strip charts are used, data
displayed in the Lissajous corresponds
to the data within the mini cursors
identified with blue dashed lines.

14| Page

1.

12.

13.

14.

15

16.

17.

18.

19.

Manual measurement
Use the mouse to manually trace a
measurement vector in the Lissajous.

Two-points measurement

Activates two additional cursors in the
strip chart. The measurement vector
in the Lissajous is based on the data
located at the position of the two
cursors.

Invert phase angle measurement
Invert the direction (z 180°) of the
measurement vector in the Lissajous.

Phase angle measurement mode
Phase measurement illustrated by the
red dashed line. Automatic
adjustment based on the
measurement mode used.

Amplitude measurement mode
Amplitude measurement illustrated by
the blue vector. Automatic
adjustment based on the
measurement mode used.

Signal measurement result
Based on the measurement modes
used.

Cursor position circle

Red circle over data point
corresponding to location of cursor in
strip chart or C-scan.

Null mark

Center of the Lissajous where the two
blue lines intersect. Corresponds to O

V for both the horizontal and vertical

axes.

Information

Operating frequency or array probe'’s
channel corresponding to cursor’s
position on C-scan.



VOLTAGE PLANE VIEW

11117 i’
INENER [t so0v
23 —4850 Hz 50.0 E ) 40.( 5
2———o |
21*—-\ é?
20 o Qe 7
) | T:45.2%
19 —4angle correction: 0.0° ! L:33.50% ¢+8
18 —44.38V 90° Ext: 360.0° ! S:50.0004
el wlalvl [elale] [oon ] or 49
=1 1 N
‘E mi‘ 10
7 16 1514 1312 1
Figure 6 Voltage Plane

1. Link button
Views with the same number are
linked. Changing the channel/C-scan
or frequency of a linked view also
modifies all the other linked views.

2. Global channel/C-scan selector
Regroups the channel/C-scan and
frequency selectors in a single button.

3. Channel/C-scan group name
selector

4. Frequency selector

5. Scale

6. Data area

Displays data located inside the cursor
of the corresponding strip chart.

10.

1.

12.

13.

14.

15

Cursor position circle

Red circle over data point
corresponding to location of cursor in
strip chart or C-scan.

Sizing measurement
Measurements available only when a
sizing curve corresponding to the
displayed channel has been created
and calibrated.

Report/Indication codes

Click to add an indication
corresponding to the selected code in
the report. Long click to edit.

Mini Strip Chart area

Displays two strip charts: Vertical
(left) and horizontal (right)
components of the Lissajous. When
mini strip charts are used, data
displayed in the Lissajous corresponds
to the data within the mini cursors
identified with blue dashed lines.

Save nominal
Saves the current adjustment to the
nominal value.

Back to nominal

Returns the signal back to the
nominal point previously stored using
the button “Save nominal”.

Normalize signal

Normalizes the displayed signal.
Brings the cursor position circle data
point to the (1,0) position.

Manual measurement
Use the mouse to manually trace a
measurement vector in the Lissajous.

Invert phase angle measurement
Invert the direction ( 180°) of the
measurement vector in the Lissajous.



16. Phase angle measurement mode

17

18.

Phase measurement illustrated by the
red dashed line. Automatic
adjustment based on the
measurement mode used.

Amplitude measurement mode
Amplitude measurement illustrated by
the blue vector. Automatic
adjustment based on the
measurement mode used.

Signal measurement result +
Circumferential extent of the
indication

Signal measurement result based on
the measurement modes used.
Circumferential extent based on flaw
coverage curves (see 22).

19. Angle correction

Displayed with red font if angle
correction is outside of accepted
tolerance.

20. Null mark

Center of the Lissajous where the two
blue lines intersect. Corresponds to O

V for both the horizontal and vertical

axes.

21. Theoretical nominal point

Corresponds to the intersecting point
of the flaw coverage curves.

22. Flaw coverage curves

From bottom to top: 90°, 180°, 270°
and 360°.

23.Information

Operating frequency.

No channel/C-scan/frequency selector in the header of a code
view. It regroups together information coming from all the

channels. Position of indications in the code view are directly

related to positions in strip charts.

Red background in the code view indicating that signal is

CODE VIEW
1 1. Header
2
4—e
2. Saturation
cor de—3

saturated. Often happens when the probe gets in the air.

3. Reported and detected indications
Position and width of the marks corresponding to position and
width of the cursor when indications were added. Clicking on
an indication in the code view automatically moves and
resizes the cursor to match this indication.

CRK |

4. Landmarks

Blue triangles pointing at the position of the landmarks.
Landmarks don't have a width.

Figure 7 Code
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INFO VIEW

The Info view displays information using large and easy to read numbers. It can be customized

to display information such as:

e Cursor position on the X or Y axis, in samples or units;

e Cursor width (A) along the X or Y axis, in samples or units;

e Acquisition rate;

e Maximum probe speed;
e Measured crack’s depth and length (Sharck™ probes only);

e Fftc.

The outputs provided by an Info view can be different during acquisition and analysis.

The view is automatically divided into the appropriate number of individual boxes to display all

the selected information.

Compensated

Depth {mm)

3.2

Length (mm)

12.3

Liftoff (mm)

0.2

Center X (mm)

292.0

Delta X (mm)

49.7

Center Y (mm)

24.0

Delta Y (mm)

15.8

Figure 8 Info (2 examples)




C-SCAN AND 3D C-SCAN VIEWS

1111 1]

1,1 .| A P, EJ
7
9 8

Ll & Jr
10—e2
Figure 9 C-scan (top) and 3D C-scan (bottom)
1. Link button horizontal arrow for the horizontal
Views with the same number are component of the Lissajous.

linked. Changing the channel/C-scan
or frequency of a linked view also
modifies all the other linked views.

7. Color palette
Double-click or go to current view
ribbon to edit.

2. Global channel/C-scan selector
Regroups the channel/C-scan and

8. Data area

) ) 9. Cursor
frequency selectors in a single button. Only the data within the 2D C-scan
3. Channel/C-scan group name cursor are displayed in a Lissajous and
selector in the 3D C-scan.

4. Frequency selector

5. Show/Hide color palette in the
view

6. Signal component selector
Vertical arrow for the vertical
component of the Lissajous or

10. 3D C-scan orientation
Click on the vertical or horizontal
arrows to change the orientation of
the 3D C-Scan.
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POLAR AND 3D POLAR VIEWS

—
.

L] el | R

Figure 10 Polar (top) and 3D Polar (bottom)

Link button

Views with the same number are
linked. Changing the channel/C-scan
or frequency of a linked view also
modifies all the other linked views.

. Global channel/C-scan selector

Regroups the channel/C-scan and

frequency selectors in a single button.

. Channel/C-scan group name

selector

. Frequency selector
. Show/Hide color palette in the

view

6.

[ -]

Signal component selector
Vertical arrow for the vertical
component of the Lissajous or
horizontal arrow for the horizontal
component of the Lissajous.

. Color palette

Double-click or go to current view
ribbon to edit.

. Data area
. Cursor

Only the data within the cursor are
displayed in a Lissajous.
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A-SCAN UT

{—O

=i

General ‘ Gates |

ScanDuration [3000mm |
Gain (26048

input Fitter [452aMHz ]

Rectificstion [ves  +]

Smoothing Filter [75MHz =]

10 9 8

Figure 11 A-scan UT

1. A-scan data area 7.
General tab
Regroups general information that
can be modified by the user, such as
the scan duration, the tension, the

filters, etc. 8

3. Gates tab
Regroups information about the
positions and dimensions of the gates.
Also, contains fields to adjust the
TCG. Fields can be modified by the
user.

4. Envelop
Click to activate the persistence of
the data on the screen. To clear the

9.

Back wall gate

Blue outlined box. Use the mouse to
adjust the position and dimensions.
Alternatively, the gates tab can be
used.

Front wall gate

Red outlined box. Use the mouse to
adjust the position and dimensions.
Alternatively, the gates tab can be
used.

Pin gate

Back outlined box. Use the mouse to
adjust the position and dimensions.
Alternatively, the gates tab can be
used.

cumulated data from the screen, .
10. Gain

disable the envelop option.

5. A-scan back wall
Zooms on the front wall and back wall
portions of the data to make it
possible to adjust the back wall.

6. Show/Hide A-scan UT view

6|Page

Identified by the yellow line. Flat
portion is the static gain. Angled
portion is the Time Compensated
Gain (TCG). Use the mouse to adjust
the position and dimensions.
Alternatively, the tabs on the right
can be used.



PROJECTION

n

WT: 276 mm| WL:0.1% |IR: 10.10 mm| ID: 19.84 mm|OD: 25.37 mm [dA: 389.0 mm | dC: 182.0 *|Tes: 2.65 mm| TRes: 9.92 mm | sWics: 426 %

WT: 2.76 mm|

[0 -120mm _[1 150mm ,

D

e 6

——8

10

View A-scan

o—d&|.”

Figure 12 Projections

C-scan view

For additional information, see the
previous section dedicated to the C-
scan view.

Infofields

Customizable infofields providing
information such as the wall
thickness, the wall loss, etc. Fields can
be added/removed.

Scale

Circumferential projection view
Cursor’s brackets

Automatically adjust to the wall

thickness at the location of the cursor.

Can be manually adjusted using the
mouse if necessary.

6. Nominal

Yellow portion showing the nominal
dimensions of the tube.

7. Cylindrical projection view
8. Report/Indication codes

Click to add an indication
corresponding to the selected code in
the report. Long click to edit.

9. Show/Hide A-scan UT view
10. ID/OD

|dentification of the OD and the ID of
the tube in the Circumferential and
Longitudinal projection views.

11. Longitudinal projection view
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Operating Magnifi 4
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BACKSTAGE DETAILS

The intent of the following pages is to highlight several key features and important details about
each section of the backstage in order to provide guidance and helpful information to the users
of Magnifi 4.

GENERAL SECTION

Magnifi 4.5RS - [..\DefaultMasterSetup\Sharck\SHARCK-BW0S3-G2. magsetup] -8 x
General
Project / Inspection Information
Project Folder: C:\Users\orousseau-cyr\Documents\Magnifi\Projects\Default Probe: SHARCK-BW053-G2
General
Inspection Folder: C:\Users\orousseau-cyr\Documents\Magnifi\Projects\Default\Default ro r‘) .6 Application: Carbon steel weld
Project Folder Inspection Transfer
Sub-folder Inspection Surface Dimensions:

Acg. Summary Seiup / Data WT: 211 mm

Setup Loaded: SHARCK-BW053-G2 [Madified) Width: 1000 mm

. N

Setup Location:  Default Master List £ " é Length: 1000 mm

Report Summary Data Lodeds Create Setup Open Setup Open Data Material: Carbon stee!
Freguencies: 20.0, 80.0 kHz
Acguisition
Filename: Prefix v
Weld -D01.magdata A_: _:
Create New List Import List

Material Database

Report

Name: Report. mdb = . N
Documentation Table Profile: Sharck Array v -

Generate
Take screenshat with report entry Report EremiEzed
Preferences
Start / Resume
Figure 13 Backstage — General Section
Project / Inspection
Project Folder: ChUsers\orousseau-gyr\DocumentsiMagnifiyProjecs\Default
Inspection Folder: ChUsers\orousseau-cyriDocuments\MagnifitProjects\Default\Default ro ro .5
. Inspection Transfer
Praject Folder ;
1 Sub-folder Inspection

Figure 14 Project / Inspection portion of the General section

Magnifi offers a two-level folders structure to stay organized. The higher-level folder is called
the Project. The second-level folder, or sub-folder, is called the Inspection. The Project folder
simply regroups together Inspection sub-folders that are related in some ways.
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For instance, a Project folder could be created for all the inspections to be performed during a
refinery shutdown. Each Inspection sub-folder could focus on a specific asset or component of
the refinery. All the files used and produced for a given Inspection are stored within the
Inspection sub-folder.

PROJECT
(ex: Refinery 04-17)

|
| l l

INSPECTION 1 INSPECTION 2 INSPECTION ...
(ex: Bundle No A1D3FX)

* Setups;

* Data lists;

* Data files;

= Screen captures;
* Notes;

* Reports;

Figure 15 Project / Inspection structure

The Project folder and Inspection sub-folder buttons open windows allowing you to add new
folders or browse and select existing ones.

A Default Inspection sub-folder gets automatically created when the Project folder is selected.
This Default Inspection sub-folder can’t be deleted or renamed.

B t1anage *
Inspections
anage Inspections elect Other...
.OM ge Inspecti Select Oth
MName State
Default Ready for | t
Bl select s project % efau eady for Inspection
DemoDatad.3 Inspection Done |Z|
« v 4 <« Magnifi » Projects » v O Search Projects el
DemoDatad.3 R Inspection Done |Z|
Oigaizeh Rlewolaey B o DemoDatad.4 Inspection Done |z|
[ This PC “  Name Type DemoDatad.4 R Inspection Done |z|
J 3D Objects Default File folder Mew inspection |Z|
I Desktop Project 1 File folder
2| Documents Project 2 File folder
N Project 3 File folder
4 Downloads
J! Music
=] Pictures
B videos
- 05(C) ol >
Folder: | Default
Select Folder Cancel
Add

Figure 16 Project / Inspection management windows
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The Transfer Inspection button is available only when an external drive is connected to the
computer. This button allows you to transfer Inspection folders with all their content between
the local drive and the external drive. The Inspections are transferred to the Project folder
selected with the drop-down menu. In the figure below, clicking on Export would copy the local
Inspection called New inspection in the Project called Project ABC located on the external

drive.
% Inspection Transfer X
.- Inspection Transfer
=] Select the Inspections you want to copy between the local and external drive.
Local Inspections Inspections on External Drive
Project: | Default < Project: | Project ABC <
Select All| [ Clear Al Select All | [ Clear Al
Name Mame
[] Default [] Component1 IXI
[] DemoDatad.3 (| Component 2 IZI
D Datad.3 R
L] Demobata IZI Import
[] DemoDatad.d Izl
@ Export
[] DemoDatad4dR |z|
2] imepeston | |

Figure 17 Inspection Transfer

Note that the Project folders that are detected and displayed in the Project drop-down menus
must be located at the following directories:

» USB Drive (D) + Magnifi * Projects
#» This PC » Documents » Magnifi » Projects »

Figure 18 Project folders directories for Inspection transfer
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SETUP AND DATA

Setup / Data

Setup Loaded: From original data file
e e '
Setup Location: ChUsers\orousseau-gyr\Documents\Magnifi'Projects\Default 0 =
Create Setup Open Setup Open Data
Data Loaded: PSBCO7T08-001

Figure 19 Setup / Data portion of the General section

A new setup can be created by clicking on the Create Setup button, which will guide the user
through a step-by-step process that differs for each inspection technique.

The Open Setup button is used to retrieve an existing setup from different locations such as
the Master List (user-configured), the Default Master List (installed with the software, can't
be modified) or from the Inspection sub-folders contained in the current Project folder.
Another option is to click on the Select Other... button to browse on your computer.

E open X
. Setup
0 Select a Setup Select Other...
Name Location

@ Current Inspection (1)

(%) Recent Files (5)

@ Master List (1)

(%) Default Master List @1)
® Default (2)

@ Inspection bundle 1 (3)

(%) Inspection bundle 2 (2)

ok | [ concel |

Figure 20 Open Setup window

The Open Data button allows you to load a data file from the current Inspection sub-folder.
It is also possible to browse on your computer to load a data file in a different location. The
location of the loaded file will become the current Inspection sub-folder.
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ACQUISITION

Acquisition

Filename: Zone, Row, Col ~

Zane-C D02001.magdata |__6 |__@

Create Mew List Import List

Figure 21 Acquisition portion of the General section

Four options are available to configure the file naming format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front

Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for heat exchanger tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for heat exchanger tubing
inspections.

For improved productivity, the names of the files to be acquired can be generated prior to the
inspection by using the Create New List button. Several different lists can be added in the
same Inspection.
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File List Configuration
| Zene A
Number of Rows in Compenent: |4 >
Start Numbering at Row: 2 >
Row Interval: 1 >
Mumber of Columns per Row: Data oo
Row MNb. of Columns T T T
2 z | Zone | Row | Col
3 3 A ooz oM
¢ : B A 002 002
> A 002 003
»oA 003 om
b oA 003 002
| Column Interval: 1 - b A 003 003
Include first and last column of each row
| Files to Create: 9 h A 0o4 o001
Filename Preview: A001001
oA 004 002
|+ Create & New ‘ ‘\/ Create | | x Cancel | b A 004 003

Figure 22 File List Creator (left) and generated list displayed in the data tab of the front stage
(right)

A complete List can be imported from a different Inspection folder by clicking on the Import
List button. Note that the complete List of files of an Inspection is automatically stored in a
file called FolderDescription.xml, located in the Inspection folder.

I open X

— Import inspection

=@ select a File
Name Location

@ Current Inspection (1)
FolderDescription.xml |z|

(¥) Default (1)

@ DemoData4.3 (1)

@ DemoData4.3 R (1)

® DemoData4.4 (1)

® DemoData4.4 R (1)

|\/ oK ||x Cancel |

Figure 23 Import List window

It is also possible to import a List created in the TubePro™ software, which is directly available
from Eddyfi™.
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REPORT

Report
MName: Report.mdb v
-
Table Profile: Tubing ECT h H— @ -
Generate Export Report
Take screenshot with report entry Report

Figure 24 Report portion of the General section

A selection of several defect table profiles to be displayed in the report can be selected from
the Table Profile drop-down menu. The information displayed in each profile is adapted to a
specific inspection technique.

Once the analysis of a data set is completed, the Generate Report button can be used to
produce a report. A few report parameters can be configured, such as the # of tube in
component, which is used to show the percentage of tubes in each category. Additional
customization of the report’s header, such as the company logo, can be done through other
sections of the backstage. Continue reading for more information.

I Generate Report X B Generate Report X
"L Section Selection V1% Report Summary
2= Sections to Include in Report B Configure the Summary Section
Defect Table Format: | Tubing ECT
efect Table Format: | Tubing Client » Izl
Report Summary
C tTy v
[ Show Empty Cells ponen (VPe) [x]
Instrument Settings ComponentS/N |z|
Component Information Site . lzl
Picture: | AcroRd32_2019-03-06_16-48-03,png
e - - ‘ [-] [%] Service Provider ™ %]
Inspection Summary
o Wark Order v 4
[/] Date and Signature Comment
Screen Captures
# oftubss i component: [15 2]

Figure 25 Generate Report windows for configuration of report’s parameters
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Analysis Report @ eddyﬁ Analysis Report @ eddyﬁ

Componentinformation Inspection Summary

Component S/N 1234 Component Type Heat exchanger faarsiption e
Tube Material Titanium Tube 00 19.05 mm N

# Tube Tested Total umber of tested tubes o
Toba Wt S Tabs Lot 0900 meen NDO Mo defect detected 12 4L0%
Total # of tubes » <10 Tutes reported i range < 10% walloss + s1%
10% - 19% Tubes 1ep0rted i rang 10% - 19% wal loss o o
20% - 29 Tubes reported i rangs 20% - 29% wal ogs o oo
r— Tubes 1eported I rangs 3% - 39% wal 033 o oo
T Tues reported i range 40 - 499 wal lozs o e
500 - 5% Tues reported i range 50% - 59% wal loss o e
0% - e Tutses reported i range 60% - 63% wal loss o e
70% - 7880 Tubes reported n range 70% - 79% wal loss o o
0% - B Tubes reported In range 80% - 89% wa los o oo
> 0% e roportad n anga > 00% vl ks 3 8%

Analysis Report @ eddyﬁ Analysis Report

Defect Table | | e |
col ol
[ | nabe | iediaen | toces ]
Gol. | code | size Chan omtset | v
djc: ¥ pos. | leng.
[
» 1w 3 o
1 0 o Mo ® 1 9 % Mo
B a1 w7 oo
ERE = 1 @ m o
s 1 4 v oo ® 1 @ & wo
s 1w om wo ® 1 % ® o
6 1 4 m e we | oRn iees o mes s 1 @ a o
7w ow me o s oFR TS o mms ® 1 @ = wo
B 1 4 & ok maw D 3 % oFn s o mms ¥ 1 m o4 mo
5 1w @ o= wew ® 2@ & oFa 7w o s = 1 n 7 o
W1 4 0 R SAN 0 2 ¢ OFR 7SS o mes ® 1 7 5 Mo
uor W oW ok e oFn TEss L
2 1 e 5 o Us s oWR 7SS o ams
IR AR NN, Signature: Date:
# 1 4 8 W
3 1 e om wo
® 1 & B wo
7 1 e @ omo
® 1 & @ wo
® 1w on wo
R
a1 e om0
a 1 & B W
2 1 e ¥ owo
® 1 % m wo
2 1 e om0
® 1 # = w0
7 1 % 2 wo

Figure 26 Example of a four-page report

The Report Viewer offers to save the report in the following format: Word, Excel and PDF. It
can also be printed directly from the viewer.

.Report\a’iewer
S b B8 B

Figure 27 Save options available in the top-left corner of the Report Viewer

The Export Report button allows you to export only the defect table in several formats such as
Tubepro or CSV.
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Take screenshot with report entry option captures an image of the front stage every time
an indication is added to the report. The screenshots are visible in the Data tab of the front
stage and can be appended to the report.

INFORMATION

When the computer has been connected to the Ectane through the Magnifi interface, probes
with a configured chip-ID can be recognized when connected to the instrument. In that
condition, the probe model will be displayed. The software will send a warning if the loaded
setup is not compatible with the connected probe. Note that the appropriate setup is not
automatically loaded when the probe is connected, it must be manually loaded by the user.

Information
Information Probe: SHARCK-BW053-G2
Probe: SHARCK-BW053-G2 ALl Incompatible with current setup, |

Figure 28 Detected probe information

Also, the message Unable to detect could simply mean that the probe being used does not
have a functional chip-ID, but it can still be used for inspection.

Information

Probe: Unable to detect

Figure 29 Unable to detect probe

START / RESUME

Click on the Start / Resume button or the blue arrow icon at the top-left of the backstage

to switch to the front stage view.
Start / Resume .

Figure 30 Start / Resume buttons
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ACQUISITION SUMMARY SECTION

This section of the backstage allows you to specify information related to the inspection and
the inspected items such as the component type, the service company, the operator, the
serial number of the probe used for inspection, etc. This information remains attached
to the data files, even if they are separated from the original Inspection folder. Therefore,
the Acquisition Summary should be filled before data acquisition.

Note that the information can be updated at anytime during an inspection to reflect the real
conditions in which the data were acquired. For instance, a change of operator would ask for a
modification in the Acquisition Summary. Therefore, all the files acquired by the new operator
would be tagged correctly.

The Acquisition Summary is also saved with the setup file.

Fields can be added, removed and customized. Additional information can also be typed in the
Comment section. The bottom portion of this section (Filename, Setup, Date, Version) is
filled automatically.

Note that it is possible to import/export the Acquisition Summary with all the information it
contains for improved productivity.

Magnifi® 4.5RS - [..\Default\Default\|FLEX-5CC_2 Epsilon.magdata]

Acquisition Summary

Componet e+ x
%
i x
Acq. Summary Inspector lzl
ez i~ x
Comment
Material Database
Documentation
Filename: |IFLEX-SCC_2 Epsilon
Setup: |IFLEX-SCC 2 Delta
Date: |5/13/2015 11:56:41 AM Version: [Magnifi® 44R5T1

Figure 31 Backstage - Acquisition Summary section
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REPORT SUMMARY SECTION

This other section of the backstage allows you to specify information that will appear in the
header of the reports, such as the client, the work order, the procedure, etc.

Fields can be added, removed and customized. The fields that are grayed are linked to the
Acquisition Summary and will be filled if the corresponding fields are filled in the Acquisition
Summary section. Additional information can also be typed in the Comment section.

The Report Summary is saved with the setup file.

Note that it is possible to import/export the Report Summary with all the information it
contains for improved productivity.

Magnifi® 4585 - [.\Default\DefaultUFLEX-5CC_2 Epsilon.magdata]

Acquisition Summary

%

E—— %]

Companent S/N lzl
Acq. Summary Ti= Izl

Work Order |g|
Report Summary

Calibration Standard_~ |g|

— %

preves E
Material Database

Comment

Figure 32 Backstage - Report Summary section
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SAVE SECTION

The Save section of the backstage proposes a few different saving options for the data files

and the setup files:

1.

2.

Report Summary

Material Database

Save Setup:
Saves the currently used setup in the current Inspection folder.

Save Setup as...:
Saves a new copy of the currently used setup and allows you to specify its name and
location.

Save Setup as Read-Only...:

Saves a new copy of the currently used setup and allows you to specify its name and
location. The file can’t be overwritten. Attention, it remains possible to apply
modifications to the setup while using it, however, the modifications can’t be saved.

. Copy Setup in Master List...:

Add the currently used setup to the Master List for a quick access from any
Inspection folder.

Sava Data as...:

Saves a new copy of the currently loaded data and allows you to specify its name and
location. Note that the currently used setup is always saved with the data. The setup
information is stored within the data file.

Magnifi® 45R5 - [.\Default\DefaultFLEX-5CC_2 Epsilon.magdata]

Save
Setup
Current Setup: From original data file - IFLEX-5CC_2 Epsilon

Owner Initials:

Description:

ulo LG =lo
Save Setup as | | Copy Setup in
ead-Only.. || MasterList..

Save Setup Save Setup as..

Data

v

-
Save Data As...

Figure 33 Backstage - Save section
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MATERIAL DATABASE SECTION

The Material Database section shows a list of materials and their properties.

Three properties are associated to each material. The resistivity and the permeability are used
by Magnifi to calculate the theoretical inspection frequency of the electromagnetic techniques.
The ultrasonic velocity is used to preset the gates’ locations when using IRIS.

Magnifi® 4,5R5 - [..\Default\Default\Probe 123 setup.magsetup] - *
Material Database
Custom Materials
General
Copy
Name U"'mms\f O M pagenity wem) Relative Permeability F+ Ax
Acq. Summary Admiralty brass 4430.000 69 1
Aluminurm brass - ET ONLY 0.000 75 1
Remove Al
Aluminum 6320.000 262 1
Report Summary Aluminum (6061-T-6) 6300.000 399 1
Aluminum bronze 3530.000 12 1
Brass (70/30) 4700.000 616 1
Brass (85/15) - ET ONLY 0.000 466 1
Brass (95/5) - ET ONLY 0.000 3.13 1
Carbon steel 5690.000 21 450
Material Database Carbon steel low-alloy Cr-Mo 5890.000 21 400
Cast iron (gray) 4600.000 1638 125
4660.000 172 1

Copper

Documentation

Preferences

Figure 34 Backstage — Material Database section
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DOCUMENTATION SECTION

This section of the backstage allows you to open PDF documents. A list of documents is
automatically added during the installation of Magnifi. Other documents such as codes,
procedures or drawings can be added to the list by saving a copy at the following location on
your computer:

» ThisPC » Docurnents » Magnifi » UserData

Figure 35 Documentation’s directory

Magnifi® 4.5R5 - [..\Default\Default\Probe 123 setup.magsetup]

Documentation

Name

ECA Probes User Guide

General

Ectane2 SXSC2008A - Users Guide - EN - 20140811
Sharck-G2 User Guide_Version1.0

Sharck-HR User Guide_Version1.1

Acq. Summary

User Guide - Ectane SXSC2001G - EN - 20131016
User's Guide - Assisted Analysis

. User's Guide - Probot
Report Summary

Material Database

Documentation

Preferences

Figure 36 Backstage - Documentation section

23|Page



SYSTEM PREFERENCES SECTION

Magnifi® 4585 - [.\DefaultiDefault\Probe 123 setup.magsetup]

System (Computer Related)

Measurement Convention Measurement Units
® ASME @ Metric
P ~) ASME Inverted ey ) Imperial
) EDF
Readback

[] Do not display data during loading
Speed:

() Actual Inspection Speed

@ Maximum

Keep Current Setup” Button Behavior:
() Retain check state

General

(@) Reset to checked after loading a data file

Setup Wizard Path: |C:\Users) r\Docu i\l ifilS p

Automatic Features

[] Allow to save setup in original location

Reminder to save setup after acquisition if not saved yet

Analysis
Logo
Preview:
& .
Select
Campany Loga
Shortcuts

Keyboard...

Integration
[ TubePro 5.3

Figure 37 Backstage — System Preferences section

—— 7 The System Preferences section contains several options that are related
iﬁﬂ;ﬁ' M to the user’s computer, meaning that the configurations will remain the
s wren - same, independently of the loaded setup file.
o eren i The Select Company Logo button allows you to define the logo to be
; displayed in the header of the report. The button lets you browse your
e T computer to select an image with any of the following
Nig FE formats: .bmp, .png, .jpg, .jpeg.
w07 1 The list of default keyboard shortcuts available during acquisition and
——rr % analysis can be visualized and managed by clicking on the Keyboard...
Q:“M] E:}; button. To modify a shortcut, simply select the action in the list and press
::j::g:jm ° the desired key.

e |
S —
N .

Figure 38
Keyboard
Shortcuts
To integrate the TubePro software with Magnifi, check the TubePro box at

the bottom of the System Preferences section.
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GENERAL PREFERENCES SECTION

The General Preferences section contains several options that are related to the setup,
meaning that the configurations are stored with the setup when it is saved and are retrieved

when the setup is loaded.

Additional information regarding some of the available options:

1.

Display

Analysis

Hide Raw Channel:

Only the processed channels appear in
the list of available channels to be
displayed in the front stage,
facilitating the analysis if the raw
channels are not relevant.

Automatic File Recording:

Data recording is initiated as soon as
the acquisition starts. When
unchecked, a Record button will
become available in the front stage
during acquisition. After starting the
acquisition, data is displayed on the
screen, but it is not recorded until the
Record button is pressed.

General (Setup Related)

Measurement t Units
Report Units: | Millimeter

Channels
Full Channel Scale:  [20.00V p-p &
Hide Raw Channel

Enable

Amplitude: |2 decim... -

Phase: 1 decim...
Acquisitian
Automatic File Recording
[ Auto Create new file on Next
[ Automatic Next on Stop acquisition
Keep re-scan files

Magnifi® 4.5R5 - [..\Default\Default\Probe 123 setup.magsetup]

3. Auto Create new file on Next:

Automatically adds a new file name in
the data tab of the front stage when
clicking on the Next button.

. Automatic Next on Stop

acquisition:

Automatically skips to the next file in
the list when stopping the acquisition,
making the acquisition process faster.

Keep re-scan files:

Already scanned files can’t be
overwritten. Re-scanning a file will
keep a copy of the original file.

Figure 39 Backstage - General Preferences section
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DISPLAY PREFERENCES SECTION

The Display Preferences section also contains several options that are related to the setup,
meaning that the configurations are stored with the setup when it is saved and are retrieved

when the setup is loaded.

The Name Splitting options refer to the channel/C-Scan group name selectors displayed in
the headers of the different views for easier navigation. By default, it is set to Automatic. The
software automatically recognizes patters in the names of the channels/C-scans and produces

the appropriate selectors.

Magnifi® 4.5RS - [..\Default\Default\Probe 123 setup.magsetup]

Display (Setup Related)
Colors

cotosereme: [iignt ] [ wamagen |

General Preferences
Display Mull Mark

Preferences

Zoom Behaviar an Stop Acquisition: | Zoom to Content

Lissajous
Display Cursor pasition dircle

Ceneral [] Display Mini Strip Charts

Proportion: |33.00%

B
L Channel

ink C-scan Cursor with Channel: isplay Duration
] Link C-scan G ith Channel Display Durat
@ Time Distance () Sample 10.000s B

Display

Display Direction: up v
[] Link to C-5can duration

C-scan
[] Display Grid Scan axis scale displayed during acquisition:

Set Specific Scale: | 300.0 mm =

Analysis

X-axis: |125.0 mm

Vaxis: | 79.9

Name Splitting

Split Channel Names Split C-scan Names
(@ Automatic (® Automatic
- Manual: Prefix 0 Frequengy 0 Channel Group | 0 Cail 0 ' Manual: Prefix 0 Channel Group 2 Frequengy 2

Figure 40 Backstage — Display Preferences section
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ANALYSIS PREFERENCES SECTION

The Analysis Preferences section also contains several options that are related to the setup,
meaning that the configurations are stored with the setup when it is saved and are retrieved
when the setup is loaded.

Magnifi® 4.5RS - [..\Default\Default\Probe 123 setup.magsetup]

Analysis
General Preferences
[ Automatically merge C-scan indications
(@ Show all detected indications
Inthe code view: () Hide detected indications converted to report entries

() Hide detected indications that overlap a report entry

Measurement Methods
Amplitude Phase

Absolute Absolute Selact All
Absolute Horizontal Absolute Peak
General
Absolute Vertical A Peak
solute Vertica verage Peal crear Al
A Absolute Peak Maximum Rate
— Absolute Peak Harizantal Peak ta Peak
Display Absolute Peak Vertical Peak ta Peak First Transition
Average Peak

Average Peak Horizontal
Average Peak Vertical

Peak ta Peak

Peak ta Peak Horizontal
Peak ta Peak Vertical

Peak ta Peak First Transition

Figure 41 Backstage - Analysis Preferences section

The Measurement Methods portion shows all the possible measurement methods that can be
used by Magnifi. Only the selected methods are available for analysis, defects reporting, sizing
curves, calibration, etc. It is recommended to select only the methods that are relevant to
facilitate the analysis. The methods are:

1. Absolute (A): 4. Absolute Peak (AP):

Uses a straight line from the Lissajous Uses a straight line, from the Lissajous
origin to the main cursor position to origin to the peak value of the data
measure amplitude. selection, to measure amplitude.

2. Absolute Horizontal (AH): 5. Absolute Peak Horizontal (APH):
Uses only the horizontal component, Uses only the horizontal component,
from the Lissajous origin to the main from the Lissajous origin to the peak
cursor position to measure amplitude. value of the data selection, to

3. Absolute Vertical (AV): measure amplitude.

Uses only the vertical component, 6. Absolute Peak Vertical (APV):
from the Lissajous origin to the main Uses only the vertical component,
cursor position to measure amplitude. from the Lissajous origin to the peak

value of the data selection, to
measure amplitude.
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7.

Average Peak (MP):

Takes the distances from points at the
extremity of the cursor to the peak of
the data selection to build an average
vector. Used only, and recommended,
for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

. Average Peak Vertical (MPV):

Uses the vertical component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.
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10.

1.

12

13.

Peak to peak (PP):

Uses the combination of the vertical
and horizontal component to
measure the maximum amplitude.

Horizontal (PPH):
Uses only the horizontal component
to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure
maximum amplitude. The firsts signal
transition is from the base of an
indication to its peak.



HELP SECTION

The last section of the backstage shows information about:

e The version of the software;

e The instrument currently connected to the computer;
e The software license and other licenses;

e Eddyfi's contact information.

This is also where you can:

e Manage your software license;
e Edit the privacy options;
e Copy log.

The Copy log... button generates .txt files to send to Eddyfi when you want to report a bug.
Directly after a crash or an unexpected event in the application, reboot Magnifi (if necessary),
click on the Copy log... button, save the .txt files at the desired location on your computer and
then send the files by email to your support contact at Eddyfi for support.

Magnifi® 4585 - [..\RefineryABC\Component 123\Setup 1.magsetup]

Help
System Contact Information
Software Version: Magnifi® 4.5R5 Build 194 Eddyfi
[ 3425 rue Pierre-Ardovin

Instrument | i

= Québec, Québec G1P 0B3
Model: E256

CANADA

Serial Number: 1209702
T +1418 780-1565
Acq. Summary Package Version:  2.1R3

Firmware Version: 2.0R4.22

Getting Support

Software License

Report Summary

Material Database

Documentation

Preferences

Company: Eddyfi NDT
Licensee:  Olivier Rousseau-Cyr
License Type: Unlimited
Expiration:  N/A
Host ID: BO368ABF
Magnifi 3.5 Probe Development Kit,
Packages:  Magrifi 4.3 Probe Development K,
Magrifi 2.0 Standard, Custom
Third-Party Licenses

Show Instrument Licenses
Show Software Licenses

Show License Agresment

Log

Privacy Opticns

Eddyfi Technologies
Product Improvement Program
Allow Notifications from Eddyfi

Show Program Details

Figure 42 Backstage - Help section
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DefHi"™ Application Guide
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ECA DefHi® Probes
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INTRODUCTION

This document presents how to set up and calibrate the DefHi® probe with Magnifi 4.4R5 on
an Ectane test instrument using the Setup Wizard.

EQUIPMENT

The DefHi® probes use a 160-pin connector that can be connected on an Ectane with the “E64”
or "E128"option (depending on the probe model).

As this probe needs to be near the tube surface, a wide range of probe diameter is offered (see
the tubing probe catalog for more details). A wide frequencies range is also available to allow
inspections of tubes of different thickness and material.

From the following tables, the best probe for your application can be selected.

Table 1 - Probe diameter selection table

TUBE WALL THICKNESS (BWG, mm, in)

BWG 10 " 12 13 14 15 16 17 18 19 20 21 22 23 24

mm 340 305 277 24 211 183 165 147 124 107 083 081 071 065 056
in 0135 0120 0.109 0095 0083 0072 0.065 0.058 0049 0042 0035 0.032 0028 0025 0.022

12.70mm 0.500in - - - - - - - - 096 096 102 102 106 106 106
15.87mm 0.625in - - 096 102 106 114 118 118 126 126 132 132 136 136 136
19.06mm 0.760in 114 118 126 136 140 148 148 148 156 166 162 162 166 166 170
22.22mm 0.875in 148 148 156 166 170 178 178 186 186 192 192 196 196 196 200
25.40mm 1.000in 178 186 186 196 200 208 208 216 220 220 226 226 226 230 230

TUBE OUTSIDE
DIAMETER

Table 2 - Probe frequency range selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 10 1 12 13 14 15 16 17 18 19 20 21 22 23 24
mm 340 305 277 24 211 183 165 147 124 107 089 081 071 065 056
in 0135 0120 0109 0095 0.083 0072 0065 0058 0049 0042 0035 0032 0028 0025 0.022

Brass (admiralty) - - - - — AW HW HW HW HW LF [F F [F If
Brass (70/30) - - - - -~ HW HW HW HW HW LF LF LF LF IF
Brass (85/15) - - - - - -~ HW HW HW H¥ HW LF  LF  LF IF
Brass (95/5) - - - - - - - -~ HW  HW  HW  HW  HW  LF  LF
., Copper - - - - - - - - - - HW  HW  HW  HW  HW |
= Copper-nickel (70/30) HW HW HW HW LF LF LF LF LF MF MF MF MF MF HF
= Copper-nickel (90/10) -~ HW HW HW HW HW LF LF LF LF LF M MF MF MF
= Copper-nickel (95/5) - - -~ MW HW HW HW HW LF LF LF LF LF MF MF
Inconel 600 F LF LF LF LF M MF MF MF MF HF HFE HF HF HF
Stainless steel 304/316 W LF LF LF LF LF MF MF MF MF HF HF HF HF HF
Titanium 99% HW MW HW LF O LF F LF LF MF MF MF MF HF  HF HF
Zirconium HW HW HW LF LF LF LF LF MF MF MF MF MF HF HF
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Table 3 - Frequency range

FREQ. (kH2)

HW: 4-60kHz * Maxi MF is reduced to 400 kHz with 15 bl
aximum MF is reduced to z wi m cable.
LF: 20—200 kHz ** Maximum HF is reduced to 1 MHz with 15 m cable.

MF: 50-500 kHz*
HF: 100-1200 kHz**

Table 4 - Total number of array channels

FREQ. HW L7 MF FREQ. HF

CONHG. BC BCA BC BCA BC BCA CONFG. BC BCA
= 096-106 - - 12 36 18 54 = 096106 - -
‘5‘: 114140 12 36 18 54 18 54 ‘5‘: 132136 18 54
L 148178 12 36 24 72 24 72 L 162170 24 72
§ 186-196 18 54 24 72 24 72 § 196-200 30 90
o 200230 18 54 30 90 30 90 o 226-230 36 108

Defhi® probes are available with one row or two rows pancake coils. The model with one row
(ERBC) will allow the detection of circumferential cracks. The model with two rows (ERBCA) will
allow the detection of both axial and circumferential cracks with the array part of the probe.

Table 4 indicates the number of array channels for each standard probe. The total number of
channels for a DefHi® probe equals the number of array channel plus two (one for the absolute
and one the differential bobbin channels). Therefore, if the number of array channels is 63 or
over, it means that an Ectane with the "E64" option won't have enough channel for this probe
and that an Ectane with the “E128" option will be required to use this probe.

The DefHi® calibration tube used in this document includes the following flaws:
e Internal groove, 10% of wall loss
e [External groove, 20% of wall loss
e Hole, 100% of wall loss
e OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth
e OD4xFBH 20% depth

But, other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named SS316_075x0.065_ECT for instance. This inspection folder groups the setup, the tube
list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

___________  E— l .l..

INSPECTION 2 INSPECTION X

| |
| |
| |

|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <«—> DATA |
| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4, the first page displayed is called the Backstage.

Magnifi® 43R10

General
Project / Inspection Information
Earer! Project Folder: C:\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default .c.) .5 Application:  Generic
Open/Add Add/Open e
Project Inspection Tube Dimensions:
oD: 19.05mm
Setup / Data
Setup Loaded: [unsaved) WT: 1.65 mm
z 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data .
Data Loaded: Material:  Stainless Steel304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata
Create New

Material Database List Import List
Report

Documentation Name: [Report.mdb =) ~ .
Table Profile: [ Tubing IRIS - © -

Generate Export Report
[] Take screenshot with report entry Report
Preferences

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an
existing project/folder or you can create a new folder.

Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

Bl Select 2 project (=

&3\ =[] Computer » 0S(C) » Users » daubeQTEC » Magnifi » 2]
Organize v New folder =5 @
't Favorites =
1§ Downloads 5
& OneDrive }
] Recent Places E 1!
I Desidop Projects T
= Libraries [ Shortcut
% Documents Micrasoft Access Database
&= Magnifi Data 3 Bitimap image
% Magifi Setup Contact
o) Music Microsoft Word Document
)T View > Microsoft Access Database
&l p_’“”e‘“ Sort by » Microsoft Project Document
B videos Group by » [F| Microsoft PowerPoint Presentation
B Compter Refresh ] Microsoft Publisher Document
& o5 pote [l SonicWALL Globsl VPN Client Document
8 ArchivesZetec (\\srvarchives) (K:) N Paste shortcut (2] | b Uiz
9 QADats (Nsrvdata) (L) Undo Delete cyiz | etDocument
5 Mechanical (\\srvdata) (M) — 5! | B R
9 SoftwareProducts (\srvdata) (N et s Wk hest
9 Client (Wsrvdata) (0:) New » B Briefease

£ PublicShare (\\srvdlata) (P2) s
C# Omialibe Menedatal (00 L
Folder. Magnifi

Select Folder
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Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your
inspection.

( . Manage - uw

—.

Inspections
anage ections elect =
.0 Manage Inspects Select Oth

Mame State

Default

Bundle_A_55316_0.75x0.65_DefH |-B

I\f Select |[x Close l

L -

Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Analysis

System (Computer Related)

Measurement Convention Measurement Units
@ AsME @ Metric

*) ASME Inverted ==
J) EDF o

O Imperial

Readback
[] Do not display data during loading
Speed:
7 Actual Inspection Speed
© Maximum
“Keep Current Setup” Button Behavior:
*) Retain check state

© Reset to checked after loading a data file

Setup Wizard Path:  C:\Users\daube.QTEC\Documents\MagnifilSetup

Automatic Features
[] Allow to save setup in original location

Ask to save setup when the first data file is recorded

Logo
Preview:

£. (@ eddyfi

Shartcuts

Keyboard.. |
Remate.. |

<

Preferences

System

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter - |

Channels

Full Channel Scale: 2000Vpp ¥

Hide Raw Channel

Precision

[ Enable

Amplitude: | 2 decim... =

Phase: 0 decim... ¥

Acquisition
Automatic File Recording

Auto Create new file on Mext
Automatic Mext on Stop acguisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Setup Wizard process. Click on Create
Setup to start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of Available
Material window.

','- New Setup Wizard @1
ﬁ Component Definition I = |

Configure the geometry and material of the component to inspect

-

Geometry: () Surface @ Tube from ID
Application: @ Generic () Air Conditioner
Material: [Stainle_ss Steel 316 vl [ Manage... ]
Resistivity: 74 pQ-cm
Permeability: lp
Velocity: 5660.000 m/s
Wall thickness: 211 mm -
14
L] ©BWG
6 24
Outside diameter: 2540 mm -
Length: G000 mm

Mote about selected material:

Application: Austenitic alloy-steel boiler, superheater, and heat-
exchanger tubes,

Composition: ~17% Cr, ~12% Ni, 2% Mo, Fe remaining

UNS: 531600

ASTM: A213 TP316, A249 TP316, AGESE TP316

o | (B

L. A

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound
velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.

You can add a note about the material to specify things like its application or composition.
When you are done, click OK.
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p
B List of Available Materials

Custom Materials

Cilsers\daube QTEC\AppData\Roaming\Eddyfi\Magnifi\UserMaterialsDatab:

N

Materials Ei Co
Mame Ultram?:j;emc'w Resistivity (u0cm)  Relative Permeability == Add
Stainles... 0.000 74 75 . 2L Import.
Stainles... 0.000 a4 75 & Remove All
Titanium a070.000 486 i
Ti-bAl-4... 0.000 123 il
Zirconium 4650.000 1 i

mem

Motes About Selected Material

[\/ OK ] [x Cancel

b

"

You will be back to the Component Definition window. If you added a new material, it will be

available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down
menu. More precise filtering can be done by using the Model drop-down menu. You can then
select your probe by its catalog number and then click Next.

' ™y
‘,'- New Setup Wizard ﬂ

/ ’ Probe Selection r - |

Select the probe that you want to use for your inspection

Technique: [ECT | Model:  |DefHi-BCA -
Probes
Tech. | Madel Catalog Number h # | Description ‘L
ECT DefHi-BCA  DEFHI-ERBCA-(096 to 106)LF o o e O e temey rane . 101 deston, 5610 10.6 mm
ECT DefHi-BCA  DEFHI-ERBCA-(096 to 140JMF o o o S e amey o, 0'c deston, 9610 140 mm
ECT DefHi-BCA  DEFHI-ERBCA-(L14 to J40JHW o o e temey o, oid deston 114 fo 140 mm |
ECT DefHi-8CA  DEFHI-ERBCA-(L14 to L4DJLF e iProbe with Bobbin, atc and axia) aray. Rigid design, 1.4 o 14.0 mm 1
ECT DefHi-BCA  DEFHI-ERBCA-(126 to J4B)HF oo oo e emaency range | 0\¢ desion, 126 fo 148 mm
ECT DefHi-BCA DEFHI-ERBCA-(148 to 178)HW gli?;tz:ofﬁ:\ﬁ]hkaozbfl::;uc;:;:adn;)gal array. Rigid design, 14.58 to 17.2 mm

DEFHI Probe with bobbin, circ, and axial array. Rigid design, 14.5 to 19.6 mm
DefHi-BCA  DEFHI-ERBCA-(148 to 196)LF diameter, LF 20-200 kHz frequency range.

DEFHI Probe with bobbin, circ, and axial array. Rigid design, 15.6 to 15.6 mm
DefHi-BCA  DEFHI-ERBCA-(156 to 186)HF diameter, HF 100-1200 kHz frequency range.

W DEFHI Probe with bobbin, circ, and axial array. Rigid design, 15.6 to 19.6 mm
diameter, HW 460 kHz frequency range.

ECT DefHi-BCA  DEFHI-ERBCA-(186 to 196)H

-

|&¢ New.. || Manage. |

[ Cancel |[4 Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

% New Setup Wizard @

Scan Definition |

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Asis

Position from: Clock A

Acquisition rate: 1500 Hz -
Typical probe speed: 300.0 mm)/'s -

[x Cancel H‘ Back H’ Mext l

L A

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 300mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 600mm. Using an encoder will give you the exact position of the probe.
Note that the position can also be obtained by using the landmark, but this feature will be
shown later.

The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 1500 Hz for DefHi, but depending on drive frequency used to inspect,
the actual acquisition rate may differ. The system will automatically readjust this value if
needed.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For an acquisition rate of 2000 Hz, the pulling speed needs to be less that 1m/s to have at least
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2 points per millimeter. If you do not use a pusher-puller, the pulling speed won’t be constant.
Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. Also, the typical probe speed should be set as close as possible from the real
value. This will help the algorithm that automatically detect landmarks (explained later). The
recommended pulling speed for DefHi® is normally around 300mm/s (12in/s).

If you selected the position from Encoder, different fields will appear and a second Scan
Definition page will become available.

4 New Setup Wizard == 3+ New Setup Wizard ==
Scan Definition [ | Scan Definition |
Configure the type of scan you will be performing with your probe Configure the type of scan you will be performing with your probe
Scan: Single Pass Scan: Single Pass
Main Scan Avis: Y Axis Main Scan Avis: Y Avis
Position from: Clock: Position from: Clock v
Acquistion rate: 1500 Hz Acquistion rate: 1500 Hz
Typical probe speed: 3000 mm/s Typical probe speec: 3000 mm/s
(3¢ cancel ][4 Back |[Pp Next [9¢ concel ][4 Back | (B Next

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.

Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at O mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute and Differential channels. It is important to set these parameters correctly before

acquiring the data since they are driven by the instrument and cannot be modified during the

analysis.

-
','- New Setup Wizard

==

A Data Definition

I

Select the C-scans you will be using and the necessary frequencies

Connector: 160 pins

Gain: 58 dB -
C-scans Required frequencies
MName Prefix Prefix  Val (kHz) Ampl (V) Phase (%)
Aodal A 02 2.50 0.0 [g]
e C P2 496 2.50 0.0 @

Suggest

[ Cancel |[4 Back |[Pp Nex |

L.

’

Pages of this section are used to set the parameters of the array part of the probe (C-Scan)
and others are used for the bobbin part of the probe (channels).

By default, Magnifi suggest two frequencies for the array part of the probe and four frequencies
the bobbin part. These frequencies are calculated with the parameters previously entered:

Prefix Frequency Channels
F1 2 xF90 Array & bobbin
F2 F90 Array & bobbin
F3 F90/2 bobbin
F4 F90/8 bobbin
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But, frequency and drive voltage can be changed by replacing their values in the Required
frequencies table. Up to 4 frequencies can be set at the same time. And the sum of their
amplitude cannot exceed 10V.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one
of the suggested frequencies is not within the recommended probe frequency range, you can
either remove it by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

DATA PROCESSING

The next windows are used to build mixed channels. Mixes are processed channels that are
mainly used to detect indication close to support plates. They are built with two frequencies of
a same channel type to attenuate the effect of the support plate and to be able to size an
indication at this location more accurately.

% New Setup Wizard @

“--.k Data Processing : : |

! Select the processings that you want to apply to the channels you have selected

[ Individually canfigure all the channels

Low Pass Median High Pass
MName ‘ Cutoff (Hz) Window Size (smpl)
ABS [] 400 ] 225
DIF [C] 400 O] 235

[x Cancel H‘ Back “’ Mext

L &

If you do not wish to use mix channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which
input you want to use the mixed channel. Note that /Input Channel 2 has to have a lower
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frequency than Input Channel 1. Mixed channel can be built for C-Scans, absolute and
differential channels.

You can rename the output mixed channel by modifying the Output Mixed Channel field.

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix
channel. The system will apply processes to the chosen input channels and will subtract them
to attenuate the reference signal.

Click on Next to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually with the Individually configure all the
channels/C-scans check box or you can apply the same filters to every channel/C-scans.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while a wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters

parameters after the acquisition, so it is always possible to fine tune the filters parameters
during the analysis.

2 New Setup Wizard == 2 New Setup Wizard =
N q N q
[  DataProcessing | | P~ Dpata Processing
, Select the processings that you want to apply to the C-scans you have selected , Select the processings that you want to apply to the channels you have selected
[ Individually configure all the C-scans [ Individually configure all the channels
Low Pass Median High Pass Low Pass Median High Pass
Name Cutoft (Hz) Window Size (smpl) Name Cutoff (Hz) Window Size (smpl)
400 0o 2s ABS [ 400 0 s
c 400 0 25 DIF [ 400 0 25
(%€ cancel | [4 Back | [P Neat [3€ cancel | (4 Back |[B Nex ]

The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won’t remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the
width of high-pass median filter should be set to at least three times the longest flaw that may
be encountered. Data should be examined in its filtered and unfiltered states. It is important to
keep in mind that the high-pass median filters can distort phase. More information about
median filter for NDT analysis can be found on Eddyfi’s blog.

46| Page



DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to
have functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

r ™y
5 Mew Setup Wizard @

9 Detect Landmark e - |
9 Configure landmarks detection

(Exit is used for Exit
sequence only) TS2

] TSH1
L
Paosition From: (@ Start Record () Stop Record w I I—
- Stop Start

[C] Negative Positioning: From | 0.0 mm

Detection Channel: R_FLABS -

Record | | Record
position from

Detection Engine: [LEQEC&’ '] LEﬁgth 0
Landrark Table (in the order seen by the probe during data acquisition)

Mame Type Pos. (mm) Min Qty Max Qty Shape Component Thresheld (V) P2P (mm) Enable

Exit Exit 25 } = 1000000 Disabled (3¢
52 152 0 } - 1000000 Enabled (3¢
Ts1 Ts1 6000 b = 1000000 Enabled (3¢

Positioned Landmark

Import... l[ Export...

[ Cancel | [ Back |[Pp Net |

W &

Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or on the place you stop to
record (usually the operator side).
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= f Exit
Detection Channel: R_ABS-FL -] (Bxitis “365’: ;OT .
TS1 sequence only) TS2
Position From: @) Start Record _) Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - Stop Start
Record i: : Record
position from
Detection Engine: Extended Len gth 0
Exit s used f Exit
Detection Channel: R_ABS-F1 - (=xitis “Se":fj .
TS1 sequence only) TS2
Position From: _) Start Record @) Stop Record I I—
[T] Megative Positioning: From |0.0 mm - StOp Start
Record I ;I Record
position from
Detection Engine: Extended O Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering in the tube. It is enabled only when doing the
acquisition. As it can trigger the data recording, it is not included in the resulting data file and
is not available at the subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TS1 is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t’s important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above
example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.
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Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known.

Click Next when you are done.

CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s).

Calibration points can also be imported with the Import button.

’ o
'+ Mew Setup Wizard @
Calibration Points |
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%2) -

Calibration points

MName Side Size

HOLE Through 1000 (%
FBH-80 oD 80.0 %
FBH-60 oD 60.0 %
FBH-40 oD 400 @
4 FBH-20 oD 200 (%)
IDGR-10 D 100 (%
ODGR-20 oD 200 %
ODGR-40 oD 400 %
ODGR-60 oD 60.0 %
SUPPORT Unknown 0.0 (%)
LIFT-OFF Unknown 0.0 (%

[x Cancel ll-‘ Back I[’ Mext ]

Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).
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CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the
amplitude(s) and phase(s) of each channel using the selected measurement method. There are
two calibration pages: one for the array (C-Scans) and one for the bobbin (channels).

By default, the calibration is performed on the Hole signal by putting it at 1V and 40° on the C-
scans, the absolute and the differential channel. However, the calibration can be done
differently on each channel type. It can also be done individually for each frequency by selecting
the Individually configure all the channels option. Different reference signals can be set to
calibrate the phase and the amplitude independently.

7 New Setup Wizard = 5 New Setup Wizard =
&  calibration &  calibration
Configure pa nd phase /,\\ Config nd phase
7] Individually configure all the C-scans [ Individually configure all the channels
Amplitude Phase Amplitude Phase

Name Voltage (V) Reference Measurement  Angle °) Reference Measurement 56 Name Valtage (V) Reference Measurement  Angle () Reference Measurement

A 1.00 HOLE MP 40.0 HOLE MP ABS 1.00 HOLE MP 40.0 HOLE MP

c 100 HOLE wp 400 HOLE e OF 100 HOLE P 400 HOLE PP

$G: Single Gain and Phase

(%€ cancet | [4 Back | [p et (3 cancel | [ Back | [p nme |

When you'll select the reference signal, the system will use the selected measurement method
to apply a rotation and a gain. Here is a short description of the available options:

1.

Absolute (A):

Uses a straight line from the Lissajous
origin to the main cursor position to
measure amplitude.

Absolute Horizontal (AH):

Uses only the horizontal component,
from the Lissajous origin to the main
cursor position to measure amplitude.

Absolute Vertical (AV):

Uses only the vertical component,
from the Lissajous origin to the main
cursor position to measure amplitude.
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4.

Absolute Peak (AP):

Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.



7. Average Peak (MP): 10. Peak to peak (PP):

Takes the distances from points at the Uses the combination of the vertical
extremity of the cursor to the peak of and horizontal component to
the data selection to build an average measure the maximum amplitude.

vector. Used only, and recommended,

_ 11. Horizontal (PPH):
for absolute signals.

Uses only the horizontal component
8. Average Peak Horizontal (MPH): to measure the amplitude.

Uses the horizontal component of the 12

distances form points at the extremity

of the cursor to the peak of the data

selection to make an average vector.

Used for absolute signals. 13. Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

9. Average Peak Vertical (MPV):
Uses the vertical component of the

distances form points at the extremity maximum amplitude. The firsts signal
of the cursor to the peak of the data transition is from the base of an
selection to make an average vector. indication to its peak.

Used for absolute signals.

Click on Next went the parameters in the table are set according to your requirements.
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SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each
line in this table.

' ™y
5+ Mew Setup Wizard ﬂ

f\ Sizing Curves e 3 |

Add and configure the sizing curves necessary for your inspection
j[n] MName Measure From Source Measurement

FlA C-scan ¥ F1A Phase @
FIC C-scan ¥ FIC Phase [z]
24 C-scan ¥ F24 Phase [z]
F2C C-scan ¥ FaC Phase @
FLABS Channel FLABS Phase [z]
FLDIF Channel FIDIF Phase @
F2ARBS Channel F2ABS Phase @
F2DIF Channel F2DIF Phase @]

|3 Cancel || Back |[Pp Nex |

L. ”,

The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals (amplitude or phase) obtained with your calibration standard. Magnifi will give you the
interpolated flaw size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve
properties. The name of the curve will be shown in the upper left corner of the page (ABS-F1in
the example below).
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%" New Setup Wizard @

Sizing Curves | ,
Configure the properties of the F1A sizing curve
Measurement method: [ ME v| Select the curve’s points:
Shape: [ BFDS v| MName Side Size
e IDGR-10 D 100 T
HOLE Through 100.0
FBH-80 oD 80.0
FBH-560 oD 60.0
FEH-40 oD 40.0
4x FBH-20 oD 20.0 A
[C] ODGR-60 oD 60.0
[C] ODGR-40 oD 40.0
[[] ODGR-20 oD 20.0
[T] UFT-OFF Unknown 0.0
[] SUPPORT Unknown 0.0

[x Cancel |[4 Back ||’ Mext |

" o

The measurement methods options are the same as the one described in the calibration page
section of this document. By default, the option average peak is set for absolute channels and
the option peak to peak is used for the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short
description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relationship with phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.
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5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve. Need at least three points.

The linear options are mostly used when little data points are available, while the options Best
fit (Dual Polynomial) is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select
the curve points for each sizing curves previously created. The order in which the points appear
in the list may influence your sizing cure. Make sure that the measured values of the calibration
points are in ascending order in the list. You can set Magnifi to show the remaining wall instead
of the defect size by checking the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when
analyzing the data.

a

- New Setup Wizard d

= _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect x|
D3l Distorted support indicatic  Defect @
ERO Erosion Defect x|
MDD Mo defect detected Mo indication @
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow @
WLL Wall loss long Defect x|
WLS Wall loss short Defect X]
WLT Wall loss taper Defect E

| L Import | | <= Add |

(% Cancel | |4 Back |[P Nex |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

r','- Mew Setup Wizard ﬁw
. o | Display = |
u

Configure display and layout properties

General options Lissajou f Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

() Zoom to full scale

[ 3

Proportion: 33.00 %

4

") Zoom to content

Display Direction: Top to Bottom A

@ Keep current scale
Strip chart duration:  Currently linked with the C-5can size

C-scan options

Scan axis scale displayed during acquisition: Orientation:

@ Entire C-scan

() Specific scale: [0.0 mm

4k
L
Il
o
R
P —
—

|3 Cancel || Back |[p Nex |

L. 4

The scroll direction is the direction in which data appears on the screen. If you choose downward,
the signals will go from the top to the bottom of the screen. If you choose the upward direction,
the signal will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one the another via the
layout tab. The " C " stands for code, " S stands for Strip chart," L " for Lissajous, " CS " for C-
scan and " CS-3D " for 3D C-scan.

Layout with the blue background will be the one opened by default.

Layouts can be readjusted at any time.
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+ New Setup Wizard M

Display = L)
Select the layout that you want to use to display your inspection results
2 Strip charts, 1 C-scan, 3 Lissajous 2 Strip charts, 1 C-scan, 3 Lissajous, 13
L L
L Igs|sf—Cs
L -31
4 Lissajous 2 C-scans, 230 C-scans
L L €S-3D
Id 5| S —Cs|Cs— c|cs|cs
L L €5-3D
. : Default layout
@ Help [5¢ cancel | (4 Back | [/ Finish

LN

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
N e P e I_ — @
o\ i =
> 4 o @ Y & A N e
Comp Probe Scan Data Process Landmark Pc'alt Calibration  Sizing Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.
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TUBE LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list
of tube.

This list can be created in the Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row_ Col 'l

001001.magdata I_'T‘o I__@

Create Mew .
List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to your list.
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[l File List Creator - XN

File List Configuration

Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 .

Mumber of Celumns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 .

b

Include first and last column of each row

Files to Create: 1 i
Filename Preview: 001001
[+ Create & Mew ] |\f Create | [ o Cancel

M

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in the
Tubepro software (available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume

button.

2. Click on Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument on which you want to

connect and then click on Connect.

#
| 4

Connect

OEK 4 & =

o Home

Setup Advanced Instrument

L\

Setup

R b ¢

Disable Ch. Setup Info o

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this

is the case, a white Xicon will be shown in the Status field of the Instrument connection window.

To download a matching version in your Ectane, clicking on the Config. button and then hit the

Send firmware to the instrument button of the Instrument configuration window.

-

Instrument Connection (Ectane)

===

Type
Ectane 2

| E120RNMI | EC:92:33:00:01:49

Maodel

MAC Address

Host Status onfig  Details

nnect Cancel

L

-

Instrument Configuration

==

Mode:

IP address:
Subnet Mask:

Gateway:

Metwork Information

wwwwwww

Embedded Software Update
@' Use the embedded software that comes with Magnifi

Usze custom embedded software

Cancel
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Two acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode. The
Setup Mode is used to scan your calibration tube and make the necessary adjustments on your
setup without saving the data automatically. The acquisition mode is used for the inspection.
When in this mode, the software automatically saves the acquired data using file names based
on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

o
£8 o

Setup Null
Mode

4. Plug the DefHi® probe on the Ectane 160-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking

on the Null button under the Home tab, or press F6 on your keyboard.

6. Bring the probe head outside of the tube and start the acquisition by clicking on the
Acquire button under the Home tab or by pressing the F2 on your keyboard.

7. Pull the calibration tube at the appropriate speed

8. When it's done, press the Stop button or again F2 on your keyboard

o

o Home  Sewp  Adwmcxd Istment | Colbration | Anohls  AshidAnsips  loyout  Comentiow [e[w]=

A A b 8 N B4
Wl LosdFie | Symem Encoder Sizing Cunves View Curves Landmarks e R

[T 8, aes Jra ] [ aer i msv J[n] Jar) - F2 T KT
AES

80.0 khiz

0.20v 1690 2 b
Lo w JoTw ][ on [ o )]

F2a27

oy E‘I-W’S b meg

Il =lrd [ = [ v
160.0 kHz

0.07V 3550 ? %4

Cel=1ol=1] S

0.18v 3510 2 %4
[ ] w Jo[e]n][con [ cor )

Information Documentation Regort

Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous
windows. These buttons are used for the channel selection.

1. 2. 3. 4
- DIF | F1,

A 4 A

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated
Strip chart to this channel.

PR ERE RN R DR EDE N AT
158.4 kHz 158.4 kHz /

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

N ER

4

158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential)

62|Page



4. Same principle as 2., but for the frequencies only

STRIP CHARTS AXIS ORIENTATION

The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from
chart.

one axis to another, click on the box showing an arrow at the upper right corner of the Strip

J .1 CIF L] F1,
158.4 kHz

1 400V |

/OOMING

158.4 kHz

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of
interest to zoom in this section. This operation can be done in both axis for the C-scan.
PR ER G [l 2oy [

u IIER IR

158.4 kHz

[t zoov [=] %!T]!Em ED ‘ EETE
{ /

u NIE R

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.

\1 2000V |-;|

J Previous Zoom
®, Full Extent

% Adjust Cursor Size
3 BestFit

~++  Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

BREREY II 333V |E| BREREY EEE EETI

80.0 kHz

2.98v 12 10.0% ID4

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.
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MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 23 4
Vep| | | P

"

=

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement

3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Hold and drag the left button of your
mouse to draw a vector in your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your and dragging it around the rotation axis. Note that is operation cannot be
performed on the raw channels since these channels have no gain or rotated applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,
make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard.
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CALIBRATION AND SIZING CURVES

SLEW

The DefHi® probes include two bobbins that generate and absolute and differential channel. It
also includes a set of pancake coils that generates C-scan(s). Since the bobbins and the

pancake coils are not physically located at the same position on the probe, there is a time delay
between the channels (coils) and the C-scan (pancakes coils). To bring all the signals at the
same position, the bobbin channels can be shifted in time to match the C-scan. This process is

called Slew in Magnifi.

To Slew:

1. Click on the Slew button that can be found under the Calibration tab.

2. Place your cursor over a flaw in you C-scan.

[l slew Calibration

==

Select current slew:

[5Iew / Slew Wizard Group

Capture Positions

Slew value:

-112

smpl

Close

L

3. Click on the button at the left in the Slew Calibration window. This will set the
reference point at which the channels will move.

4. Place your cursor over the same flaw but on the differential or absolute channel.

5. Click on the button at the right in the Slew Calibration window

6. Click on Apply.

Note that this process will move the channels by a constant number of samples. Therefore, a

probe pulling speed that was not constant won't have a data alignment that is valid throughout

the hole scan.

66|Page



CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the calibration window

3. Inthe Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

| Calibration B

BRI [t 2oov 4]

@ Channel "

_) Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

[ Calibrate ]

[ Reset |

1. Select the signal name in the list

2. Click on the green arrow button to associate the measured signal to the calibration
point

3. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of
them

4. When all your calibration points are checked marked, click on the Calibrate button
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SIZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button

2. Select Channel and Sizing Curves/or C-Scan and Sizing Curves in the calibration
window

3. Go over the signal in your Strip chart/ or C-scan and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is display on the
Lissajous to show the defect size. To have the correct interpolated point, the measurement
method also needs to be the same as the one used for the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.

Select the signal name in the list

Click on the green arrow

Redo the previous steps for all the other indications in the list
4. Click on the Calibrate button

W N =

The previous operations must be done for the channels and the C-scans.
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Error messages after creating the phase sizing curves can appear. The main cause of these
errors is the measurement direction.

The image below shows two different measurements. On the left, you can see that the
measurement arrow is pointing toward the liftoff signal. In this case, the measured phase is
rotated of 180° from the right value. When one or more points were measured in the wrong
direction, Magnifi cannot build the sizing curve and will generate an error message.

On the image on the right, the arrow is pointing from the liftoff signal to the defect signal,
which is correct. However, in this picture, the arrow starts quite far from the middle of the liftoff
variation signal, which will cause an error in the measurement. In this case, we suggest you to
move the cursors until your measurement is taken from a point near the base of the signal.

'The atrow is The beginning of
pointing towards the arrow is quite
the liftoff signal far from the
1198 [
1194 0®
T .
1.501 ¥pp 64 ?
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To adjust you sizing curves and remove the error messages, go the Calibration tab, and click on
View Curves.

. L ;
[ Select Calibration Point ) [ select Calibration Point [
[ DrF-£L- ECT) -] [ D-p1 - ECT) -]
1000 O 1000
820 b 800
% 840 > % 60.0
5 480 > 5 @00
280 200
>
10.0 <l 00
300 340 20 60 100 140 7 37 a7 £l 128 158
Phase (degree) Phase (degree)
MName Side Size (%) Value %) Name Side Size (%) Value (%)
IDGR-10  ID 100 10 T IDGR-10  ID 100 10 T
HOLE Through 1000 40 HOLE Through 100.0 40
FEH-80  OD 00 71 FEH-80  OD 800 71
FBH-60 QD 600 99 FEH-60 0D 600 99
FEH-40 oD 400 300 x FEH-40 oD 400 120
A\ Invalid

The sizing curve window will appear. Each sizing curves you asked magnify to create will be
listed in the drop-down menu. If an invalid notification is present on the curve, it means that
either you haven't entered the sizing points yet or that Magnifi failed to create the curve. To
adjust the sizing curve manually, enter the value in the table.

In the above example, the entered phase angle for the 40% defect is 300°, but the correct phase
angle for the 40% is 120°. The defect 40% has an 180° bias due to wrong measurement direction.
In this case, we can simply change the angle value from 300° to 120° in the table to fix the sizing

curve.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws
in the Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw
size does not appear, it means that you are not in a channel where a sizing curve was set.

LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TSTand TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).
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Once the landmarks are calibrated properly the system should be able to recognize them
automatically.

Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your
inspection file. Note that when a data is saved, the setup is also saved with it.

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.

r. Save Setup As Mw

. Setup

O Save setup in current inspection

File name: | New setup

Mame

Setup_DEFHI-ERBCA-148MF_SN_1327503

|\.f (0] 4 | [x{:ancel ]
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INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1.
2.

6.
7.
8.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the DefHi® probe on the Ectane 160-pin connector. The orange dot on the
connector must be align with with the orange dot on the Ectane.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

Pull the tube to inspect at approximately 12”/s (300 mm/s)

When it's done, press the Stop button or again F2 on your keyboard

Repeat step 4,5 and 6 for all the tubes to inspect in you bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two landmarks are needed to use this feature. These landmarks are created by default
when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1.

2.

Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

Click on Settings ...
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4.

5.

( E Sequence @1 rQ Manual Sequence Configuration @1

Sequence

/\ Type: ) Mene @ Landmark
Start Recording Landmark:
Launch .

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

' Pushing
' Pulling/Recording
' Waiting for Mext

0K | [ Cancel

You must be
connected to an

0 instrument to start
the sequence,

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button

or use a timer. Select the desired option in the Restart section.
Click on OK.

To use the manual sequence:

1.
2.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the DefHi® probe on the Ectane 160-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab

Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.
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7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

8. Pull the probe until it goes out of the tube. This will trigger the last landmark detection
that will stop the data recording.

9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.
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TUBE LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously
in the Tube list section of this document. To do so, checkmark the Automatic File Recording
option that can be found by clicking on the Acquisition preferences button in the Data window.
This option is selected by default.

1total, D acquired

() (#or) (X

@ Acquisition preferences:
P — Automatic File Recording
Daw

Please activate [T Auto Create new file on Mexdt
process. [ Automatic Next on Stop acquisition
Keep re-scan files

The list of tube is also shown in the Data window.

Data T X
Row| Col

» 001 001 b

b 002 001

b 003 001

b 004 001

4 total, 0 acquired

() (for) (X
(A (&) (¥)

Tubes can be added or removed by using the first line of buttons of this window.

A common practice is to rescan your calibration tube and balance on it periodically. You can
save this new calibration tube data by adding a new tube in your tube list (999 001 for example).
Or you can go out of the acquisition mode, scan your tube, and click on the Save Cal As... button
under the Calibration tab to save your data. You can then go back to the acquisition mode to
continue your inspection and to save automatically the acquired tubes in your bundle.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in
the Home tab.

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename
option.
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LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab. Note that double-clicking on a tube when you are still connected to an
instrument will start the data recording.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired

or| (% [
A [0 ] [ 0] sort order:

4 File name »

DQV
Please activate DQV an [~ Reverse order

process.
Sort by creation date

V| Show re-scans
| Show messages
[¥| Show screenshots
(¥ Next skip re-scan
("] Show only tagged files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an
entry in the report. These two buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.
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Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
to 3 | B E e m-(n =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.

78| Page



i ™
. Generate Report u r. Generate Report u1

1% Section Selection
“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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Analysis Report @ eddyﬁ Analysis Report @ eddyﬁ

Defact Table
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric
O ASME Inverted === == O Imperial
360
_| EDF

System Readback
|:| Do not display data during loading
Speed:
! Actual Inspection Speed
9 Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

O Reset to checked after loading a data file
Setup Wizard Path:  ChUsers\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo

Preview:

- ]
| (Y edd

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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ECT Bobbin Probes ECT Detachable Bobbin Probes

77

ECT Flexible Bobbin Probes ECT Magnetic Saturation
Bobbin Probes
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INTRODUCTION

This document presents how to use an ECT probe with Magnifi 4.3R10 on an Ectane test
instrument.

Eddyfi offers four types of ECT bobbin probes. The following was made using a standard bobbin
probe (ECT-BBST), but can also be applied to all other types of ECT bobbin probes.

EQUIPMENT

ECT probes use a 4-pin connector that can be connected on an Ectane with the “E"” option. The
absolute and differential signal from the probe will provide Strip charts and Lissajous.

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe
diameter is offered (see the tubing probe catalog for more details). A wide frequencies range
is also available to allow inspections of tubes of different thickness and material.

From the following tables, the best standard probe for your application can be selected. Note
that Eddyfi can also offers custom product that are not shown in these tables.

Table 5 - ECT-BBST probes diameter selection table

TUBE WALL THICKNESS (BWG, mm, in)

BWG 10 1 12 13 14 15 16 17 18 19 20 21 22 23 24

mm 340 308 277 241 211 183 165 147 124 107 089 08 071 065 056
in 0135 0120 0109 0095 0083 0072 0065 0058 0.049 0.042 0035 0037 0028 0.025 0.022

9.53mm 0.375in = = = = = = = = = = 070 072 074 076 078
12.70mm 0.500in = = = o2 078 084 088 090 096 098 102 104 106 106 108
15.87 mm 0.625in 084 090 096 104 110 114 118 122 126 128 132 134 136 136 138
19.05mm 0.7501in 114 122 126 134 140 144 148 152 156 158 162 164 166 166 168
22.22mm 0.875in 144 152 156 164 168 174 178 180 186 188 192 194 196 196 198
25.40mm 1.000in 174 182 186 194 198 204 208 210 216 218 222 224 224 226 228
31.75mm 1.250in 234 238 246 255 260 265 270 275 280 280 285 285 290 290 290
38.10mm 1.5000n 295 300 310 315 320 325 330 335 340 340 345 345 350 350 350
50.80mm 2.000in 415 420 430 435 440 445 450 455 460 460 465 465 470 470 470

TUBE 0D
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Table 6 - ECT-BBST probe frequency range selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 10 1 12 13 14 15 16 17 18 19 20 21 22 23 24
mm 340 305 27 241 211 183 165 147 124 107 089 08 071 065 056
in 0135 0120 0.109 0095 0083 0.072 0065 0058 0.049 0042 0035 0032 0028 0.025 0022

Aluminum UF UF UF UF UF UF UF UF UF UF LF LF LF LF LF
Aluminum bronze UF UF UF UF UF LF LF LF LF LF LF LF LF MF MF
Brass (admiralty) UF UF UF UF UF UF UF UF LF LF LF LF LF LF LF
Brass (70/30) UF UF UF UF UF UF UF UF LF LF LF LF LF LF LF
Brass (85/15) UF UF UF UF UF UF UF UF UF LF LF LF LF LF LF
= Brass (95/5) UF UF UF UF UF UF UF UF UF UF LF LF LF LF LF
cc Copper UF UF UF UF UF UF UF UF UF UF UF UF LF LF LF
E Copper-nickel (70/30) UF LF LF LF LF LF LF LF LF MF MF MF MF MF HF
= Copper-nickel (90/10) UF UF UF UF LF LF LF LF LF LF LF MF MF MF MF
Copper-nickel (95/5) UF UF UF UF UF LF LF LF LF LF LF LF LF MF MF
INCONEL® 600 LF LF LF LF LF MF MF MF MF MF HF HF HF HF HF
Stainless steel 304/316 LF LF LF LF LF LF MF MF MF MF MF HF HF HF HF
Titanium 99 % LF LF LF LF LF LF LF LF MF MF MF MF MF HF HF
Zirconium LF LF LF LF LF LF LF LF MF MF MF MF MF MF HF

Table 7 - ECT-BBST Frequency range

CODE FREQUENCY IN kHz
Min. Max, Central
UF 1 10 5
LF 10 100 ]
MF 50 500 250
HF 100 1000 500

The ECT calibration tube used in this document includes the following flaws:
e Internal groove, 10% of wall loss
e External groove, 20% of wall loss
e Hole, 100% of wall loss
e OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth
e OD4xFBH20% depth
But, other combinations of flaws can be used to calibrate the probe and to build sizing curves.

Note: Fill factor and selection tables may differ for other type of bobbin probes. Please refer to
the tubing probe catalog on our website to find out more.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named SS316_075x0.065_ECT for instance. This inspection folder groups the setup, the tube
list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

___________  E— l .l..

INSPECTION 2 INSPECTION X

| |
| |
| |

|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <«—> DATA |
| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4.3, the first page displayed is called the Backstage.

Magnifi® 43R10

General
Project / Inspection Information
Earer! Project Folder: C:\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default .c.) .5 Application:  Generic
Open/Add Add/Open e
Project Inspection Tube Dimensions:
oD: 19.05mm
Setup / Data
Setup Loaded: [unsaved) WT: 1.65 mm
z 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data .
Data Loaded: Material:  Stainless Steel304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata
Create New

Material Database List Import List
Report

Documentation Name: [Report.mdb =) ~ .
Table Profile: [ Tubing IRIS - © -

Generate Export Report
[] Take screenshot with report entry Report
Preferences

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an
existing project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project
file. Select New, Folder and enter the chosen name. You can then select the newly
created folder and click on Select Folder.

Bl select 2 project =

@‘\J'l » Computer » 0S(C:) » Users » daube.QTEC » Magnifi » v|4,|\ Se o

Organize v New folder =- @
It Favorites

& Downloads i

& OneDrive i

%l Recent Places E L

B Deskiop

Projects e

i Libraries @] shoeut

3 Documents 5 Microsoft Access Database

= Magnifi Data E B | Bitmopimage

* Magnifi Setup -

o Music = Micresoft Word Document

LIS View v Microsoft Access Database

Project:
QE‘] =9 Sortby v Microsoft Praject Document
Videos
Group by r Microsoft PowerPoint Presentation

- " Refresh Microsoft Publisher Document
% Computer

P Pate SonicWALL Global VPN Client Decument

3 ArchivesZetec (\srvarchives) (K Paste shortcut Rich Ted Format

8 QAData (Wsrvdata) (L) Undo Delete Ctrlez | | TedDocument

55 Mechanical (\srvdlata) (M) Share with R () | PPN

59 SoftwareProducts (srvdata) (N:) Microsoft Bxcel Workshest

@ Client (\\srvdata) (O:) New v Briefease

52 PublicShare (\srvdats) (P:) R

L Nualibe M eredatal (00 w2

Folder Magnifi

Select Folder
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name
of your inspection.

- Al
. Manage g

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|/ select | |3 Ciose |

3. Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Display

Analysis

System (Computer Related)

Measurement Convention Measurement Units
@ AsSME @ Metric

) ASME Inverted -—— +
) EDF o

) Imperial

Readback
[] Do not display data during loading
Speed:
7 Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

©) Reset to checked after loading a data file
Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup
Automatic Features

[] &llow to save setup in original location
Ask to save setup when the first data file is recorded

Loga
Preview:
-y o
Select
Company Logo

Shorteuts

Keyboard.. |
Remaote... |

<

Preferences

System

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter - |

Channels
Full Channel 5cale: 2000V p-p -
Hide Raw Channel
Precision
[ Enable

Amplitude: | 2 decim... =

Phase: 0 decim... ¥
Acquisition

Automatic File Recording

Auto Create new file on Mext
Automatic Mext on Stop acguisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Setup Wizard process. Click on Create
Setup to start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of Available
Material window.

5" New Setup Wizard *

Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: () Surface (® Tube from ID
Application: (@ Generic () Air Conditioner
Material: Carbon steel L
Resistivity: 21 pll-cm
Permeability: 450 p
Velocity: 5850.000 m/s
Wall thickness: 1.65 mm -
16
() CBWG
6 24
Qutside diameter: 19.05 mm =
Length: 6000 mm B

Mote about selected material:
ASTM: A178, ATT9, A192, AZ210, A214

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound
velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.
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You can add a note about the material to specify things like its application or composition.
When you are done, click OK.

(] List of Available Materials S|

Custom Maternals

Materials - Copy
i Velody (n/9) (crem) Pemesbilty
Stainless Steel 321 - ET ONLY 0.000 715 1| & Remaove All
Stainless Steel 430 - ET OMLY 0.000 63 100 | 3¢
Stainless Steel Duplex - ET OMLY 0.000 74 75 | %

Stainless Steel 9041 - ET ONLY 0.000 o4 75 (&
Titanium 6070.000 486 1 (%
Ti-BAI-4V - ET ONLY 0.000 123 1 (%€
Zirconium 4650.000 a1 1 |

Motes About Selected Material

v ok ][ conce

You will be back to the Component Definition window. If you added a new material, it will be
available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION
In the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down
menu. More precise filtering can be done by using the Model drop-down menu. You can then
select your probe by its catalog number (PRBT-ECT-BBST) and then click Next.

‘;— Mew Setup Wizard

/ I’\_, Probe Selection -

Select the probe that you want to use for your inspection

-
Technique: | ECT L | Model: | Bobbin v |
Probes

Tech. Model Catalog Mumber Y | Description

ECT Bobbin Bobbin ABS/DIF + AC ECT probe for air conditionner having ABS, DIF and AC channel.

|g New... | |"§Mgnage... |

(% Cancel | |4 Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

5% New Setup Wizard *

Scan Definition _

Configure the type of scan you will be performing with your probe

Scan: Single Pass
Paosition from: Clock hi
Acquisition rate: 2000 Hz =

L

Typical probe speed: | 1000.0 mm/'s

Acquisition Size: 600.000 s Maximum

|x Cancel ||< Back ||» Mext |

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 300mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 600mm. Using an encoder will give you the exact position of the probe.
Note that the position can also be obtained by using the landmark, but this feature will be
shown later.
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The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 2000 Hz for ECT, but depending on drive frequency used to inspect,
the actual acquisition rate may differ. The system will automatically readjust this value if
needed. For standard eddy current probes, the acquisition rate can always be set at 2000 Hz.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For an acquisition rate of 2000 Hz, the pulling speed needs to be less that Tm/s to have at least
2 points per millimeter. If you do not use a pusher-puller, the pulling speed won’t be constant.
Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. Also, the typical probe speed should be set as close as possible from the real
value. This will help the algorithm that automatically detect landmarks (explained later). The
recommended pulling speed for ECT is around 300mm/s.

If you selected the position from Encoder, different fields will appear and a second Scan
Definition page will become available.

2% New Setup Wizard =) 2 New Setup Wizard =]

Scan Definition [ | Scan Definition

Configure the type of scan you wil be performing with your probe Encoder and axis settings
Scant Single Pass e
Main Sean fis: ¥ Axis e [ClockDir =
Position from: Encoder Resolution: 2546 T

e are= [ nvert direction
Typical probe speed: 2500 mm/s Preset 0000 mm B
Maximum probe speed: 3500 mm/s = [¥] Apply preset on Start
Density: 2,000 smpl/mm
Acquisition Size: 100000 mm | ] Madmum
(9 cancel | (4 Back | [ Nex [3€ cancel | (4 Back | B Net

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.

Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute and Differential channels. It is important to set these parameters correctly before
acquiring the data since they are driven by the instrument and cannot be modified during the
analysis.

5% Mew Setup Wizard d

5 o=tz Deinition ]

Select the channels you will be using and the necessary frequencies

Gain: |58 dB -
Channels Required frequencies
MName Prefix Prefic  Val (kHz) Ampl (V) Phase (%)
Absolute ABS F1 57.6 2.50 0.0 IZI
Differential DIF 2 288 250 00 ]
F3 14.4 2.50 0.0 IZI
A 50 250 00 ]
A At least one suggested frequency is out of bounds and has
been clamped.
Suggest Add

|x Cancel | |‘ Back | [P Next |

By default, Magnifi suggest four frequencies theoretically calculated with the parameters
previously entered:
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Prefix Frequency
F1 2 x F90
F2 F90
F3 F90/2
F4 F90/8

But frequency and drive voltage can be changed by replacing their values in the Required
frequencies table. Up to 4 frequencies can be set at the same time. And the sum of their

amplitude cannot exceed 10V.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one
of the suggested frequency is not within the recommended probe frequency range, you can

either remove it by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly
used to detect indication close to support plates. They are built with 2 frequencies of a same
channel type to attenuate the effect of the support plate and to be able to size an indication

at this location more accurately.
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5% Mew Setup Wizard

Configure the channel mixes for your inspection

P Oxt= Deinition ]

Input Channel 1 Input Channel 2 Output Mixed Channel
DIF-F1 DIF-F3 MK

Mixed Reference Signal
REF

|x Cancel ||‘ Back | | b

Net |

If you do not wish to use mix channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which
input you want to use the mixed channel. Note that /Input Channel 2 has to have a lower
frequency than Input Channel 1. Mixed channel can be built for both absolute and differential

channels.

You can rename the output mixed channel by modifying the Output Mixed Channel field.

The Mixed Reference Signal (usually a support plate signal) will be used to calibrate the mix
channel. The system will apply processes to the chosen input channels and will subtract them

to eliminate the reference signal.

Click on Next.
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DATA PROCESSING

The Data Processing window used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to
every channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters
parameters after data acquisition, so it is always possible to fine tune the filters parameters
during analysis.

5% Mew Setup Wizard d

P& Data Processing ]

! Select the processings that you want to apply to the channels you have selected

[ Individually configure all the channels

Low Pass Median High Pass
Mame : Cutoff (Hz) Window Size (smpl)
ABS- 400 [ 3m
DIF- 400 [ 301
MIX1 400 [ 3m

|x Cancel | |‘ Back | | ’ Mext
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The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won't remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off
variations of the probe within the tube, changes in material, geometry or thickness. As a rule-
of-thumb, the width of high-pass median filter should be set to at least three times the longest
flaw that may be encountered. Data should be examined in its filtered and unfiltered states. It
is important to keep in mind that the high-pass median filters can distort phase. More
information about median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to
have functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

=% Mew Setup Wizard d
9 Detect Landmark ]
9 Configure landmarks detection
i Exit
Detection Channel: R_F1ABS v (Exit is used for
TS1 sequence only) TS2
L]
Paosition From: (® Start Record () Stop Record w I
1 Megative Positioning: From | 0.0 mm = STOp Start
Record |4 : Record
position from
Detection Engine: Legacy - Length 0
Landmark Table (in the order seen by the probe during data acquisition)
MNarme Type Pos. (mm) Min Oty Max Gty Shape Component Threshold (V) P2P (mm) Enable
Exit Exit -25 b -y 10000.00 Disabled IZI
152 152 0 p = 1000000 Enabled  [3¢]
T51 T51 6000 b -y 10000.00 Enabled IZI

Positioned Landmark

(% Cancel | |4 Back |[P Nex |

Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.
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You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or on the place you stop to
record (usually the operator side).

(Exit i d fi Exit
Detection Channel: | R_ABS-FL - (Bxitss “SG": f’: .
TS1 sequence only) TS2
Position From: @ Start Record _) Stop Record I I—
[C] Negative Positioning: From |00 mm - Stop Start
Record I4 I Record
i ] position from
Detection Engine: Extended Len gth 0
Fow it i £ Exit
Detection Channel: R_ABS-F1 ] = I; s USG'CJ: }OT )
TS1 sequence only) TS2
Position From: _) Start Record @ Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record I ;I Record
position from
Detection Engine: Extended O Lengr_h

In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering in the tube. It is enabled only when doing the
acquisition. As it can trigger the data recording, it is not included in the resulting data file and
is not available at the subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TS1 is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t's important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above

100|Page



example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.

Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s).

Calibration points can also be imported with the Import button.

5" Mew Setup Wizard X

@ Calibration Points ]

Configure calibration points used for channels and sizing curves

Units of measurement: | Percentages (%) b

Calibration points

MName Side Size

HOLE Through 100.0 x|
FBH-20 oD 0.0 x|
FBH-60 oD §0.0 x|
FBH-40 oD 200 ]
4xFBH-20 oD 0.0 x|
IDGR-10 ] 100 ]
ODGR-20 oD 200 x|
ODGR-40 oD 400 ]
ODGR-60 oD §0.0 x|
SUPPORT Unknown 0.0 ]
LIFT-OFF Unknown 00 ]
REF Mone 0.0

| L Import | |- Add |

|x Cancel ||‘ Back ||> Mext |

Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).

102|Page



CALIBRATION

The Calibration page is used to define reference signal(s) that will be used to set the
amplitude(s) and phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by putting it at 1V and 40° on both
the absolute and the differential channel. However, the calibration can be done differently on
each channel type. It can also be done individually for each frequency by selecting the
Individually configure all the channels option. Different reference signals can be set to calibrate
the phase and the amplitude independently.

+% Mew Setup Wizard d

O calibration ]

A Configure parameters to calibrate channel amplitude and phase

[ ] Individually configure all the channels

Amplitude Phase
MName - Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS- 1.00 HOLE MP 40.0 HOLE MP
DIF- 1.00 HOLE Pp 40.0 HOLE PP
MIXT 1.00 HOLE PP 40.0 HOLE PP

|3 Cancel | |4 Back |[Pp  Nex
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When you'll select the reference signal, the system will use the selected measurement method

to apply a rotation and a gain. Here is a short description of the available options:

1.

Absolute (A):

Uses a straight line from the Lissajous
origin to the main cursor position to
measure amplitude.

Absolute Horizontal (AH):

Uses only the horizontal component,
from the Lissajous origin to the main
cursor position to measure amplitude.

. Absolute Vertical (AV):

Uses only the vertical component,
from the Lissajous origin to the main
cursor position to measure amplitude.

. Absolute Peak (AP):

Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

. Absolute Peak Horizontal (APH):

Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

. Absolute Peak Vertical (APV):

Uses only the vertical component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

Average Peak (MP):

Takes the distances from points at the
extremity of the cursor to the peak of
the data selection to build an average

10

1.

12.

13.

vector. Used only, and recommended,
for absolute signals.

. Average Peak Horizontal (MPH):

Uses the horizontal component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Average Peak Vertical (MPV):

Uses the vertical component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Peak to peak (PP):

Uses the combination of the vertical
and horizontal component to
measure the maximum amplitude.

Horizontal (PPH):
Uses only the horizontal component
to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure
maximum amplitude. The firsts signal
transition is from the base of an
indication to its peak.

Click on Next went the parameters in the table are set according to your requirements.
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SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each
line in this table.

=% Mew Setup Wizard d

Sizing Curves ]

Add and configure the sizing curves necessary for your inspection

In3 Mame Source Measurement
ABS-F1 ABS-F1 Phase x|
ABS-F2 ABS-F2 Phase X]
DIF-F1 DIF-F1 Phase x|
DIF-F2 DIF-F2 Phase X]
MIXT MIXT Phase x|

(% Cancel | |4 Back |[P Nex |

The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals (amplitude or phase) obtained with your calibration standard. Magnifi will give you the
interpolated flaw size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.
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For every sizing curve created in the last window, a window will appear to configure the curve

properties. The name of the curve will be shown in the upper left corner of the page (ABS-F1in

the example below).

=% Mew Setup Wizard d
Sizing Curves -]
Configure the properties of the ABS-F1 sizing curve

Measurement method: MP L3 Select the curve's points:
Shape: BFDS . Marme Side Size
[] Report as remaining wall IDGR-10 b 100 il
HOLE Through 100.0
FBH-80 oD 80.0
FBH-60 oD 60.0
FBH-40 oD 40.0
4x FBH-20 oD 20,0 o
] REF Mone 0.0
[] ODGR-60 oD 60.0
[ ODGR-40 oD 40.0
[] ODGR-20 oD 20,0
] sUPPORT Unknown 0.0
[] LFT-OFF Unknown 0.0

|x Cancel | |‘ Back | |’

Mext |

The measurement methods options are the same as the one described in the calibration page

section of this document. By default, the option average peak is set for absolute channels and

the option peak to peak is used for the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short

description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):

A curve with two linear segments representing ID and OD (or Near and Far) side

calibration points in relationship with phase.
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2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve. Need at least three points.

The linear options are mostly used when little data points are available, while the options Best
fit (Dual Polynomial) is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select
the curve points for each sizing curves previously created. The order in which the points appear
in the list may influence your sizing cure. Make sure that the measured values of the calibration
points are in ascending order in the list. You can set Magnifi to show the remaining wall instead
of the defect size by checking the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when
analyzing the data.

a

- New Setup Wizard d

= _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect x|
D3l Distorted support indicatic  Defect @
ERO Erosion Defect x|
MDD Mo defect detected Mo indication @
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow @
WLL Wall loss long Defect x|
WLS Wall loss short Defect X]
WLT Wall loss taper Defect E

| L Import | | <= Add |

(% Cancel | |4 Back |[P Nex |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

= New Setup Wizard X
H i ]
. Configure display and layout properties
General options Lissajou / Strip chart options
Zoom behavior on stop acquisition: Miniature strip chart
Zoom to full scale
Proportion: 33.00 - | %
() Zoom to content . o
Display Direction: Down <

(®) Keep current scale

4Fk

Strip chart duration: |10 s

|x Cancel | |* Back | [P Next |

The scroll direction is the direction in which data appears on the screen. If you choose downward,
the signals will go from the top to the bottom of the screen. If you choose the upward direction,
the signal will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.
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The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one to the another via the

layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code
indication zone.

Layout with the blue background will be the one opened by default.

Layouts can be readjusted at any time.

5% New Setup Wizard X
T Display - ]

Select the layout that you want to use to display your inspection results

2 Strip charts, 1 Lissajous 2 Strip charts, 4 Lissajous

Wls]s| ¢

4 Strip charts, 2 Lissajous

L L

V]ids|s|s]s

. : Default layout

|x Cancel | |‘ Back | |\/ Finish

Click Next to complete the setup wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
AW A [~ @ & —
J —
o N 5 Y A N Fo @8
Comp Probe Scan Data Process Landmark pC.al Calibration  Sizing Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.

TUBE LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list
of tube.

This list can be created in the Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row, Col ']

001001.magdata E‘o |__©

Create Mew .
List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.
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Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click

on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to your list.

.
[l File List Creator

- ]

File List Cenfiguration

Mumber of Rows in Component: 1
Start Mumbering at Row: 1 .

Row Interval: 1

Mumber of Columns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 -

-

Include first and last column of each row

Files to Create: 1
Filename Preview: 001001
[+ Create & MNew ] |\{' Create | [ b 4 Cancel

L.

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in the
Tubepro software (available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume

button.
2. Click on Connect button under the Instrument tab. This will open the Instrument

configuration page. Click on the line showing the instrument on which you want to
connect and then click on Connect.

Home Setup Advanced Instrument Calibration

B R ¢ @

Setup  Disable Ch. Setup Info o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

F N
Instrument Connection (Ectane) ﬁ
——
Type Model MAC Address Host Status QConfig Details
Ectene2 | E128RNMI - EC:92:3300:00:14 ' ' :
Connect Cancel
[
r e —_——
Instrument Configuration 4 ﬁ
- -
Metworl Information Embedded Software Update

Mode: A tomatic - @ Use the embedded software that comes with Magnifi

P address: |192.168.19 .10 lUze custom embedded software

Subnet Mask:  |255.255.255.0

Gateway: DO0OO0O0

A

Two (2) acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode.
The Setup Mode is used to scan your calibration tube and make the necessary adjustments on
your setup without saving the data automatically. The acquisition mode is used for the
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inspection. When in this mode, the software automatically saves the acquired data using file
names based on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

O

4. Plug the bobbin probe on the Ectane 4-pin connector.

5. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Bring the probe head outside of the tube and start the acquisition by clicking on the
Acquire button under the Home tab or by pressing the F2 on your keyboard.

Pull the calibration tube at approximately 12”/s (300 mm/s)

When it's done, press the Stop button or again F2 on your keyboard

o

© N

BGO0E L & Magnifi® 43810
) [ vome | sehs  Atmnd  idument  Colbaon  m  AwicdedAmas Lymd ot View [ ]ele
. ™
o000 Lk L 2% O o)
S MUl Previow Acquire ™ Net  Rescan loadfle M Smeds.  Cler | K89 Prefences | Content  Fl # ter | MoDefect Copture AddNote Paleite
Mode Dita Setup Satup & R
Data * x T I=1" T Jo] (2] L orJ 72 [Fomv Jo] [ == %) T oo [ eev J (2] Lord T oo [ wwv,
Row| Col ~ | 80.0kHz 80.0 kHz B0.0 kHz L 80.0 kHz
< 000 00 . T et
@ o wor E— . LT
» o o L
LT - i
R —
soe_nm /,/"
Freeg - AN -
) sl (3] N -
A 7| m 14.34V 43 294 1157V 156°
- — el wIZ[#]7] N [ 3 e o Ea
e, O || N
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— i —_—
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- % PREI o Twe ] [ I
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/ / ;
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Ik 21 new notificabions Infarmation Repart
_:_ N |:.r[;::5 |mcm = |ume-:mw I”‘m’"l““f& ‘ © ©002001

Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These
buttons are used for the channel selection.

1. 2. 3. 4.
- DIF | F1,

4 4 4

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated
Strip chart to this channel.

PR ER R EER R DR ED E N AT
158.4 kHz 158.4 kHz ;

s
.

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

PRED N

158.4 F1ABS

F1DIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MiX1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only
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STRIP CHARTS AXIS ORIENTATION
The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from
chart.

| a

158.4 kHz

a

one axis to another, click on the box showing an arrow at the upper right corner of the Strip

oF | F1,

I ‘
/OOMING

zoom in this section.

On the strip chart, hold the right button of your mouse and drag on the zone of interest to
u J oF

158.4 khz

1 2000V [

u J oF [

1 2000y J=] PREFE v ]
{ | 58.4 kHz ECEL T j ...........................
/

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent

BREREA

158.4 kHz

[1 z000v [=]

o
E_ Full Extent

Previous Zoom

% Adjust Cursor Size
T BestFit

~+  Horizental

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

PR ERE EBEIE IR REED R
158.4 kHz F1DIF 156,84 kiiz

s
i

¢
)
-

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 2 3 4 5
N Y I E3

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement

3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

Allow a manual measurement of the signal. Hold and drag the left button of your

mouse to draw a vector in your Lissajous.

o
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LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your mouse and dragging it around the rotation axis. Note that is operation cannot
be performed on the raw channels since these channels have no gain or rotation applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,
make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard.

CALIBRATION AND SIZING CURVES

CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the calibration window

3. In the Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you selected your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

N8|Page



SIZING CURVES

The following section describes how to build your sizing curves.

1.
2.
3.

7% Calibration

® Channel A

) Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

3 Calibrate
Reset

Select the signal name in the list
Click on the green arrow button to associate the measured signal to the calibration

Go the calibration tab and click on the Sizing curve button
Select Channel and Sizing Curves in the Calibration window
Go over the signal in your Strip chart and adjust the cursors to see only the desired

If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of

When all your calibration points are checked marked, click on the Calibrate button

Note: The system calibrates the signal with a measurement method that is defined in the

calibration part of the setup (previous step). It is recommended to read the data with the same

method as the system when you selected your calibration point. This will allow you to see what

the system is using to make its calibration. If for some reason the measurement is not taken

properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is display on the

Lissajous to show the defect size. To have the correct interpolated point, the measurement

method also needs to be the same as the one used for the sizing curve. To change the

measurement method, click on the icons at the bottom left of the Lissajous.

4. Select the signal name in the list
5. Click on the green arrow
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6. Redo the previous steps for all the other indications in the list
7. Click on the Calibrate button
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Error messages after creating the phase sizing curves can appear. The main cause of these
errors is the measurement direction.

The image below shows two different measurements. On the left, you can see that the
measurement arrow is pointing toward the liftoff signal. In this case, the measured phase is
rotated of 180° from the right value. When one or more points were measured in the wrong
direction, Magnifi cannot build the sizing curve and will generate an error message. Note that
you won't have this issue with an absolute channel if you're using the average peak

measurement method.

On the image on the right, the arrow is pointing from the liftoff signal to the defect signal,
which is correct. However, in this picture, the arrow starts quite far from the middle of the liftoff
variation signal, which will cause an error in the measurement. In this case, we suggest you to
move the cursors until your measurement is taken from a point near the base of the signal.
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To adjust you sizing curves and remove the error messages, go the Calibration tab, and click on

View Curves.

. ~ .
[ select Calibration Point [ [ setect Calibration Point o
[ DiF-F1 - ECT) ~| [ DIF-F1 - (ECT) -]
100.0 O 100.0
82.0 b 80.0
& 60 T & son
B ' T H
w350 > 4 - 400
280 200
>
10.0 < 0o
300 340 20 60 100 140 7 37 67 el 128 158
Phase (degree) Phase (degree)
MName Side Size (%) Value (%) Name Side Size (%) Value ()
IDGR-10 D 00 10 T IDGR-10  ID 100 10 T
HOLE Through 100.0 a0 HOLE Through 100.0 40
FEH-80 oD 80.0 71 FEH-80 oD 80.0 1
FEH-60 oD B50.0 99 FBH-60 ap 60.0 99
FBH-40  OD A0.0 300 x FEH-40  OD 400 120
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The sizing curve window will appear. Each sizing curves you asked magnify to create will be
listed in the drop-down menu. If an invalid notification is present on the curve, it means that
either you haven’t entered the sizing points yet or that Magnifi failed to create the curve. To
adjust the sizing curve manually, enter the value in the table.

In the above example, the entered phase angle for the 40% defect is 300°, but the correct phase
angle for the 40% is 120°. The defect 40% has an 180° bias due to wrong measurement direction.
In this case, we can simply change the angle value from 300° to 120° in the table to fix the sizing
curve.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws
in the Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw
size does not appear, it means that you are not in a channel where a sizing curve was set.

LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TSTand TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).
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Once the landmarks are calibrated properly the system should be able to recognize them
automatically.
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Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your
inspection file. Note that when a data is saved, the setup is also saved with it.

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.

INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to your instrument.

2. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.

The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the bobbin probe on the Ectane 4-pin connector.

4. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press F6 on your keyboard.

5. Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

6. Pull the tube at approximately 12""/s (300 mm/s)

7. When it's done, press the Stop button or again F2 on your keyboard

8. Repeat step 4,5,6 and 7 for all the tubes to inspect in your bundle.

MANUAL SEQUENCE

b

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two (2) landmarks are needed to use this feature. These landmarks are created by default
when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1. Click on the Manual Sequence button under the Calibration tab.

2. If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

3. Click on Settings ...
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8.

' N . ™
E Sequence ﬁ Q Manual Sequence Configuration ﬁ

Sequence
/\ Type: ' None @ Landmark
Launch Start Recording Landmark: | Exit -
Start Recording Delay: 10= .

Stop Acquisition Landmark:  T51
Target Settings...

Stop Acquisition Delay: 20s .
Restart
MDD Review Type: () Mone ) UserInput @ Timer
@ Pushing Delay: 100s 3
. Pulling/Recording
- OK i |
.Waltmg for Mext | [ ancel

You must be
connected to an
instrument to start

the sequence.

Connect...

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button

or use a timer. Select the desired option in the Restart section.
Click on OK.

To use the manual sequence:

1.

2.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the ECT probe on the Ectane 4-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab

Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.

Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

Pull the probe until it goes out of the tube. This will trigger the last landmark detection
that will stop the data recording.
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9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.

TUBE LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously
in the Tube list section of this document. To do so, checkmark the Automatic File Recording
option that can be found by clicking on the Acquisition preferences button in the Data window.
This option is selected by default.

1 total, 0 acguired

x]

@ Acquisition preferences:

—— Automatic File Recording

Eli;e activate [7] Auto Create new file on Next

Process. [7] Automatic Next on Stop acquisition
Keep re-scan files

The list of tube is also shown in the Data window.

Data T X
Row| Caol

» 001 001 Eb

» 002 001

» 003 001

» 004 001

4 total, 0 acquired

() (for) (%]
() () (%]

Tubes can be added or removed by using the first line of buttons of this window.
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A common practice is to rescan your calibration tube and balance on it periodically. You can
save this new calibration tube data by adding a new tube in your tube list (999 001 for example).
Or you can go out of the acquisition mode, scan your tube, and click on the Save Cal As... button
under the Calibration tab to save your data. You can then go back to the acquisition mode to
continue your inspection and to save automatically the acquired tubes in your bundle.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in
the Home tab.

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename
option.

LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab. Note that double-clicking on a tube when you are still connected to an
instrument will start the data recording.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired
o) (o] (¢ .
B4 [0 [ %] Sort order:

t 4 Flename »

DQV
Please activate DQV an ] Reverse order
process.

| Sort by creation date
|| Show re-scans

V| Show messages

'¥| Show screenshots

(V] Next skip re-scan

"] Show only tagged files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an
entry in the report. These two buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.
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Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
to 3 | B E e m-(n =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tubes in each category.
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“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)
Measurement Convention Measurement Units
Preferences @ AsME @ Metric
O ASME Inverted === == O Imperial
360
") EDF

System Readback
|:| Do not display data during loading
Speed:
! Actual Inspection Speed
9 Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

General

O Reset to checked after loading a data file
Setup Wizard Path:  ChUsers\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo

Preview:

- ]
| (Y edd

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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INTRODUCTION

This document presents how to use an Eddyfi IRIS system with Magnifi 4 on an Ectane test
instrument.

Eddyfi offers five types of IRIS centering devices. The following was made using a small centering
device but can also be applied to other types of IRIS centering devices.

For illustration purposes, we used a SS316 tube 25.4 mm (1 in) in outside diameter (OD) and
1.96 mm (0.077 in) in wall thickness.

TERMINOLOGY

PROBE DELAY (PD)

Corresponds to the transit time of the ultrasonic pulse to reach the mirror (typically 20 ps to 23

us)
TUBE INTERNAL RADIUS (|R)*

Corresponds to the pulse transit time through water (from the mirror to the front wall)

* This explanation assumes a stationary mirror, thus we use internal “radius” instead of
“diameter”

TUBE WALL THICKNESS (WT)

Corresponds to the pulse transit time through the metal. Time in between front wall and back
wall

Front wall i,

_ Probe Delay IR\__’
N

" Mirror i

| T
“= Back wall

i
H

|
L Pin signal
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EQUIPMENT

CENTERING DEVICE

ULTRASONIC TRANSDUCER

TURBINE
IRIS PUMP
CABLES
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SELECTION

Select your hardware according to the following tables.
Example:

e CDSL-SLA: Small centering device
e TB-170:17.0 mm (0.67 in) turbine
e TD-15M-254: 15MHz, 25.4 mm (1in) focal length transducer

IRIS selection table for tubing:

TUBE WALL THICKNESSES

0.238 0206 0165 0135 0.109 0.083 0.065 0.049 003
COXS-SLA COXS-5LA
- - - - - - TB-0B3 TB-0B5 -
MTD-Z0M-191 MTD-20M-191
CDXS-SLA CDXS-SLA COXS-SLA COXS COXS
- - - - TB-085 TB-0B5 TB-170 T8-120 T8-120
MTD-20M-191 MTD-20M-191 TO-20M-254 TO-20M-254 TO-10M-254
COXS-5LA COXS-SLA CDXS-5LA CDXS-5LA COXS-SLA COXS-SLA COXS-SLA
- - TB-083 TB-083 TE-170 TE-170 TE-170 T8-120 T8-120
MTD-204-191 MTD-208-191 TO-15M-154 TO-15M-154 TO-20M-254 TO-20M-254 TO-20M-254
COXS-3LA COXS-3LA COXS-5LA COXS-SLA COXS-SLA CDXS-5LA COXS-SLA COXS-SLA
T8-083 T8-083 TE-120 TE-120 TE-120 TE-120 TE-120 T8-120 -

MTD-20M-191 MTD-20M-191 TO-I0M-154 TO-I3M-104 TO-13M-254 TO-13M-254 TO-20M-254 TO-20M-254

TO-IOM-318 TO-10M-318 TO-I0M-318 TO-15M-318 TOHI5M-318 TOHI5M-318 TO-I5M-318

v
EI COXS-SLA COXS-SLA COXS-SLA CONS-SLA CO3M-SLA COSM-5LA COSM-5LA COEM-5LA

T 25.40 1.oon Te-120 Te-120 TB-120 TB-120 TB-170 TE-ITD TE-IT0 Te-170 -
E TO-IOM-254 TD-10M-254 TD-10M-254 TD-15M-254 T0-15M-318 TO-15M-318 TD-20M-313 TD-20M-318

]

o CDEM-SLA COSM-SLA CIGM-SLA COMD COMD COMD COMD

= 15 1.750 Te-170 Te-170 TB-170 TB-170 TB-170 TE-IT0 TE-IT0 - -
=

(o]

COMD COMD COMD COMD COMD COMD COMD
LAl 1.500 TB-170 TB-170 TB-170 TE-170 TE-170 TE-ITD TE-IT0 - -
TO-I0M-318 TO-10M-318 TO-10M-381 TO-15M-3B1 TO-15M-361 TO-15M-381 TO-15M4-381
COMD COMD COLG COLG COLG CDLG CDLE
50.80 2000 TB-170 TB-170 TB-170 TE-170 TE-170 TE-170 TE-IT0 - -
TO-I0M-381 TO-IDM-381 TO-1DM-443 TO-15M-443 TO-15M-443 TO-15M-445 TO-15M-445
COLG COLG COLG COLG COLG CDLG
63.50 2.500 T8-170 T8-110 18110 TE-I70 TE-I70 TE-I70 - - -
T0-104-445 T0-10M-508 TO-10M-508 TO-15M-508 TO-15M-508 TO-15M-508
COLG COLG COLG COLG COLG COLG
T6.20 3.000 TE-IT0 T8-110 8110 TE-170 TE-I70 TE-I70 - - -

T0-10M-508 T0-10M-508 T0-10M-508 T0-15M-508 TO-15M-508 TO-15M-508
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IRIS selection table for piping:

UT TRANSDUCERS (MHZ, MM, IN)

DIMENSIONS 10 15 RECOMMENDED SPEEDS  gyu || T DETECTABLE
oD WALL THICKNESS 76.2 BB9 635 762 889 RO PULL DEFECT (TYP.)
MM IN SCH MM IN L 30 35 25 30 35 RPS MM/S IN/S MM IN
w | 35 | um ° B3 63 0158
503 20
3 | eo |aso0 | @ | 549 | oz 55 40 0I5t
wo || |un| e 5 533 2 18 0150
wo| s | un| @ ° It} 50 0197
45 18
2 | me | soo0 | @0 | sno| oms 50 67 018
o | a8 | oae | @ 5l 43 18 i (N
wo| s | un| @ ° n 405 16 56 02
g | ma3 e | w0 | sm | om ® I 53 0209
Iy 1
m | 8% | o3 o q 50 01
wo| oz | un ® B 20 13 7 017
5 | wos | s | w0 | 655 | 0o ® 3 65 060
6 14
B | 953 | oam ® El! 53 0,268
@ | o | om ° a0 0315
B | 1693 | 662 305 12
| nw | o ® 18 029
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PROJECT AND INSPECTION FOLDERS

In this section, we will create a folder structure that will manage the save locations of your
setup, data and report. This management is operated through the creation of a project.

Magnifi suggests two levels of file. The first level is the Project folder. It is meant to include
different inspections that are related in some way. For instance, it can include all the inspections
done at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of
file is the Inspection subfolder. Inspection subfolders are saved in the project folder. An
inspection subfolder can include the data specific to the inspection of a bundle of tubes with a
specific technology and could be named SS316_075x0.065_ECT for instance. This inspection
subfolder regroups the setup, the tube list, the data and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

I E— ﬂ | .l..

INSPECTION 2 INSPECTION X

| |
| |
| |
| |
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <> DATA

| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4, the first page displayed is called the Backstage.

General

Project / Inspection

Magnifi® 43R10

Information

Eerer Project Folder: C:\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default ro .5 Application:  Generic
Open/Add Add/Open
Project Inspection Tube Dimensions:
oD: 19.05mm
Setup / Data
Setup Loaded:  (unsaved) WL 165mm
: 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data )
Data Loaded: Material:  Stainless Steel 304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata
Create New
Material Database List Import List
Report
Documentation Name: [Reportman = . N
Table Profile: [ Tubing IRIS -] -
Generate
Export Report
[T] Take screenshat with report entry Report port Repo

Preferences

To create or open a project,

Start / Resume

existing project/folder or you can create a new folder.

click on Open/Add Project in the backstage. You can select an

Create a folder by right-clicking on the location where you want to add your Project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click

on Select Folder.

I select a project ||
@Uv‘ » Computer » 05(C) b Users b daubeQTEC b Magnifi » - [4]] ol
Organize *  New folder =5- @

¢ Favorites £

18 Downloads. i

& OneDrive | |

] Recent Places F I

B Desktop

Projects ——

4 Libraries [# shortcut

¥ Documents B Microsoft Access Database

= Magnifi Data E @ | Bitmapimage

. Magnifi Setup ——

@ Music M Microsoft Word Document

i Pictures View » | B Microsoft Access Database
Qﬂqpmms Sort by » | (@] Microsoft Project Document

Videos
Group by » | @Y Microsoft PowerPoint Presentation

. Refresh 4% Microsoft Publisher Document
1% Computer

& o5 paste [ SonicWALL Global VPN Client Document
59 ArchivesZetec (snvarchives) (K3 Paste shortcut 185 [Rch T Fomnat

¥ QAData (\srvdata) (L) Undo Delete Ctlez | o TedtDocument

8 Mechanical (\srvdats) (M) N , G4 Dessin Microsoft Visio

9 SoftwareProducts (\\srvdata) (N:) 8 Microsoft Bxcel Worksheet

& Client (\\srvdata) (0:) New » | Briefcase

59 PublicShare (\\srvdata) (P:) T

S8 Oislite Mensrara) (0 ~

Folder. Magnifi
Saecroim
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Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your
inspection.

r Bl
. Manage u

I Inspections
(1) Manage Inspections Select Other..

Mame State

Default Ready for Inspection

Bundle_A_55316_0.73X0.065_ECT ‘_@

|/ Select | [ Close |

L F

Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Analysis

System (Computer Related)

Measurement Convention Measurement Units
@ ASME @ Metric

O ASME Inverted s o O Imperial

O EDF o

Readback

[ Do not display data during loading

Speed:

O Actual Inspection Speed
© Maximum

"Keep Current Setup” Button Behavior:
*) Retain check state

© Reset to checked after loading a data file
Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[C] Allow to save setup in original lacation

Ask to save setup when the first data file is recorded

Loga
Preview:

4| (@ eddyfi

Shortcuts

Keyboard.. |
Remote... |

<

Preferences

System

General

Display

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter - |

Channels

Full Channel Scale: 2000Vpp -

Hide Raw Channel

Precision

|:| Enable

Amplitude: |2 decim...

Phase: 0 decim... »

Acquisition
Automatic File Recording

Auto Create new file on Mext
Automatic Mext on Stop acguisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Wizard option menu. Click on Create
Setup to start the Wizard.
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COMPONENT DEFINITION

The first page shown by the Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of Available
Material window.

% New Setup Wizard u “ ‘ ; J _4 ;.

/ Component Definition -
(2) P |

{_ﬁ_, Configure the geometry and material of the component to inspect

Geometry: @ Tube from ID () Surface

Material: Inconel 600 A [ Manage... ]
o Aluminum -
HEEERLE Alum@num (6061-T-6) — || Note about selected material

Aluminum brass - ET OMNLY Composition: ~16% Cr, ~8% Fe, MNi remaining
Aluminum bronze UMNS: NOGE00

Velocity: Brass (70/30) ASTM: B163 alloy 600

HENICILY: Brass (85/15) - ET ONLY
Brass (95/5) - ET OMLY
Carbon steel

Wall thickness: Carbon steel low-alloy Cr-Mo i
Cast iron (gray)

Copper

Outside diameter: | Copper nickel 70-30

Copper nickel 90-10

Length: Copper nickel 95-05 - ET ONLY

Ductile iron - ET OMLY

Hastelloy C

Incoloy 800 - ET OMNLY -

Permeability:

12

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material velocity value to its theoretical value. The resistivity and
permeability are used to set electro-magnetic techniques parameters only. They doesn’t need
to be set if an electro-magnetic inspection is not performed on this material.

You can add a note about the material to specify things like its application or composition.
When you are done, click OK.

1411Page



[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{:;;: ?r: /) [H;f;i::;t)’ Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove All
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 41 1 (%
N e I I Y < |-

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will be

available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.
Click Next when everything is set correctly.

Select or set the Material, Wall Thickness, Outside diameter and Length base of the tube you
are going to inspect. Click next when finish.
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5% Mew Setup Wizard d

A Component Definition -

e Configure the geometry and material of the component to inspect

Geometry: () Surface (® Tube from ID
Application: @ Generic () Air Conditioner
Material: | Stainless Steel 316 hd | | Magage...|

Resistivity: 74 plcm

Permeability: T

Velecity: 5660.000 m/s
Wall thickness: 1.98 mm =

14-15
| | . BWG

6
Qutside diameter:

Length: 5080 mm =

Mote about selected material:

Application: Austenitic alloy-steel boiler, superheater, and heat-
exchanger tubes,

Compaosition: ~17% Cr, ~12% Ni, 2% Mo, Fe remaining

UNS: 531600

ASTM: A213 TP316, A249 TP316, AGBE TP316

|x Cancel | | Back | | b Mext
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PROBE SELECTION

5% New Setup Wizard

p ”\_, Probe Selection -

Select the probe that you want to use for your inspection
™

Technique: | IRIS ~
Recommended

Accessories Eddyfi Part Number Description
Turbine IRIS-TB-170

Transducer IRI5-TD-20M-318

Centering Device  PRET-IRIS-CDSM-SLA

Selection for setup creation

Turbine: (7 8.5 mm (Eddyfi) Transducer frequency: (7 5 Mhz
() 12 mm (Eddyfi)
(® 17 mm (Eddyfi)
() Other

|x Cancel | |‘ Back | | ’ Mext |

By selecting the Iris technique, Magnifi will recommend a Turbine, Transducer and Centering
Device to be used for the optimal results for the tube in the previous section. In the case you
don't have the transducer in hand and you don’t have time to order it, we suggest using the
closest possible frequency and a focal a bit further than the recommended transducer. Click

Next when you're finished.
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SCAN DEFINITION

5% New Setup Wizard ot

Scan Definition _

Configure the type of scan you will be performing with your probe

Scan: Rotating

Main Scan Axis: ¥ Axis

Position from: Trigger ~

Acquisition rate: 16009 Hz =
Typical probe speed: | 20,0000 rps =

(% Cancel | |4 Back |[P Nex |

The position from: option defines how the c-scan is populated. It can be populated by using the
pin at the end of the turbine or using an encoder. The Acquisition rate can be increased after
the setup by clicking on Scan icon from the Setup menu. Increasing the Acquisition rate will
enable you to rotate faster, but the inspection can possibly become noisier. Click Next when
you're finished.
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5% Mew Setup Wizard d

Scan Definition _

Encoder and axis settings

Rotation Axis Axial Axis

Offset: 0.000 *

4k

Offset: |'D.DDO mm

4k

ik

Displayed Resolution: |2.'DDGI */smpl Displayed Resclution: |'I.DDO mm/smpl

4k

Size: 360.0 ° = Size: |5080.0 mm

4k

|x Cancel | |‘ Back | [P Next |

The resolution is set to have 180 points through the circumference and have 1 point every mm
on the tube axis. Click Next when you're finished.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when
analyzing the data.

a

- New Setup Wizard d

= _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect x|
D3l Distorted support indicatic  Defect @
ERO Erosion Defect x|
MDD Mo defect detected Mo indication @
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow @
WLL Wall loss long Defect x|
WLS Wall loss short Defect X]
WLT Wall loss taper Defect E

| L Import | | <= Add |

(% Cancel | |4 Back |[P Nex |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY

The Display window is used to set the layouts. Check marking the proposed layouts will make
them available in your setup. You will be able to switch from one the another via the layout tab.

Layout with the blue background will be the one opened by default.

Layout can be readjusted at any time.

5 Mew Setup Wizard *

L!TE] Display ]

Select the layout that you want to use to display your inspection results

1 C-scan, 3 Projections 2 C-scans, 2 Projections

cs cs BS

DS cs Cy
AC AC

1 C-scan, 2 Projections, 1 Info 2 C-scans, 1 Projection, 1 Info
cs BS cs BS
]| os ! | o !

AC AC

. : Default layout

|x Cancel | |" Back | |\/ Finish

Click Next to complete the setup wizard process.
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TUBE LIST

Magnifi will create a file for each inspected tube. The list of tube can be created in the
Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row_ Col V]

001001.magdata ‘-0 --Q
CreafiestNEW Import List

Four options are available to set the filename format:
1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tubes. You can also use the Create & New button to add
another set of tube to you list.
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[l File List Creator - XN

File List Configuration

Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 .

Mumber of Celumns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 .

Include first and last column of each row
Files to Create: 1 i
Filename Preview: 001001

[+ Create & Mew ] |\f Create | [x Cancel

M

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the file name window of the Frontstage. The
tube list can also be imported from another project using the Import List button. The tube list
file can be found in the Inspection folder. It is also possible to import a list created in Tubepro.
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HARDWARE ASSEMBLY

Note: Please report to the relevant supplied document if you use a micro turbine and extra-
small centering devices.

Unscrew the turbine base from the turbine.

Holding the centering device, screw the turbine base

e Make sure the arms do not come in conflict with the turbine base.

e To optimise your probe data, both centering modules must be far from each other and
the centering arms must be in the direction showed on the picture below:

Insert the microdot connector at the base of the centering device until it exits the base of the
turbine previously assembled

Screw the poly to the base of the centering device
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e Make sure the IRIS coaxial cable at the far end and close to the microdot connector is
not kinked. You may have higher noise just after the front wall echo in the A-scan. It will
directly affect the probe sensitivity on smaller defects.

Screw the transducer to the microdot connector

e [f yourtransducer has white spots on the curved section, this is an indicator to eventually
replace it. To increase its lifetime, don't use it without coupling (water) and remove the
BNC connector when the probe is not running.

Screw the turbine to its base

e The UT transducer must not push the turbine rotor. To avoid it, shake the IRIS cable until
the UT transducer is completely inserted in the turbine.

e Make sure the rotation is smooth. If not, you may have to lubricate the rotor. It may
also be necessary to clean the mirror for a better signal quality.

e Centering tape can be added on the turbine.

Connect the BNC cable to the BNC connector on the poly
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Connect the BNC cable to the Ectane

TIPS

To optimise your probe data, both centering devices must be far away from each other
and in the right direction, as in the picture below.

Centering tape can also be added on the turbine.

Make sure the UT transducer doesn’t push the turbine rotor. To avoid this situation,
shake the IRIS cable until the UT transducer is completely inserted in the turbine

With the XS centering devices, use the key to adjust both centering modules at the
proper strength.
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SETUP ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on the Start/Resume

button.
2. Click on the Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument on which you want to

connect and then click on Connect.

Home Setup Advanced Instrument Calibration

B R ¢ @

Setup  Disable Ch. Setup Info o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

F N
Instrument Connection (Ectane) ﬁ
——
Type Model MAC Address Host Status QConfig Details
Ectene2 | E128RNMI - EC:92:3300:00:14 ' ' :
Connect Cancel
[
r e —_——
Instrument Configuration 4 ﬁ
- -
Metworl Information Embedded Software Update

Mode: A tomatic - @ Use the embedded software that comes with Magnifi

P address: |192.168.19 .10 lUze custom embedded software

Subnet Mask:  |255.255.255.0

Gateway: DO0OO0O0

A

Two (2) acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode.
The Setup Mode is used to scan your calibration tube and make the necessary adjustments on
your setup without saving the data automatically. The acquisition mode is used for the
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inspection. When in this mode, the software automatically saves the acquired data using file
names based on the tube list.

3. For the gates adjustment, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

Of |
s ©

Setup Mull
FMode

4. Push the centering device fully in the tube and make sure the ultrasonic beam is in a
clear area in your standard.

Start / Resume

5. Click Start/Resume to start the setup.
| G = Magniis 43810 a x
22000 = .0 BiEE 90k
&)
SRS ol [ T [ 38 S8 8 SR LA

R R R SO G O O O O - » oos00n
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6. Increase the size of the A-scan window

| e anifis 430 _ox
Wome | Setup  Ammnced  instumemt  Cabortion  Ansius  Asteddnshs  Lyout  Cumentview i
— pu
. = A s o)
SEWP MUl Previeus Acguin Ne caifie ST Smeds K99 Drefernces | Content Pl Bestfa Comter | NoDefect Copture AddNote Paleste
Mode ctup Setup Etent

N N A A

7. Start the IRIS pump and press F2 to see live data.

L] Magnifie 43810 -ax
& Bestnurer Admnced  Instment  Cabbration  Ann  Aseted mabsh  Lwout  CurertView

04

I &

Ree te Clear Kuep Center

" Setup

e [eor [ oo,

1 Brn[t 1R |0 BEo A £ | e | P | wmaime] e TR | I | S0 [ 00

L : - -

Result

N - | |

Mo U NS N S

O No
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Press M o get an envoloppe over your A-Scan

BCCOE 8 v agnes 43810

Q) e | sewp  sswwes wmmer  commsn e svesicwn oo ceves Bl
S L .t a 3 ) ; -
00000 LK L2 i VE S| 9@ QD
S Nl Previows Sop St Net  Reson losdfle S Saefo. Clear | KMB prfeences | Comtent PP getFe Cemter | MoDefect Copture AddNote Palette
s oo o son et
=

£ D m' | | T oome ]
= -
om m
v
P
L
O . . o
» w7
L
g
» o o
L | ]
» o2 @ [l namls sl Eamffe | 7o [ Tar | e [ e [y [t [ e ]
» oo .
13 toel, 4 scqueed Y
A & - G
= o EnE
= e et Jomm ]
-
G
—
[ |
recerson [T =
P 5
DAYV screening Nt
T Nobieaton centerfommiion Docmentaton Repor
[T Pos ¥ imm) [Scale (mm) [PRS(ps]  [AR Ha)
[ o e o Mo | © » 005001 o

Set the start position and the length of the pin gate as narrowly as possible. The level
should be set to avoid the surrounding noise level. (This is to make sure no noise will
come in the gate and increase the rotation speed.)

= AR
Gorer | Goten |
Sean Durslion 3473 s
Gain (0098
Tension (200000 ¥
egus Fier [4524 e ]
Recsficaton [Yes K|

Smoothing Filer [75 Mz 3]

10. In this situation, reducing the overall gain will reduce the noise level. After the gain is

adjusted, click two times on P 1o refresh the A-scan.

i

Scan Duration [34.73 mm

20048 D>

Tension [200000V -]
InputFilee [4520MH 7]
Recticaion [ 2]

Smaothing Filer [ 75 MHz -

mentation Report
Tmm) [PRS (pn) PR
0 610

16008 © » 006001

o
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11. Adjust the front wall gate, it needs to be as low as possible without catching noise and
wide enough to get the movement of the front wall due to the centering.

[e]a]~]

W
o ML

™ Level relstive o
Deley

7CG [ 48 mm

12. Click on ™ to remove the envoloppe and click on 4 to zoom on the back wall.

@)~

General Gates |

Start Length Level

Back wall

I Level relative to Frontwall

Delay

Slope
TCE 10.00 dB/us

13. Increase the TCG slope as much as possible without putting too much noise in the

signal. The backwall signal should be around 80% of the full screen height.

u N Magnifis 43810 - s
€) [ Fome | s Ammnces  msment  Cosvation  napus  Avetesdnsis  Lsyout  Curmentview @] e cm]
. e I T
3 - Cig
j;‘-‘ Ml Stop e R ad File Clear  Ke®P  prserences ontent BestFit Cemter | MoDefect Capture AddMaote Palette

o] Col
Gon o

v o

v o o

> o o0

©ous

b o005 001 Z a
» o

o 0

» o oo

» o0 o

» o o

» oz m T |
» o3 oo

1310t 4 20qured

[ otmm [t mtmm ]

[T | T |

Test Resut

/ Ganersl  Gates

/ St Lengeh Level
Fin [61Tmm |[059mm | [90%

Frontwall007mm _|[277mm | [5%
Back wall [1.00mm 247 mm E
7 Levelretive o Frons sl

/ Detay Sege
/ TCG [048mm 50,00 dBAn
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14. Increase the Level and the Start position of the back wall gate to clean the C-scan and
bring the gate as close as possible to the front wall.
e T,

] Magnifié 43010 ~ox
©) [ vome | sem  Admnced  mumemt  Castwstion  dnayus  Aswsteadnsbais  Lyout  Cument view - [cm s c
o b § i
- - L'
SP Nl Proview Swp S Hen  Rewan Lovdfle SV Smcds Clw | KSR proemces | Comet Pl Butfe Comm | MoDeect Coptune AddNote Paere
Hode Dta senp setup tent

1T 1.05 mn] &7.1 %] 1 100mm

I
b oz o e T [ [ o e o M I T BT ey || e g [ somm [t 05w )
LN

1310tal. 4 acqured.

I L4

= =

Detay Sege
TCG [048mm [50.00dBAn

L —

ion Repart

T Pos ¥ (man) [Scale (mm) [PRS (rpa)  [oR (i)
1415 858140 00 &3 18008

006001

Press F2 to stop the acquisition, press F2 again start the acquisition and pull your calibration
tube. The pulling speed should be around 50 to 100mm/s

Magnifia 43810

Sox
CaMbuation  Anshysis  Asssted Amabsis  Lsout  Cument View [[v\m:gt]m’]
L " W) i '
< B L 0O B K E @ QD
G

Rescan LosdFde  SWe
Set

NoDefect Capture AddNote Palette
wp

¥
Keep  preferences
Setup.

Content  Full  BetFa Center
Btent

[t _0omm 1 100mm |

T = T S e T e || T

T oot Gten |
Start Length Level
Fn[617mm  |[055mm | [0
Frontwa [1007mm
Back wall [076mm | [266mm %
™ Leve estve o Frontwal
Detey Sope
Teo[oden | [amdEn
|
DQV Screening Note
O Notfication center _Informetion Documentation Report
Sl [ [F R I R A S A - © » 006001 °
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15. To troubleshoot this kind of result (green noise in the C-Scan), different options are
available. (Do the changes while you are acquiring the data to see the results live)

a. Reduce overall gain in the general tap.
b. Increase the level of the backwall gate.

In the image below the probe is on the 50% OD groove (the last part of the C-scan in yellow).

c. You need to reduce the level of the backwall gate.

d. You might need to decrease the overall gain again and increase the slope of the
TCG to clean the C-Scan

_ox

BEEED

[T | T |

[ otmm [t mtmm ]

» N -

Goneral | Gates

Scan Duraton [35.26me

smationDocumentation Report

T Bos ¥ {mm) [Scale (mrm) [PRS (rps) [/4R (Fiey
4673 28500 oo = 16008

16. Put the cursor into a clear portion of the tube. Click on

, select ProbeDelay and

WallThickness and then press Calibrate. (That will adjust the velocity and wedge delay

to get the defined WT in your readings)
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17. Play with the color palette to improve the image.

= Palette Selector X
Coseme [WT :
Palette Sym  From To

Inverted Rainbow v O [108mm 2| 188mm *

appyToal | [ ok | [ Cancel
MGOOB L & - MG 43010 . et ettt e et —_— —— Sox
[&]4¢]emfm clem]
Ot

97 [ 108 w1 215 00 3 ] S S50 [ 120 T 1 0T e 7o | i 26 (R | e | [ oo [ woomm

I™ Level relative o Front wall
i
DOV Ser MNote
[ r Information Documentstion Repert
| R el el P e o © » 006001 o

Note: In this presentation, we used a shorter focal length (1in) for the transducer. So, it reduces
the Back Wall response. That's why the 50% groove (3™ groove) is not clean. The level of the
OD signal of the 50% groove is sometimes at the same level as the base noise.
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INSPECTION

The following section describes how to perform an inspection.

1. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

2. Insert the centering device/turbine in to the tube to inspect, start the IRIS pump and
start the acquisition by clicking on the Acquire button under the Home tab or by
pressing the F2 on your keyboard.

3. Pull the calibration tube at approximately 2/s (50 mm/s).

4. When it's done, press the Stop button or again F2 on your keyboard.

5. Repeat step 2,3 and 4 for all the tubes to inspect in you bundle.

For each acquisition taken, Magnifi can automatically save a file using the file name defined
previously in the Tube list section of this document. To do so, checkmark the Automatic File
Recording option that can be found by clicking on the Acquisition preferences button in the
Data window. This option is selected by default.

Data 7 X
|File name ’;
() MUE-ECT-TUBED SS - 1 =]

1

+" MUE-ECT-TUBEDE 55-2
» MUE-ECT-TUBEDE 55-3
+" MUE-ECT-TUBEDE S5-4
+" MUE-ECT-TUBEDE 55-1

10total, 10 acguired

(%) =
@ LM * | Acquisition preferences:
Automatic File Recording
oo Autto C /i
Please activate Auto Create new file on Mext

process. Automatic Mext on Stop acquistion
Keep re-scan files

The list of tubes is shown in the Data window at the left of the Frontstage.

Data 2%
Row| Col

b 001 001 ED

B 002 001

B 003 001

B 004 001

4 total, 0 acquired

() (For) (%)
(A (2] (%]
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Tubes can be added or removed by using the first line of buttons of this window.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting a tube in the list and by clicking on the Rescan button in the
Home tab.

Also, a tube name can be changed by right-clicking on a tube in the list and by selecting the
Rename option.

LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

Data a4 x

|File name
(' MUE-ECT-TUBEDE 55-1 E]
+ MUE-ECT-TUBEDE 55-2
/' MUE-ECT-TUBEDE 55- 3
+ MUE-ECT-TUBEDE 55-4
" MUE-ECT-TUBEDB §5- 1

amo

10 tatal, 10 acquired

| (%) I
L] (22 ] [¥:2] sor order.
DoV

4 File name *
Flease activate DGV an 7] Reverse order
process.

[T Sort by creation date

Show re-scans

Show messages
Show screenshots
Mext skip re-scan

[ Show only tagoed files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the B-Scan windows can be used to add an
entry in the report. These two buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the indication in the C-scan and adjust the cursor so that the cursor only include
the indication

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.

il . =] =] || 088 m| w528 |1 00mm |
@A 3 5 ____ 2 an 7
~

COR
CRK
DNT
DSl
£RO
NDD
083
I: PIT
- PLG
- RST
wiL
wis

Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it
is plugged.

To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

[» oBs | o
io E-m DG r | EHR OE | gy = =
ext

Review | | No Defect | RST Completion Inset  Export  Display Profile Subtraction | Infofield Cal. Infofield

Previous
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REPORT TABLE

To access the list of defects entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification Information

Report BDocumentation DOV Screening  Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report
Zone Row Col.” Code Size Side WT(mm)  ChanneliC-scan Y pos. (mm) Yleng. (mm)  Xpos. () Xleng. (%) Comment
1 EU 27 790 PIT 54.76 ° 095 IRIS 1029.0 15.0 276.00 3400 E

Information Documentation Report

Entries in the report can be modified by changing the value in the table. You can also delete an
entry by clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.
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i ™
. Generate Report u r. Generate Report u1

1% Section Selection
“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)
Measurement Convention Measurement Units
Preferences @ AsME @ Metric
O ASME Inverted === == O Imperial
360
") EDF

System Readback
|:| Do not display data during loading
Speed:
! Actual Inspection Speed
9 Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

General

O Reset to checked after loading a data file
Setup Wizard Path:  ChUsers\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo

Preview:

- ]
| (Y edd

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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MFL Application Guide
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MFL Probes

170|Page



INTRODUCTION

This document presents how to set up and calibrate the MFL probe with Magnifi 4 on an Ectane
test instrument using the Setup Wizard.

EQUIPMENT

The MFL probes use a 19-pin connector that can be connected on an Ectane with the “ERMN"
option.

The Absolute, Differential and Trail signal from the probe will provide Strip charts and Lissajous.
Magnetic flux leakage technology gives a variation of amplitude only. The phase variation on
the Differential channel is artificially built to help the user to identify the indications. The Trail
signal is more sensitive to internal flaws and can help to determine the flaw side in a tube.

From the following table, the best standard probe for your application can be selected.

Note that Eddyfi can also offers custom product at diameter that are not shown in this table.
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Table 8 - Probe diameter selection table

PRBT-MFL-ADT-XXX-Nzz
|

TUBE OD TUBEWT DIAMETER PoLY PROBE PART NUMBER NOTES
mm in BWG mm in CODE mm in CODE LENGTH
12 277 0.109
124 12.4 0.488 PRET-MFL-ADT-124-Nzz
13 241 0.095 These probes offer less sensitivity
19.08 0.750 14 21 0.083 o = R LT to external defects, because the
. . -MFL-ADT-138-Nzz i
15 183 0.072 .mr.e. sections of the probes are
significantly smaller than the tube
16 1.65 0.065 148 14.8 0.583 PRBT-MFL-ADT-148-Nzz section. Sensitivity to internal
9 376 0148 | 1e2 162  0.638 PRBT-MFL-ADT-162-Nzz defects remains very high.
10 3.40 0.134 170 17.0 0.669 PRET-MFL-ADT-170-Nzz
" 3.05 0120
180 18.0 0.709 PRET-MFL-ADT-180-Nzz
12 277 0.109
2540 1.000 13 2.4 0.095 188 18.8 0.740 PRET-MFL-ADT-188-Nzz
14 21 0.083
194 194 0.764 PRET-MFL-ADT-194-Nzz
15 1.83 0.072
16 1.685 0.085 20 20m (B51t)
200 20.0 0.787 PRET-MFL-ADT-200-Nzz
17 147 0.058 30 30m(98fh)
10 3.40 0.134
230 23.0 0.908 PRBT-MFL-ADT-230-Nz
" 3.05 0120
12 277 0.109
.75 1.250 244 244 0.961 PREBT-MFL-ADT-244-Nzz
13 24 0.095
14 21 0.083
256 25.6 1.008 PREBT-MFL-ADT-256-Nzz
15 1.83 0.072
10 3.40 0.134
290 290 1.142 PRET-MFL-ADT-290-Nz
" 3.05 0.120
12 277 0.109
3810 1500 302 30.2 1.189 PRET-MFL-ADT-302-Nzz
13 24 0.095
14 21 0.083
35 5 1.24 PRET-MFL-ADT-315-Nzz
15 1.83 0.072

The MFL calibration tube used in this document includes the following flaws:
e Internal 360° groove, 10% of wall loss
e External 180° groove, 40%,60% and 80% of wall loss
e OD Flat bottom hole (FBH) 40%, 60% and 80% depth
e Hole, 100% of wall loss

But, other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named SS316_075x0.065_ECT for instance. This inspection folder groups the setup, the tube
list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

___________  E— l .l..

INSPECTION 2 INSPECTION X

| |
| |
| |

|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <«—> DATA |
| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4, the first page displayed is called the Backstage.

Magnifi® 43R10

General
Project / Inspection Information
Earer! Project Folder: C:\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default .c.) .5 Application:  Generic
Open/Add Add/Open e
Project Inspection Tube Dimensions:
oD: 19.05mm
Setup / Data
Setup Loaded: [unsaved) WT: 1.65 mm
z 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data .
Data Loaded: Material:  Stainless Steel304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata
Create New

Material Database List Import List
Report

Documentation Name: [Report.mdb =) ~ .
Table Profile: [ Tubing IRIS - © -

Generate Export Report
[] Take screenshot with report entry Report
Preferences

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an
existing project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project
file. Select New, Folder and enter the chosen name. You can then select the newly
created folder and click on Select Folder.

Bl select 2 project =

@‘\J'l » Computer » 0S(C:) » Users » daube.QTEC » Magnifi » v|4,|\ Se o

Organize v New folder =- @
It Favorites

& Downloads i

& OneDrive i

%l Recent Places E L

B Deskiop

Projects e

i Libraries @] shoeut

3 Documents 5 Microsoft Access Database

= Magnifi Data E B | Bitmopimage

* Magnifi Setup -

o Music = Micresoft Word Document

LIS View v Microsoft Access Database

Project:
QE‘] =9 Sortby v Microsoft Praject Document
Videos
Group by r Microsoft PowerPoint Presentation

- " Refresh Microsoft Publisher Document
% Computer

P Pate SonicWALL Global VPN Client Decument

3 ArchivesZetec (\srvarchives) (K Paste shortcut Rich Ted Format

8 QAData (Wsrvdata) (L) Undo Delete Ctrlez | | TedDocument

55 Mechanical (\srvdlata) (M) Share with R () | PPN

59 SoftwareProducts (srvdata) (N:) Microsoft Bxcel Workshest

@ Client (\\srvdata) (O:) New v Briefease

52 PublicShare (\srvdats) (P:) R

L Nualibe M eredatal (00 w2

Folder Magnifi

Select Folder
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name
of your inspection.

i R
. Manage g

I Inspections
o Manage Inspections Select Other...

MName State

Default Ready for Inspection

Bundle_A_C5_254x2.77_M Fl| |_E

| v/ select | [ Close |

3. Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Display

Analysis

System (Computer Related)

Measurement Units
© Metric

) Imperial (

Measurement Convention
© ASME

O ASME Inverted
O EDF :

ot

Preferences

Readback
[] Do not display data during loading
Speed:
7 Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

@) Reset to checked after loading a data file

System

Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[] &llow to save setup in original location General

Ask to save setup when the first data file is recorded

Loga
Preview:
-y o
Select
Company Logo

Shorteuts

Keyboard.. |
Remaote... |

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter - |

Channels
Full Channel Scale: 2000V p-p =
Hide Raw Channel
Precision
[ Enable

Amplitude: | 2 decim...

Phase: 0 decim... ¥
Acquisition

Automatic File Recording

Auto Create new file on Mext
Automatic Next on Stop acquisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Setup Wizard process. Click on Create
Setup to start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of
Available Material window.

r','- New Setup Wizard ﬂ-‘
ﬁ Component Definition = = |

Configure the geometry and material of the component to inspect

Geometry: () Surface @ Tube from ID
Application: @ Generic () Air Conditioner
Material: [Carbon steel vl [ Manage... ]
Resistivity: 21 pllcm
Permeability: 450 p
Velocity: 5830.000 m/s
Wall thickness: 2377 mm -
12
[} - BWG
6 24
Outside diameter: 2540 mm -
Length: 6000 mm -

Mote about selected material:

ASTME A178, A179, A192, A210, AZ214

W »y

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound
velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.

You can add a note about the material to specify things like its application or composition.
When you are done, click OK.
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[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{:;;: ?r: /) [H;f;i::;t)’ Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove All
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will be

available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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P

In

ROBE SELECTION

the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down

m
se

enu. More precise filtering can be done by using the Model drop-down menu. You can then
lect your probe by its catalog number (PRBT-MFL-ADT) and then click Next.

-

— ™y
;'- New Setup Wizard .t ’ ' u

‘l’\_, Probe Selection b—! |

Select the probe that you want to use for your inspection

i
Technique: |MFL | Model  [All -
Probes

Tech. | Model ‘ Catalog Number Y | Description

17.9mm

MFL

(& New.. || Manage. |

[ Cancel || Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

% New Setup Wizard : , @

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: W Axis

Position from:

Acquisition rate: 2000 Hz -

k

Typical probe speed:  1000.0 mm/s

Acquisition Size: 600.000 s . Maxirnum

-

[x Cancel H< Back “’ Mext |

L A

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 1000mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 2000mm. Using an encoder will give you the exact position of the
probe. Note that the position can also be obtained by using the landmark, but this feature will
be shown later.

The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 2000 Hz for MFL.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For an acquisition rate of 2000 Hz, the pulling speed needs to be less that Tm/s to have at least
2 points per millimeter. If you do not use a pusher-puller, the pulling speed won’t be constant.
Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
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resolution target. Also, the typical probe speed should be set as close as possible from the real
value. This will help the algorithm that automatically detect landmarks (explained later). The
recommended pulling speed for MFL is around 1000mm/s.

If you selected the position from Encoder, different fields will appear and a second Scan

Definition page will become available.

3 New Setup Wizard

3 , =

3 New Setup Wizard

Scan Definition
Configure the type of scan you will be performing with your probe
can
i i i

ed:  1500.0 mm/s.

2.000 smplfmm

100000 mm & Maximum

(%€ cancel | (4 Back |[p Wex

Scan Definition
Encoder and axis settings

Axial Encoder

Type: |Quadrature

Resolution: ~ 25.460
[ Invert direction
Preset  0.000mm :
Apply preset on Start

[3€ cancel | (4 Back | [P Nex

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.
Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at O mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain for the different channels. It is
important to set these parameters correctly before acquiring the data since they are driven by
the instrument and cannot be modified during the analysis.

r ™
%+ New Setup Wizard Y '. ' u
ﬂ Data Definition = |

* Select the channels you will be using and the necessary frequencies
Connector: 19 pins
Channels
MName Prefix Gain (dB)
ABS ABS 300
DIF1 DIF1 48.0
TRAIL TRL 36.0
DIF2 DIF2 48.0
|3 Cancel | |4 Back |[P Nex
L A

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. For MFL, a mix channel is built by default to
create a differential signal shape on the differential signal. This part of setup is used for internal
signal processing purpose only and it is not recommended to change it.
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r‘,'- New Setup Wizard Y ‘ ! ' u-‘
ﬂ Data Definition r b | |

Configure the channel mixes for your inspection

Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal
DIFIDC DIF2DC DIFDC DO NOT USE (X

|3 Cancel || Back |[Pp Nex |

L.

Click on Next.

DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while a wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters
parameters after the acquisition, so it is always possible to fine tune the filters parameters
during the analysis.
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" New Setup Wizard ) , @

Data Processing

Select the processings that you want to apply to the channels you have selected

<7

[T Individually configure all the channels

Low Pass Median High Pass
MName ) Cutoff (mm) Window Size (mm)
ABSDC [ 40 ] 1500
DIFIDC E 40 [C] 1500
DIF2DC E 40 ] 1500
DIFDC ] 40 [[] 1500
TRLDC E 40 [C] 1500

|3 Cancel || Back |[p Nex |

L 4

The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won't remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off
variations of the probe within the tube, changes in material, geometry or thickness. As a rule-
of-thumb, the width of high-pass median filter should be set to at least three times the longest
flaw that may be encountered. Data should be examined in its filtered and unfiltered states. It
is important to keep in mind that the high-pass median filters can distort phase. More
information about median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.

184 |Page



DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to
have functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

i ™
5+ Mew Setup Wizard ' ’ @

9 Detect Landmark e - |
9 Configure landmarks detection

Exit is used for Exit
Detection Channel: R_ABSDC - gequeme only)
TS1
. TS2
Position From: (@ Start Record () Stop Record w I I—
[C] Negative Positioning: From | 0.0 mm - Stop Start
Record |< : Record
position from
Detection Engine: [Legaq.r vl Length 0
Landmark Table (in the order seen by the probe during data acquisition)
MName Type Pos. (mm) Min Qty Max Qty Shape Component Thresheld (V) P2P (mm) Enable
Exit Exit 25 } - 1000000 Disabled (3¢
152 182 0 } = 1000000 Enabled (3¢
751 Ts1 6000 } = 1000000 Enabled (3¢

Pasitioned Landmark

Import... H Export...

[ Cancel |[d Back |[Pp Nex |

L. &

Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or on the place you stop to
record (usually the operator side).
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(Exit i d ff Exit
Detection Channel: R_ABS-FL -] (Exitis “36": 'ﬁr .
TS1 sequence only) mSZ
Position From: @) Start Record _) Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record |g ] Record
™~ 1
position from
Detection Engine: Extended Len gth 0
(Exit i d fi Exit
Detection Channel: R_ABS-F1 - (=Xitis “59": ﬁr .
TS1 sequence only) TS2
Position From: _ Start Record @ Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record I ;i Record
position from
Detection Engine: Extended O Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering in the tube. It is enabled only when doing the
acquisition. As it can trigger the data recording, it is not included in the resulting data file and
is not available at the subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TST is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t's important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above
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example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.

Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known.

Click Next when you are done.

187 |Page



CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s).

Calibration points can also be imported with the Import button.

rd ™y
=" New Setup Wizard v '. ' ﬂ
Calibration Points = - |
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%) -
Calibration points
Mame Side Size
HOLE Through 1000 (X
FEH-80 oD 80.0 @
FEH-60 oD 60.0 [z]
FEH-40 oD 400 @]
FEH-20 oD 200 @
IDGR-10 D 100 [z]
IDGR-20 D 200 @
W5180-20 oD 200 @
WS180-40 oD 400 @
WS5180-60 oD 60.0 @
WS180-80 oD 80.0 [z]
DO NOT USE None 0.0
L Import | | == Add
|3 Cancel || Back |[p Nex |
L >

Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).

188 |Page



CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the
amplitude(s) and phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by putting it at 1V and 90° on the
differential channel. The wear scar 60% is used to calibrate the absolute channel at 6V and 90°.
And, the inside diameter groove is used to set the trail signal at 10V with a phase of 0°. These
calibrations are done to have the amplitude on one axis only (0° or 90°) since signals from the
MFL probe doesn’t have a phase. Different reference signals can be set to calibrate the
amplitude independently for each channel. Simply modify the parameters in the table to
customize the calibration.

. ™ ] I .
5+ New Setup Wizard , @

6 Calibration | |

A Configure parameters to calibrate channel amplitude and phase

[T Individually configure all the channels

Amplitude Phase
MName Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABSDC 6.00 WS180-60 pp 0.0 DO NOT USE Pp
DIFIDC 1.00 HOLE pp 90.0 DO NOT USE Pp
DIF2DC 1.00 HOLE pp 90.0 DO NOT USE PP
DIFDC 1.00 HOLE pp 90.0 DO NOT USE Pp
TRLDC 10.00 IDGR-10 pp 0.0 DO NOT USE Pp

[x Cancel H‘ Back I[’ Mext l

L A

When you'll select the reference signal, the system will use the selected measurement method
to apply a rotation and a gain. Here is a short description of the available options:

1. Absolute (A): 2. Absolute Horizontal (AH):
Uses a straight line from the Lissajous Uses only the horizontal component,
origin to the main cursor position to from the Lissajous origin to the main
measure amplitude. cursor position to measure amplitude.
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3.

Absolute Vertical (AV):

Uses only the vertical component,
from the Lissajous origin to the main
cursor position to measure amplitude.

. Absolute Peak (AP):

Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

. Absolute Peak Vertical (APV):

Uses only the vertical component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

Average Peak (MP):

Takes the distances from points at the
extremity of the cursor to the peak of
the data selection to build an average
vector. Used only, and recommended,
for absolute signals.

. Average Peak Horizontal (MPH):

Uses the horizontal component of the
distances form points at the extremity
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1.

12.

13.

of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Average Peak Vertical (MPV):

Uses the vertical component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Peak to peak (PP):

Uses the combination of the vertical
and horizontal component to
measure the maximum amplitude.

Horizontal (PPH):
Uses only the horizontal component
to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure
maximum amplitude. The firsts signal
transition is from the base of an
indication to its peak.

Click on Next went the parameters in the table are set according to your requirements.



SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each
line in this table.

r‘,'- New Setup Wizard | '. ' ﬂ1
Sizing Curves = - |
Add and configure the sizing curves necessary for your inspection
D MName Source
ABS ABSDC (%
DIF DIFDC (%
[ Cancel || Back |[Pp Nex |
L. &

The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals obtained with your calibration standard. Magnifi will give you the interpolated flaw size
base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve
properties. The name of the curve will be shown in the upper left corner of the page (ABS in the
example below).
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s % ] I .
%+ New Setup Wizard , &

Sizing Curves | |
Configure the properties of the ABS sizing curve
Meazurement method: [ PP v] LrsElli et
Shape: [ BEP v] MName Side Size
WS180-40 oD 40.0 T
Shape orientation: [ Auto, ']
W5180-60 oD 60.0
[T] Report as remaining wall WS180-80 oo %00
v - .
Force to zero =3
[] DO NOT USE None 0.0
[7] IDGR-10 D 100
[7] IDGR-20 D 200
[] HOLE Thraugh 100.0
[] FBH-20 oD 200
[E] ws180-20 oD 200
[] FBH-40 oD 40.0
[] FBH-GOD (o]u] 60.0
[E] FBH-80 oD 80.0
[x Cancel ] [‘ Back ] I b Nex |

L 4

The measurement methods options are the same as the one described in the calibration page
section of this document. By default, the option Peak to Peak is set for absolute channels and
the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short
description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relationship with phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.
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5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve. Need at least three points.

Once the measurement method and the interpolation curve shape are chosen, you can select
the curve points for each sizing curves previously created. The order in which the points appear
in the list may influence your sizing cure. Make sure that the measured values of the calibration
points are in ascending order in the list. You can set Magnifi to show the remaining wall instead
of the defect size by checking the box Report as remaining wall thickness.

Click Next when you are done.

INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when

analyzing the data.

','- MNew Setup Wizard

=~ -

Code
COR
CRE
DNT
DSt
ERO
NDD
0BS
PIT
PLG
RST
WLL
WLS
WLT

— Indication Codes

Configure the indications codes used for the report

Description
Corrosion

Crack

Dent

Distorted support indicatic
Erosion

MNe defect detected
Obstructed

Pitting

Plugged

Restricted

Wall loss long

‘Wall loss short

Wall loss taper

Type Automatic Color
Defect

Defect

Defect

Defect

Defect

Mo indication

Feature Ib Red
Defect

Feature Ib Brown
Feature I Yellow
Defect

Defect

Defect

(3631 (3€) (3¢ (3¢) (3¢ 3¢ ) (¢ ¢ ) 3¢ 3¢ ¢

& Import | | =f= Add

[x Cancel ][‘ Back ]I’ Mext |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the

data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done

193|Page



DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

s A
5" New Setup Wizard . ’ @

. = Display | 1l

Configure display and layout properties

General options Lissajou f Strip chart options

Zoom behavior on stop acquisition: [F] Miniature T

Zoom to full scale

3

Proportion: 33.00 %

4

() Zoom to content

Display Direction: Top to Bottom -

@ Keep current scale

3

Strip chart duration: 6000 mm

4

[x Cancel H‘ Back “’ Mext |

e A

The scroll direction is the direction in which data appears on the screen. If you choose downward,
the signals will go from the top to the bottom of the screen. If you choose the upward direction,
the signal will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.

The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one to the another via the
layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code
indication zone.

Layout with the blue background will be the one opened by default.

Layouts can be readjusted at any time.
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' ™
5+ New Setup Wizard . | ’ @

Display e 1
Select the layout that you want to use to display your inspection results

3 Strip charts, 3 Lissajous stacked 2 Strip charts, 1 Lissajous

(]

. : Default layout

[ Cancel |4 Back | [/ Finish

. 4

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

o BB Y & A |h o @

Comp E‘robe Scan Data Process Landmark pC.al Calibration  Sizing Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.
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TUBE LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list
of tube.

This list can be created in the Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row_ Col 'l

001001.magdata I_'T‘G I__Q

Create Mew .
List Import List

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to your list.
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[l File List Creator - XN

File List Configuration

Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 .

Mumber of Celumns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 .

b

Include first and last column of each row

Files to Create: 1 i
Filename Preview: 001001
[+ Create & Mew ] |\f Create | [ o Cancel

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in the
Tubepro software (available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume
button.

2. Click on Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument on which you want to
connect and then click on Connect.

Home Setup Advanced Instrument Calibration

B R ¢ @

Setup  Disable Ch. Setup Info o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

L B
Instrument Connection (Ectane) ﬁ
——
Type Model MAC Address Host Status QConfig Details
Ectene2 | E128RNMI - EC:92:3300:00:14 ' ' :
Connect Cancel
[
r - -
Instrument Configuration 4 ﬁ
- -
Metworl Information Embedded Software Update
Mode: Rastomatic - @ Use the embedded software that comes with Magnifi
IP address:  |192.168.19 10 lUze custom embedded software

Subnet Mask:  |255.255.255.0

Gateway: DO0OO0O0

A

Two acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode. The
Setup Mode is used to scan your calibration tube and make the necessary adjustments on your
setup without saving the data automatically. The acquisition mode is used for the inspection.
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When in this mode, the software automatically saves the acquired data using file names based
on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

O
s

Setup gl
Mode
4. Plug the MFL probe on the Ectane 19-pin connector.
5. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.
6. Bring the probe head outside of the tube and start the acquisition by clicking on the

Acquire button under the Home tab or by pressing the F2 on your keyboard.
7. Pull the calibration tube at approximately Tm/s
8. When it's done, press the Stop button or again F2 on your keyboard
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Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These
buttons are used for the channel selection.

1. 2. 3. 4,
- DIF | F1

4 4 4 4

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated
Strip chart to this channel.

PREREEEE R R ER BN BRI
158.4 kHz 158.4 kHz 7

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

|| [ oF | F1,

158.4 F1ABS

FIDIF
F2ABS
F2DIF
FIABS
FIDIF
Land
M1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only

200|Page



STRIP CHARTS AXIS ORIENTATION

The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from
one axis to another, click on the box showing an arrow at the upper right corner of the Strip

|| | DIF | F1,| |I 400V Eﬂ

chart.

158.4 kHz

/OOMING

On the strip chart, hold the right button of your mouse and drag on the zone of interest to
zoom in this section.

PREDED T 200V =] PREDER 1 2000v [=] DPED LD ‘

158.4 kHz 158.4 kHz f .............. ; ...........................

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent. C-Scan

u |! DIF | le\ \1 2000V |-;|
158.4 kiz

S Previous Zoom
® Full Betent

% Adjust Cursor Size
G BestFit

<+ Horizontal

View indications

ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

201|Page



To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

) o | Ry IREN B IBPREEDE BRE

158.4 kHz F1DIF 158.4 kHz
r

s
£
£
£
&

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 2. 3. 4
Vep | ee | 25| 2P

i

=

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement

3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Hold and drag the left button of your
mouse to draw a vector in your Lissajous.
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LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your and dragging it around the rotation axis. Note that is operation cannot be
performed on the raw channels since these channels have no gain or rotated applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,
make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard.
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CALIBRATION AND SIZING CURVES

SLEW

The MFL probes include two bobbins that generate and absolute and differential channel. It
also includes a Trail bobbin. Since the Trail is not physically located at the same position as the
other coils, there is a time delay between the Differential/Absolute channels, and the trail
channel. To bring all the signals at the same position, the trail channel can be shifted in time
to match the other channels. This process is called Slew in Magnifi.

To Slew:

1. Click on the Slew button that can be found under the Calibration tab.

(Bl siew Calibration S |

Select current slew:
|Slew / SLEW - |

Capture Positions

Slew value: | -79 smpl

Close

L -

2. Place your cursor over a flaw in the strip chart of a Differential channel.

3. Click on the button at the left in the Slew Calibration window. This will set the
reference point at which the channels will move.

4. Place your cursor over the same flaw but on the strip chart of the Trail channel.

5. Click on the button at the right in the Slew Calibration window

6. Click on Apply.

Note that this process will move the channels by a constant number of samples. Therefore, a
probe pulling speed that was not constant won't have a data alignment that is valid throughout
the hole scan.
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CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the calibration window

3. Inthe Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

#| Calibration = ). P [t 200v 1]

@ Channel )

_) Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

s Calibrate
Reset

4. Select the signal name in the list

5. Click on the green arrow button to associate the measured signal to the calibration
point

6. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of
them

7. When all your calibration points are checked marked, click on the Calibrate button

SIZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button

2. Select Channel and Sizing Curves in the Calibration window

3. Go over the signal in your Strip chart and adjust the cursors to see only the desired
signal.
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Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is display on the
Lissajous to show the defect size. To have the correct interpolated point, the measurement
method also needs to be the same as the one used for the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.

Select the signal name in the list

Click on the green arrow

Redo the previous steps for all the other indications in the list
Click on the Calibrate button

N
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Sizing curves can also be adjusted manually. To do so, go the Calibration tab, and click on View
Curves. The sizing curve window will appear. Each sizing curves you asked magnify to create will
be listed in the drop-down menu. If an invalid notification is present on the curve, it means that
either you haven't entered the sizing points yet or that Magnifi failed to create the curve. To
adjust the sizing curve manually, enter the value in the table.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws
in the Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw
size does not appear, it means that you are not in a channel where a sizing curve was set.
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LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TS1 and TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).

Once the landmarks are calibrated properly the system should be able to recognize them
automatically.

Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your
inspection file. Note that when a data is saved, the setup is also saved with it.

r. Save Setup As ﬁw

F Setup
0 Sawve setup in current inspection Browse...
File name: Setup_PRBT-MFL-ADT-180_SN_1710217

MName

Setup_PRET-MFL-ADT-180_SN_1710217

I\/ QK |[XCancell

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.
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INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1.
2.

6.
7.
8.

Connect Magnifi to your instrument.

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the MFL probe on the Ectane 19-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press F6 on your keyboard.

Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

Pull the tube at approximately Tm/s (40"/s)

When it's done, press the Stop button or again F2 on your keyboard

Repeat step 4,5,6 and 7 for all the tubes to inspect in you bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two landmarks are needed to use this feature. These landmarks are created by default
when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1.

2.

Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

Click on Settings ...
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i ' i '
E Sequence Iﬁ ¥ Manual Sequence Configuration Iﬁ
Sequence
/\ Type: ) Nene @ Landmark
Start Recording Landmark:
Launch
Start Recording Delay: 10s -
l:(:)l Stop Acquisition Landmark: T51
Target R Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
. Delay: 100 -
NDD Review e —
. pUShmg oK | [ Cancel
@ Pulling/Recording L J
. Waiting for Mext
You must be
connected to an
0 instrument to start
the sequence,

>

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

6. You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).

o1

7. Two options are available to restart the acquisition: The user can either push a button
or use a timer. Select the desired option in the Restart section.
8. Click on OK.

To use the manual sequence:

1. Connect Magnifi to the instrument

2. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plug the ECT probe on the Ectane 4-pin connector.

4. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

5. Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab
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6. Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.

7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

8. Pull the probe until it goes out of the tube. This will trigger the last landmark detection
that will stop the data recording.

9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.

TUBE LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously
in the Tube list section of this document. To do so, checkmark the Automatic File Recording
option that can be found by clicking on the Acquisition preferences button in the Data window.
This option is selected by default.

1 tatal, 0 acquired
) [For) (¢ ]

fl Acquisition preferences:
—E:.:q,— Automatic File Heu.:ording
Please activate [ Auto Create new file on Mext

process. [T] Automatic Mext on Stop acquisition
Keep re-scan files
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The list of tube is also shown in the Data window.

Data R X
Row| Cal

» 001 001 )]

b 002 001

b 003 001

b 004 001

=+ o) 3¢
FNEDIRY

Tubes can be added or removed by using the first line of buttons of this window.

A common practice is to rescan your calibration tube and balance on it periodically. You can
save this new calibration tube data by adding a new tube in your tube list (999 001 for example).
Or you can go out of the acquisition mode, scan your tube, and click on the Save Cal As... button
under the Calibration tab to save your data. You can then go back to the acquisition mode to
continue your inspection and to save automatically the acquired tubes in your bundle.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in
the Home tab.

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename
option.
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LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab. Note that double-clicking on a tube when you are still connected to an
instrument will start the data recording.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired

or| (% [
A [0 ] [ 0] sort order:

4 File name »

DQV
Please activate DQV an [~ Reverse order

process.
Sort by creation date

V| Show re-scans
| Show messages
[¥| Show screenshots
(¥ Next skip re-scan
("] Show only tagged files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an
entry in the report. These two buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.

1,] | oF | F1, T4y L[] DIF | F1,| |t 2783° |1 148V

158.4 kHz 158.4 kHz !

CRK
, DNT

e DS
J ERO
J NDD

/ 0BS

, PIT
PLG
RST
WLL

&,
0.41% 1192 46.!
mp | ST 2F M COR

4 F Fa

YVmp

4

"

213|Page



Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
to 3 | B E e m-(n =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.
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i ™
. Generate Report u r. Generate Report u1

1% Section Selection
“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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Analysis Report @ eddyﬁ Analysis Report C\ eddyﬁ
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)
Measurement Convention Measurement Units
Preferences @ AsME @ Metric
O ASME Inverted === == O Imperial
360
") EDF

System Readback
|:| Do not display data during loading
Speed:
! Actual Inspection Speed
9 Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

General

O Reset to checked after loading a data file
Setup Wizard Path:  ChUsers\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo

Preview:

- ]
| (Y edd

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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NFA Probes
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INTRODUCTION

This procedure presents how to use an NFA probe with Magnifi 4.3R10 version and above on an
Ectane test instrument.

EQUIPMENT

The NFA probes use a 160-pin connector that can be connected on an Ectane with the “E64"
option.

The array section of the probe will provide a C-scan imaging and the conventional channel will
display a standard Strip chart / impedance plane signal for the absolute.

From the following table, the best probe for your application can be selected.

TUBE O TUBE'WT DIAMETER FREQ. PaLY

mmi in WG mm (] CODE mmi in COCE AAMGE CODE LENGTH PROEE PART NUMEER
12 277 000 124 12.4 0.4e3 FRET-NFA-BEAA-1 24MF Mz
13 24 0096 130 130 0512 FRET-NFA-BEAL-1 30MF Mz

ags om0 14 21 (0.083 138 138 0543 FRET-NFA-BEAL-1 38MF ez
15 188 007 142 142 0550 FRET-NFA-BEAS-1 42MF Mz
10 a0 0 170 170 OEED FRET-NFA-BBAA-1 TOMF Mz
1 06 0120 180 180 Q700 PRET-NFA-BBAA-1 B0MF Mz
12 277 000 184 184 07 FRET-NFA-BBAA-1 BANF Rz

24 1w 13 24 0,025 164 188 0740 PRET-MFA-BBAL-1 BENF hex
14 21 0,083 104 194 O7Ed FRET-HFA-BBAA-104MF Fex
15 183 Qo7 20 200 O7e7 W -k % gg: ﬁg FRET-HFA-BEAA-200MF-Mex
10 340 01 230 Z30 0006 FRET-HFA-BBAA-2 S0MF-hez
1 306 0120 228 76 092 FRET-HFA-BBAN-2 3EMF-hez

S8 12 12 27T 000 244 M4 00El FRET-HFA-BEAN-2 4 AMF-hez
13 24 0.005 260 S0 0on FRET-HFA-BEAA-2GOMF-Nz
10 340 013 200 #.0 1.142 FRET-HFA-BEAA-200MF-Nz
11 306 0120 208 6 1,188 FRET-HFA-BEAA-206MF-Nz

@10 1500 12 2T 000 anz M2 1180 FRET-HFA-BEAN-302MF-Nz
13 2 0.005 ae ma  1me FRET-HFA-BEAA-208MF-Nz

The NFA calibration tube used in this document includes the following flaws:

e Internal taper groove, 30% of wall loss on 4in length

e |D Round bottom hole 50% of wall loss, Diameter 0,138in

e |D Round bottom hole 50% of wall loss, Diameter 0,186in

e |D Round bottom hole 50% of wall loss, Diameter 0,375in

e |D Round bottom hole 50% of wall loss, Diameter 0,250in

e |D Round bottom hole 50% of wall loss, Diameter 0,312in

e Internal Groove 20 %

But, other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named SS316_075x0.065_ECT for instance. This inspection folder groups the setup, the tube
list, the data files and the Magnifi report.

PROJECT
(ex: Shell 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

# :

SETUP
LIST

______________________________
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When you open Magnifi 4, the first page displayed is called the Backstage.

General

Projec Folder

Inspection Folder

Acquisition

Filename

Report

Name

Tabie Profile:

Project / Inspection

rs\nmarissette Documents Magni Projects\How to

o )

Openvada
Project
est pre itiec)
CAuses ette\Documents\Magnifi Projects\How to
Create setup

Free Format
NewFile magasts
Report.mab

Saved with setup

(V7] Take screenshot with report entry

Magndi® $3R10 - [..\nmorissette\Desktopitest probot.magsetup]

i

#ddiOpen
inspection
+
0o =
Opensetup | | OpenData
=
mport ist
© -
Generate
okt | |ExportReport

Information

Probe Unable to detect

pree

Tube

0D 1905 mm

WL otemm

tength: 2250 mm

Materat

Frea

To create or open a project, click on Open/Add Project in the backstage. You can select an

existing project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your Project file.
Select New, Folder and enter the chosen name. You can then select the newly created

folder and click on Select Folder.

Bl select a project

GO

» Computer » 0S(C) » Users » daube.QTEC » Magnifi »

~ [ 43| [ Search Magnifi

Organize ~  Newfolder

» Favorites

& Downloads
@ OneDrive

£l Recent Places
Bl Desktop

4 Libraries
5 Documents
= Magnifi Data

% Magnifi Setup
o Music
&= Pictures
il Projects

B videos

1% Computer
&, 0s(c)
9 ArchivesZetec (\\srvarchives) (K:)
9 QAData (\\srvdata) (L)
% Mechanical (\\srvdata) (M:)
9 SoftwareProducts (\\srvdata) (N:)
S Client (Wsrvdata) (07)
3 PublicShare (\\srvdats) (P:)
8 Nualitw M srudatal (00

Folder: Magnifi

E
it

Projects

m

Folder
[®] Shortcut
[ Microsoft Access Database
& Bitmap image
Contact
5 Microsoft Word Document
View v |[] Microsoft Access Database
Sort by v @] Microsoft Project Document
Group by ¥ Microsoft PowerPoint Presentation
Refresh % Microsoft Publisher Document
— SonicWALL Global VPN Client Document
Paste shortcut B Rich Text Format
Undo Delete irkez) | |I= | (Text Bacument
i Dessin Microsoft Visio
il " /@5 Microsoft Excel Worksheet
New b | E Briefease

Properties

St ol
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name
of your inspection.

Bl Manage *
l Inspections
0 Manage Inspections Select Other...
9 P
MName State
Default

54179 _Tinx0.120_MFEA |-E

v e ] [X oo |

3. Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the New Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In
the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Analysis

System (Computer Related)

Measurement Convention Measurement Units
@ ASME @ Metric

O ASME Inverted s o O Imperial
O EDF o

Readback
[ Do not display data during loading
Speed:
O Actual Inspection Speed
© Maximum
"Keep Current Setup” Button Behavior:
*) Retain check state

© Reset to checked after loading a data file
Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup
Automatic Features

[C] Allow to save setup in original lacation

Ask to save setup when the first data file is recorded

Loga
Preview:
o
‘. *
Select
Company Loga

Shortcuts

Keyboard.. |
Remote... |

<

Preferences

System

Display

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter |

Channels
Full Channel Scale: 2000Vpp

Hide Raw Channel

Precision
"] Enable
amplitude: | 2 decim... =
Phase: 0 decim... »
Acquisition

[¥] Automatic File Recording

Auto Create new file on Mext
Automatic Mext on Stop acquisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Wizard option menu. Click on Create
Setup to start the Wizard.
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COMPONENT DEFINITION

The first page shown by the Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of
Available Material window.

% New Setup Wizard u H ‘, ; J 4 ’-

/ Component Definition .
(2) P |

{J-_..’f’\_/’ Configure the geometry and material of the component to inspect

Geometry: @ Tube from ID () Surface
Material: [Inconel 600 A [ Manage... ]
o Aluminum -
HEEERLE Aluminum (5061-T-6) — || Note about selected material
- Aluminum brass - ET OMNLY Composition: ~16% Cr, ~8% Fe, i remainin
Permezbility: | Ajyminum bronze UNS:F:\IUEGUU ' I
Velocity: Brass (70/30) - ||| ASTM: B163 alloy 600
HENICILY: Brass (85/15) - ET ONLY 3
Brass (95/5) - ET OMLY 12
] Carbon steel |
Wall thickness: Carbon steel low-alloy Cr-Mo | , , , , : , ,
Cast iron (gray)
Copper

Outside diameter: | Copper nickel 70-30

Copper nickel 90-10

Length: Copper nickel 95-05 - ET ONLY

Ductile iron - ET OMLY

Hastelloy C

Incoloy 800 - ET OMNLY -

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound
velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.

You can add a note about the material to specify things like its application or composition.
When you are done, click OK.
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[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{:;;: ?r: /) [H;f;i::;t)’ Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove All
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will be

available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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3" New Setup Wizard *

n Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: () Surface (® TubefromID
Application: (®) Generic () Air Conditioner
Material: | Carbon steel ~ | Manage...
Resistivity: 21 pll-cm
Permeability: 450 p
Velocity: 5890.000 m/'s
Wolthicknes:
n
'\'_l)' " BWG
] 24
Outside diameter: 540mm T
Length: 000 mm -

Mote about selected material:

[ASTME A178, A179, A192, AZ10, AZ14

|x Cancel | | 4 Back | |' Mext
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PROBE SELECTION

In the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique: drop-
down menu. More precise filtering can be done by using the Mode/ drop-down menu. You can
then select your probe by its catalog number (PRBT-NFA-BBAA) and then click Next.

5 Mew Setup Wizard *
/ ’ Probe Selection -
. Select the probe that you want to use for your inspection
Technique: | MFT v | Model: MNFA v
Probes
Tech. Model Catalog Mumber Y | Description -
MFT MEA PRET-MFA-BBAA-130MF MNF& probe, ABS with array receivers (2x9), diameter 13.0 mm, MF frequency range.
MNFT MFA PRET-MNFA-BEAA-138MF MNFA probe, ABS with array receivers (2x9), diameter 13.8 mm, MF frequency range.
MNFT MFA PRET-MFA-BEAA-142MF NFA probe, ABS with array receivers (2x10), diameter 14.2 mm, MF frequency range.
MFT MEA PRET-MF&-BBAA-T162MF MNF& probe, ABS with array receivers (2412), diameter 16.2 mm, MF frequency range.
PRET-MFA-BBAA-TTOMF MNF& probe, ABS with array receivers (2x13), diameter 17.0 mm, MF frequency range,
--——
PRET-MFA-BEAA-184MF NFA probe, ABS with array receivers (2x14), diameter 18.4 mm, MF frequency range.
MNFT MFA PRET-MFA-BEAA-18BMF NFA probe, ABS with array receivers (2x14), diameter 18.8 mm, MF frequency range.
MFT MEA PRET-MFA-BBAA-T134MF MNF& probe, ABS with array receivers (2x15), diameter 19.4 mm, MF frequency range.
MFT MEA PRET-MFA-BBAA-200MF MNF& probe, ABS with array receivers (2415), diameter 20,0 mm, MF frequency range. \
|gl New... | |‘; Manage... |
|3 Concel | |4 Back |[p Net |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

% New Setup Wizard X % New Setup Wizard =)

Sean Definition ] Scan Definition
Configure the type of scan you will be performing with your probe Encoder and axis settings

Single Pass Circular Axis Al Axis

¥ Auis Offset: 0.000° & Offset: 0,000 mm
Probe Resolution:  12.850 “/smpl

Clock Displayed Resolution: | 0.200 mm/smpl

Displayed Resolution: |6.425 */smp! :

1500 He B Size: 60000 mm
Size: 3600° B

Typicel probe speed: [1000.0 mm/s

Oversampling; 2x -

[ cancel | [ Back | [ Nei ] (%€ Cancel | [ Bsck | [p Nea

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 300mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 600mm. Using an encoder will give you the exact position of the probe.
Note that the position can also be obtained by using the landmark, but this feature will be
shown later.

The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 1500 Hz for NFA.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For instance, with an acquisition rate of 2000 Hz, the pulling speed needs to be less that Tm/s
to have at least 2 points per millimeter. If you do not use a pusher-puller, the pulling speed
won't be constant. Therefore, it is recommended to target a lower pulling speed to be able to
reach your axial resolution target. Also, the typical probe speed should be set as close as possible
from the real value. This will help the algorithm that automatically detect landmarks (explained
later). The recommended pulling speed for NFA is around 300mm/s.

The Probe Resolution (Circular Axis) is define by 360° divided by the number of pancake coils
located on the circumference of the NFA probe. For this instance, the 18mm NFA have 28 coils
so the resolution is 12.85°. The Displayed Resolution (Circular Axis) is the number of points
displayed in the C-scan and it is defined by the Probe Resolution divided by the Oversampling
(interpolation).

The Displayed Resolution (Axial Axis) is defined by typical probe speed divided by the Acquisition
rate.
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The size is the length of the tube to be inspected. The length needs to be set accurately for the
Landmarks work in Magnifi.

If you selected the position from Encoder, different fields will appear, and a second Scan
Definition page will become available.

. New Setup Wizard = % New Setup Wizard =
Scan Definition | Scan Definition
Configure the type of scan you will be performing with your probe Encoder and axis settings
Scan: Single Pass Circular Axis Axdal Axis
Main Scan Axis: Y s Offset: 0000~ : Offset: 0000 mm
Pasition from: Crnienli: BN e Displayed Resolution: | 0.500 mm/smpl
Displayed Resolution: | 6,425 */smpl
Detect Overspeed Size: 60000 mm
Size: 3600°
Typical probe speed: 3000 mm/s. B 12 =
Maximum probe speed: 4500 mm/s Oversampling: 2x -
Density: 2000 smpl/mm
Asial Encoder
Type: [Quadrature -
Resolution: 25,460 % count/mm
[Tl nvert direction
Preset 0000 mm :
Apply preset on Start
(% concel | (4 Back | [B_ Net (% cancel ][4 Back | [ Net

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.

Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at 0 mm.

The Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute and Array channels. It is important to set these parameters correctly before

acquiring the data since they are driven by the instrument and cannot be modified during the
analysis. But NFA the set frequency will not change.

7+ New Setup Wizard X 7+ New Setup Wizard X

ML Data Definition I 7 B I

g Select the C- you wil i y frequencies * Select the you wil i y frequencies
Connector. ® 160 pins [gam: 43dB
Gain: 38 B

Channels Required frequencies
C-scans Required frequencies MName Prefix Val (kHz) Ampl (V) Phase (7)
Name Prefix Val (kHz) Ampl (V) Phase (%) ABS F1 80 10.00 00
RAW Foo80 10.00 00
CIRC
PIT
Add e Add
[3¢ concel | [d Back | [B Nex | [3¢ concel | [d Back | [B Nex |

By default, Magnifi suggest one frequency set by default to 8kHz.

But frequency and drive voltage can be changed by replacing the value of your choice. Up to 4
frequencies can be set at the same time. And the sum of their amplitude cannot exceed 10V.

Also, the Absolute channel(s) cannot use a different frequency then the Array channel(s). They
are link together.

Click on Next when the desired parameters are entered.
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DATA PROCESSING

The Data Processing window used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to
every channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while a wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters
parameters after the acquisition, so it is always possible to fine tune the filters parameters
during the analysis.

3" New Setup Wizard *

5  DataProcessing ]

! Select the processings that you want to apply to the C-scans you have selected

[] Individually configure all the C-scans

Low Pass Median High Pass
MName : Cutoff (Hz) Window Size (smpl)
CIRC 1 200 201
PIT 1 200 201
RAW 1 200 1 11

|® Cancel | |4 Back | [P Net
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3" New Setup Wizard *

P\ Data Processing ]

! Select the processings that you want to apply to the channels you have selected

[[] Individually configure all the channels

Low Pass Median High Pass
MName Cutoff (Hz) Window Size (smpl)
ABS O 167 [ 225

|x Cancel | |" Back | |> MNext |

The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won't remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the
width of high-pass median filter should be set to at least three times the longest flaw that may
be encountered. Data should be examined in its filtered and unfiltered states. It is important to
keep in mind that the high-pass median filters can distort phase. More information about
median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to

have functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

-

=+ New Setup Wizard

=

9 Detect Landmark
9 Configure landmarks detection

r

Detection Channel: R_ABSF1

-

Pasition From:

[T Negative Pasitioning: From | 0.0 mm

@ Start Record

() Stop Record

Detection Engine: [Legaq,r

Landrark Table (in the order seen by the probe during data acquisition)

(Exit is used for
sequence only)

Exit
TS2

l o 151
]
- Stop

Record |4

I Start

: Record

v Length

position from

0

b

MName Type Pos. (mm) Min Qty Max Qty Shape Component Thresheld (V) P2P (mm) Enable
Exit Exit 25 } = 1000000 Disabled (3¢
152 152 0 } = 1000000 Enabled (3¢
Ts1 Ts1 6000 b = 1000000 Enabled (3¢
Positioned Landmark
|3 Cancel | [4 Back |[Pp Nex |

"

Two landmarks are created by default for NFA. The default channel used to detect these
landmarks is the absolute channel. The R_ before the channel stands for raw. This is the signal
of the channel without software filter, rotation or software gain applied.

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance) or on the place you stop to record (usually the operator side).
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(Exit i d ff Exit
Detection Channel: R_ABS-FL -] (Exitis “36": 'ﬁr .
TS1 sequence only) mSZ
Position From: @) Start Record _) Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record i: : Record
position from
Detection Engine: Extended Len gth 0
(Exit i d fi Exit
Detection Channel: R_ABS-F1 - (=xitis “Se'{fr .
TS1 sequence only) TS2
Position From: _) Start Record @) Stop Record I I—
[T] Megative Positioning: From |0.0 mm - StOp Start
Record I ;I Record
position from
Detection Engine: Extended O Length

In the above example, the Exit landmark was created. It is detected when the probe exits the
tube at its outer end. It can be used to trigger the start of the acquisition (explained later). It
has a negative position because this event happens before the tube inspection starts. It is
enabled only when doing the acquisition. As it can trigger the acquisition start, it is not included
in the resulting data file and is not available at the subsequent analysis step.

TS2 is the first tubesheet encountered when the probe is pulled. TS1 is the last tubesheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t’s important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above
example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.

234|Page



Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of Landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known. The Legacy mode is recommended for NFA.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s).

Calibration points can also be imported with the Import button.

5 New Setup Wizard *
Calibration Points _

@ Configure calibration points used for channels and sizing curves

Units of measurement: | Percentages (%) s

Calibration points
MName Side Size
GR-20 D 200 ]
DO NOT USE Unknown 0.0 |z|
151 Unknown 00 ]
T52 Unknown 0.0 |z|
REH-25_9.5mm D 250 |z|
REH-75_8.5mm D 750 ]
REH-50_2.5mm D 500 %]
REH-25_3.5mm D 250 %]
REH-75_3.5mm D 750 %]
GR-40 D 400 %]
TAPER-20 D 300 ¥
TAPER-60 D 600 ]
REH-50_8.5mm D 500 ¥
REH-25_4.7mm D 250 |z|
REH-25_6.3mm D 250 %
REH-25_7.9mm D 250 %]
REH-50.4.7mm D 500 ]
REH-50_6.3mm D 500 %]
REH-50_7.8mm D 500 ]
REH-75_4.7mm D 750 ¥
REH-75_6.3mm D 750 ]
REH-75_7.9mm D 750 ¥
Exit Unknown 0.0 |z|

[ concel |[d Back | [P mex |

Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).
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CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the
amplitude(s) and phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the 9.5mm 50% round bottom hole for the array
channels. The angle will be 90° for CIRC channel and 42° for PIT and RAW. For all array channels
the voltage will be set to 2V. For the conventional channel the GR-20 is set at 2V, 90°. However,
the calibration can be done differently on each channel type. It can also be done individually
for each frequency by selecting the Individually configure all the channels option. Different
reference signals can be set to calibrate the phase and the amplitude independently.

5% New Setup Wizard ot

O calibration ]

= Configure parameters to calibrate C-scan amplitude and phase

[] Individually configure all the C-scans

Armplitude Phase
MName Violtage (V) Reference Measurement Angle (%) Reference Measurement 5G
CIRC 2.00 RBH-30_%.5mm Pp 90.0 RBH-50_9.5mm PPF
PIT 2.00 RBH-30_%.5mm PP 42.0 RBH-50_9.5mm PPF
RAW 2.00 RBH-30_%.5mm Pp 420 RBH-50_9.5mm PPF

5G: Single Gain and Phase

|x Cancel | |‘ Back | [P Net
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5 New Setup Wizard
6 Calibration

A Configure parameters to calibrate channel amplitude and phase

[ Individually configure all the channels

Amplitude
Mame Voltage (V) Reference Measurement
ABS 2.00 GR-20 PPF

Phase
Angle (%)
90.0

Measurement

PPF

Reference

GR-20

|x Cancel | |< Back | i

Next |

When you'll select the reference signal, the system will use the selected measurement method

to apply a rotation and a gain. Here is a short descri

Absolute (A):

Uses a straight line from the Lissajous
origin to the main cursor position to
measure amplitude.

Absolute Horizontal (AH):

Uses only the horizontal component,
from the Lissajous origin to the main
cursor position to measure amplitude.

Absolute Vertical (AV):

Uses only the vertical component,
from the Lissajous origin to the main
cursor position to measure amplitude.
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ption of the available options:

4. Absolute Peak (AP):
Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.



7. Average Peak (MP): 10. Peak to peak (PP):

Takes the distances from points at the Uses the combination of the vertical
extremity of the cursor to the peak of and horizontal component to
the data selection to build an average measure the maximum amplitude.

vector. Used only, and recommended,

_ 11. Horizontal (PPH):
for absolute signals.

Uses only the horizontal component
8. Average Peak Horizontal (MPH): to measure the amplitude.

Uses the horizontal component of the 12

distances form points at the extremity

of the cursor to the peak of the data

selection to make an average vector.

Used for absolute signals. 13. Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

9. Average Peak Vertical (MPV):
Uses the vertical component of the

distances form points at the extremity maximum amplitude. The firsts signal
of the cursor to the peak of the data transition is from the base of an
selection to make an average vector. indication to its peak.

Used for absolute signals.

Click on Next went the parameters in the table are set according to your requirements.
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SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each
line in this table.

=% Mew Setup Wizard d

/\ Sizing Curves ]
D
.
G

Add and configure the sizing curves necessary for your inspection

Mame Measure From Source Measurement

TAPER Channel F1ABS Amplitude @

GROOVE Channel F1ABS Amplitude @
20 PIT 3.50mm C-scan'y PIT Amplitude E
28 PIT 4.73mm C-scan'¥ PIT Amplitude @
33 PIT 8.35mm C-scan'y PIT Amplitude E
43 PIT 7.93mm C-scan'¥ PIT Amplitude @
55 PIT 9.52mm C-scan'y PIT Amplitude E

|x Cancel | |‘ Back | |.~ Mext |

The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals amplitude obtained with your calibration standard. Magnifi will give you the interpolated
flaw size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve
properties. The name of the curve will be shown in the upper left corner of the page (TAPER in
the example below).
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5 New Setup Wizard

Sizing Curves

Configure the properties of the TAPER sizing curve

Measurement method: PP e
ez BFL MName Side Size
1 Report as remaining wall TAPER-30 b 300 T
[ ] Force to zero TAPER-60 D 50.0 £
[] GR-20 1D 200
[ ] RBH-254.7mm D 25.0
[] RBH-25_3.5mm ID 25.0
[ ] RBH-25_79mm ID 25.0
[] RBH-25.9.5mm ID 250
[ ] RBH-25_6.3mm ID 25.0
[] GR-40 1D 40.0
[ ] RBH-50_4.7mm D 50.0
[] REBH-50_9.5mm D 50.0
[ ] RBH-50_3.5mm ID 50.0
[] REBH-50_7.9mm ID 50.0
[l RRH-50 f.3mm D S0.0
| 20 Cancel | |4 Back | | b Net |

The measurement methods options are the same as the one described in the calibration page

section of this document. By default, the option peak to peak is set for all channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short

description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):

A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relationship with phase.

2. Best Fit (Dual Slope) (for phase measurement only):

A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):

Simple, point-to-point curve.
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5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve. Need at least three points.

The linear options are mostly used when little data points are available, while the options Best
fit (Dual Polynomial) is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select
the curve points for each sizing curves previously created. The order in which the points appear
in the list may influence your sizing cure. Make sure that the measured values of the calibration
points are in ascending order in the list. You can set Magnifi to show the remaining wall instead
of the defect size by checking the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when
analyzing the data.

a

- New Setup Wizard d

= _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect x|
D3l Distorted support indicatic  Defect @
ERO Erosion Defect x|
MDD Mo defect detected Mo indication @
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow @
WLL Wall loss long Defect x|
WLS Wall loss short Defect X]
WLT Wall loss taper Defect E

| L Import | | <= Add |

(% Cancel | |4 Back |[P Nex |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

= New Setup Wizard X
H i - ]

Configure display and layout properties

General options Lissajou / Strip chart options

Zoom behavior on stop acquisition: [ Miniature strip chart

() Zoom to full scale
Proportion: 33.00 %
() Zoom to content _ o
Display Direction: Top to Bottom b
(®) Keep current scale
Strip chart duration: Currently linked with the C-5can size

C-scan options

Scan axis scale displayed during acquisition: QOrientation:

(@) Entire C-scan

Sca
() Specific scale: | 0.0 mm T { |

Index

|x Cancel | |‘ Back | P Nedt |

The scroll direction is the direction in which data appears on the screen. If you choose downward,
the signals will go from the top to the bottom of the screen. If you choose the upward direction,
the signal will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.

The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one the another via the
layout tab The " C " stands for code, " S " stands for Strip chart,” L " for Lissajous, " CS " for C-scan
and " CS-3D " for 3D C-scan.

Layout with the blue background will be the one opened by default.

Layout can be readjusted at any time.
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%" Mew Setup Wizard *

T ]
. Select the layout that you want to use to display your inspection results
1 Strip chart, 1 C-scan, 2 Lissajous, 13D 1 Strip chart, 2 C-scans, 3 Lissajous
L L L
s [ Tlds|cs|cs
C5-3D L]L
1 Strip chart, 2 C-scans, 4 Lissajous 1 Strip chart, 3 C-scans, 4 Lissajous
L]L L]t
[ ]ds|cs|cs [ ] Hslesleslcst
L]L L]t
. : Default layout
) Help |x Cancel | |‘ Back | |\/ Finish

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

o BB Y & A |h o @

Comp E‘ml:le Scan Data Process Landmark pC.al Calibration  Sizing Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.
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TUBE LIST

Magnifi will create a file for each inspected tube. The list of tube can be created in the
Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row_ Col V]

001001.magdata ‘-0 --Q
CreafiestNEW Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to you list.
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[l File List Creator - XN

File List Configuration

Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 .

Mumber of Celumns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 .

b

Include first and last column of each row

Files to Create: 1 i
Filename Preview: 001001
[+ Create & Mew ] |\f Create | [ o Cancel

e

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the file name window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in Tubepro.
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume

button.
2. Click on Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument on which you want to

connect and then click on Connect.

Home Setup Advanced Instrument Calibration

B R ¢ @

Setup  Disable Ch. Setup Info o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

F N
Instrument Connection (Ectane) ﬁ
——
Type Model MAC Address Host Status QConfig Details
Ectene2 | E128RNMI - EC:92:3300:00:14 ' ' :
Connect Cancel
[
r e —_——
Instrument Configuration 4 ﬁ
- -
Metworl Information Embedded Software Update

Mode: A tomatic - @ Use the embedded software that comes with Magnifi

P address: |192.168.19 .10 lUze custom embedded software

Subnet Mask:  |255.255.255.0

Gateway: DO0OO0O0

A

Two acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode. The
Setup Mode is used to scan your calibration tube and make the necessary adjustments on your
setup without saving the data automatically. The acquisition mode is used for the inspection.

248 |Page



When in this mode, the software automatically saves the acquired data using file names based
on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

O
s

Setup Mull
FMode

4. Plug the NFA probe on the Ectane 160-pin connector.

5. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

6. Bring the probe head outside of the tube and start the acquisition by clicking on the
Acquire button under the Home tab or by pressing the F2 on your keyboard.

7. Pull the calibration tube at approximately 12"/s (300 mm/s)

8. When it's done, press the Stop button or again F2 on your keyboard

BGCSOE L & ~ Magnifi® 43810 -2 x
O‘ H Setuy e Instrument  Cadbratign nalyas sted Anabyi layout  Cusrent View ‘ ‘ 2 \:lu‘
A [(OBS
s O 00 =0 t B £ I o RE TN 9 Q
Setup. Mull  Previeus Acq Saw Mext R LosdFde SN Save As. K9 preferences Full  BetFt Center | MoDefect Capture AddNote Palette
Made Dt Sen o Etent R
oara " % =171 EERE PP ER R o o [l [=17] T [ JGEL L ied o [,
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous
windows. These buttons are used for the channel selection.

1. 2. 3. 4
- DIF | F1,

A 4 A

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated
Strip chart to this channel.

PR ERE RN R DR EDE N AT
158.4 kHz 158.4 kHz /

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

| | | oF | F1,

158.4 F1ABS

F1DIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only
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STRIP CHARTS AXIS ORIENTATION

The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from
chart.

one axis to another, click on the box showing an arrow at the upper right corner of the Strip

A .1 CIF -,
158.4 kHz

1 400V |
/OOMING

F1,

u Joor ]

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of
interest to zoom in this section. This operation can be done in both axis for the C-scan.
158.4 kHz

[t 200v [ I_,| | IERER

158.4 kHz

\I 2000V |-p|

J o JE
1564

{ | ——==
?

u NIE G

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent. C-Scan

\1 2000V |-.|

4 Previous Zoom
®, Full Bxtent
% Adjust Cursor Si

G Bestfit

—+  Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

BREREY II 333V |E| BREREY EEE EETI

80.0 kHz

2.98v 12 10.0% ID4

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.
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MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 23 4
Vep| | | P

"

=

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement

3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Hold and drag the left button of your
mouse to draw a vector in your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your and dragging it around the rotation axis. Note that is operation cannot be
performed on the raw channels since these channels have no gain or rotated applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,
make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard. Calibration and sizing curves
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CALIBRATION AND SIZING CURVES

SLEW

The NFA probes includes bobbins that generate an absolute channel. It also includes a set of
pancake coils that generates C-scan(s). Since the bobbins and the pancake coils are not
physically located at the same position on the probe, there is a time delay between the channels
(coils) and the C-scan (pancakes coils). To bring all the signals at the same position, the bobbin
channels can be shifted in time to match the C-scan. This process is called Slew in Magnifi.

To Slew:

1. Click on the Slew button that can be found under the Calibration tab.

(Bl stew Calibration oS |

Select current slew:
[SIEW { Slew Wizard Group v]
Capture Positions

Slew value: | -112 smpl

Close

LS -

2. Place your cursor over a flaw in you C-scan.

3. Click on the button at the left in the Slew Calibration window. This will set the
reference point at which the channels will move.

4. Place your cursor over the same flaw but on the absolute channel.

5. Click on the button at the right in the Slew Calibration window

6. Click on Apply.

Note that this process will move the channel(s) by a constant number of samples. Therefore, a
probe pulling speed that was not constant won't have a data alignment that is valid throughout
the hole scan.
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CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the calibration window

3. Inthe Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

7% Calibration

) Channel

() Channel and Sizing Curves

(@) C-scan

() C-scan and Sizing Curves

() Landmark

RBH-30_9.5mm

| Calibrate

| Reset

4. Select the signal name in the list

5. Click on the green arrow button to associate the measured signal to the calibration
point

6. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of
them

7. When all your calibration points are checked marked, click on the Calibrate button
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SIZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button

2. Select Channel and Sizing Curves in the calibration window

3. Go over the signal in your Strip chart and adjust the cursors to see only the desired

signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is display on the
Lissajous to show the defect size. To have the correct interpolated point, the measurement
method also needs to be the same as the one used for the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.

Select the signal name in the list

Click on the green arrow

Redo the previous steps for all the other indications in the list
Click on the Calibrate button
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LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TS1 and TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).
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Once the landmarks are calibrated properly the system should be able to recognize them

automatically.

Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your

inspection file.

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.
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INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1.
2.

6.
7.
8.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFA probe on the Ectane 160-pin connector. The orange dot on the connector
must be align with with the orange dot on the Ectane.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

Pull the tube to inspect at approximately 12"/s (300 mm/s)

When it’s done, press the Stop button or again F2 on your keyboard

Repeat step 4,5 and 6 for all the tubes to inspect in you bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two landmarks are needed to use this feature. These landmarks are created by default
when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1.

2.

Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

Click on Settings ...
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o

8.

( E Sequence @1 rQ Manual Sequence Configuration @1

Sequence

/\ Type: ) Mene @ Landmark
Start Recording Landmark:
Launch .

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

' Pushing
' Pulling/Recording
' Waiting for Mext

0K | [ Cancel

You must be
connected to an

0 instrument to start
the sequence,

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button

or use a timer. Select the desired option in the Restart section.
Click on OK.

To use the manual sequence:

1.

2.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFA probe on the Ectane 160-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab

Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.
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7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

8. Pull the probe until it goes out of the tube. This will trigger the last landmark detection
that will stop the data recording.

9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.

TUBE LIST MANAGEMENT

For each acquisition taken, Magnifi can automatically save a file using the file name defined
previously in the Tube list section of this document. To do so, checkmark the Automatic File
Recording option that can be found by clicking on the Acquisition preferences button in the
Data window. This option is selected by default.

1 tatal, 0 acquired

EIEDES
f ‘ Acquisition preferences:
p— Automatic File Recording
Daw '
Please activate [] Auto Create new file on Next
Process. [] Automatic Next on Stop acquisition
Keep re-scan files

This list of tube is shown in the Data window at the left of the Frontstage.
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Data P
Row| Col
» 001 001 ED
» 002 001
» 003 001
» 004 001

4 total, 0 acquired

ENEDIE
) (2] (%)

Tubes can be added or removed by using the first line of buttons of this window.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting a tube in the list and by clicking on the Rescan button in the
Home tab.

Also, a tube name can be changed by right-clicking on a tube in the list and by selecting the
Rename option.
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LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired

B8] [0 ] [ ¥ 0] Sort order:

4 Filename »

DQV
Please activate DQV an [] Reverse order

process.
Sort by creation date

|¥] Show re-scans

Show messages

[¥] Show screenshots

(] Next skip re-scan

("] Show only tagged files

N
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REPORT

INDICATIONS

The two (2) Indication buttons at the lower corner of the Lissajous windows can be used to add
an entry in the report. These 2 buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.
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Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
to 3 | B E e m-(n =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.
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i ™
. Generate Report u r. Generate Report u1

1% Section Selection
“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric
O ASMEInverted = —--- - ) Imperial
Jo0
_| EDF

System Readback
|:| Do not display data during loading
Speed:
) Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

Q) Reset to checked after loading a data file

General

Setup Wizard Path:  Ch\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logao

Preview:

= (V' eddvyfi

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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NFT Bobbin Probes

—

268 |Page



INTRODUCTION

This document presents how to use an NFT probe with Magnifi 4.4R5 on an Ectane test
instrument.

EQUIPMENT

NFT probes use a 19-pin connector that can be connected on an Ectane with the “ERNM" option.
The absolute and differential signal from the probe will provide Strip charts and Lissajous.

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe
diameter is offered (see the tubing probe catalog for more details).

From the following table, the best standard probe for your application can be selected. Note
that Eddyfi can also offers custom product that are not shown in these tables.

Table 9 - NFT-BBAD probes diameter selection table

TUBE 0D TUBEWT DIAMETER FREQUENCY POLY PROBE PART NUMBER
mm in BWG mm in CODE mm in CODE RANGE CODE LENGTH

10 3.40 0.134 110 11 0.433 PRBT-NFT-BBAD-110MF-Nzz
1 3.05 0120

120 12 0.472 PRBT-NFT-BBAD-120MF-Nzz
12 277 0109
i3 il L 130 13 0.512 PRET-NFT-BBAD-130MF-Nzz

: 20 20m(B5fh -BBAD- .
19.05 0.750 14 2.1 0.083 MF 50-2000Hz 30 30m (81

15 1.83 0.072
16 1.65 0.065 140 14 0.551 PRBT-NFT-BBAD-140MF-Nzz
17 147 0.058
18 1.24 0.049 150 15 0.501 PRET-NFT-BBAAD-150MF-Nz
9 376 0148 160 16 0.630 PRBT-NFT-BBAD-160MF-Nzz
10 3.40 0134

170 17 0.669 PRBT-NFT-BBAD-170MF-Nzz
1 3.05 0120
12 277 0.109

180 18 0.709 PRBT-NFT-BBAD-180MF-Nzz
13 2.4 0.095

25.40 1.000

14 2.1 0.083

190 19 0.748 PRBT-NFT-BBAD-190MF-Nzz
15 1.83 0.072
16 1.65 0.065

200 20 0.787 PRET-NFT-BBAD-200MF -Nzz
17 147 0.058
18 1.24 0.049 210 el 0.827 PRET-NFT-BBAD-21 0MF-Nz
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419 0,165 210 4| 0.827 PRET-NFT-BBAD-210MF-Nzz

3.76 0.148
220 2 0.866 PRET-NFT-BBAD-220MF-NzZ

10 3.40 0134

11 3.05 0.120
230 23 0.906 PRET-NFT-BBAD-230MF-Nzz

12 277 0,108
31.75 1.250 13 24 0.095 240 24 0.945 PRET-NFT-BBAD-240MF-Nzz

14 21 0.083
15 183 0.072 250 25 0.984 PRET-NFT-BRAD-250MF-Nzz

16 1.65 0.065 20 20m (85 1Y
MF 50-2000Hz
17 147 0.058 30 30m(8fy

260 26 1.024 PRET-NFT-BBAD-260MF-Nzz

18 1.24 0.049
8 419 0.165 270 27 1.063 PRET-NFT-BBAD-27OMF-Nzz

9 3.76 0.148
280 28 1.102 PRET-NFT-BBAD-280MF-Nzz

10 3.40 0134
" 3.0 0120 290 29 1.142 PRET-NFT-BBAD-290MF-Nzz

3810 1.500

12 277 0.109
300 30 1.181 PRET-NFT-BBAD-300MF-Nzz

13 2.41 0.095

14 21 0.083
30 3 1.220 PRET-NFT-BBAD-310MF-Nzz

15 1.83 0072

The NFT calibration tube used in this document includes the following flaws:
e Internal groove, 30% of wall loss
e Internal round bottom holes (RBH), 6.35mm diameter, 75% of wall loss
e Through wall hole, 6.35mm diameter
e Internal round bottom holes (RBH), 6.35mm diameter, 50% of wall loss
e Internal round bottom holes (RBH), 6.35mm diameter, 25% of wall loss
e Internal groove, 60% of wall loss

But, other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include data specific to the inspection of a tube bundle with a specific technology and could be
named CS_075x0.065_NFT for instance. This inspection folder groups the setup, the tube list,
the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

___________  E— l .l..

INSPECTION 2 INSPECTION X

| |
| |
| |

|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <«—> DATA |
| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4, the first page displayed is called the Backstage.

Magnifi® 43R10

General

Project / Inspection Information

General

Project Folder: C\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default ro .5 Application:  Generic
Open/Add Add/Open Transfer
Project Inspection ] Tube Dimensions:
Acq. Summary
oD: 19.05 mm
Setup / Data
Setup Loaded: [unsaved) WT: 1.65 mm
z 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data .
Data Loaded: Material:  Stainless Steel 304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata l_'_ol T
Create New

Material Database List Import List
Report

Documentation Name: [Report.mdb =) ~ .
Table Profile: [ Tubing IRIS - © -

Generate Export Report

[] Take screenshot with report entry Report

Preferences

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an
existing project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project
file. Select New, Folder and enter the chosen name. You can then select the newly
created folder and click on Select Folder.

Bl select 2 project B
@‘\J'l » Computer » 0S(C:) » Users » daube.QTEC » Magnifi » ~ [ 3] [ Search Magnii o
Organize + New folder =2 - @

't Favorites

& Downloads i

& OneDrive i

il Recent Places E L

B Desktop

Projects Folder

4 Libraries @ Shortcut

3 Documents 5 Microsoft Access Database

= Magnifi Data = B | Bitmopimage

2 Magnifi Setup -

= icrosos ord Document
o Music =Ry ft Word D
&) Pictures View b [# Microsoft Access Database
Project
EE‘] (85 Sort by ¥ | Microsoft Project Document
Videos
Group by * @¥ Microsoft PowerPoint Presentation

B Comput Refresh @i Microsoft Publisher Document
/% Computer

& osic) e SonicWALL Global VPN Client Document
& ) P s

58 ArchivesZetec (\\srvarchives) (K:) Paste shortcut B Rich Text Format

5 QADsta (Wsrvdats) (L) Undo Delete Ciriez | ) TedDocument

S8 Mechanical (Wsrvdata) (M) Share with R (3] | D i

55 SoftwareProducts (Wsrvdata) (N:) (] | MR =

@ Client (\\srvdata) (O:) New » |1 Briefcase

9 PublicShare (\\srvdata) (P:) G

L Nualibe M eredatal (00 w2

Folder: Magnifi
Select Folder

2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name

of your inspection.
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i Al
. Manage u

l Inspections
Manage Inspections Select Other...

Mame State

Default Ready for Inspection |

Bundle_A_55316_0.75X0.065_ECT ]_E

|/ select | |3 Close |

3. Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Display

Analysis

System (Computer Related)

Measurement Units
© Metric

Measurement Convention
© ASME

O ASME Inverted
O EDF :

) Imperial

ot

Readback
[] Do not display data during loading
Speed:
7 Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

©) Reset to checked after loading a data file
Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup
Automatic Features

[] &llow to save setup in original location
Ask to save setup when the first data file is recorded

Loga
Preview:
-y o
Select
Company Logo

Shorteuts

Keyboard.. |
Remaote... |

<

Preferences

System

General

Display

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter |

Channels

Full Channel Scale: 2000Vpp

Hide Raw Channel

Precision

7] Enable

amplitude: | 2 decim... =

Phase: 0 decim... »

Acquisition
Automatic File Recording

Auto Create new file on Mext
Automatic Mext on Stop acguisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Setup Wizard process. Click on Create

Setup to start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of
Available Material window.

% New Setup Wizard u H ‘, ; J 4 ’-

/ Component Definition .
(2) P |

{J-_..’f’\_/’ Configure the geometry and material of the component to inspect

Geometry: @ Tube from ID () Surface
Material: [Inconel 600 A [ Manage... ]
o Aluminum -
HEEERLE Aluminum (5061-T-6) — || Note about selected material
- Aluminum brass - ET OMNLY Composition: ~16% Cr, ~8% Fe, i remainin
Permezbility: | Ajyminum bronze UNS:F:\IUEGUU ' I
Velocity: Brass (70/30) - ||| ASTM: B163 alloy 600
HENICILY: Brass (85/15) - ET ONLY 3
Brass (95/5) - ET OMLY 12
] Carbon steel |
Wall thickness: Carbon steel low-alloy Cr-Mo | , , , , : , ,
Cast iron (gray)
Copper

Outside diameter: | Copper nickel 70-30

Copper nickel 90-10

Length: Copper nickel 95-05 - ET ONLY

Ductile iron - ET OMLY

Hastelloy C

Incoloy 800 - ET OMNLY -

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound
velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.

You can add a note about the material to specify things like its application or composition.
When you are done, click OK.
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[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{:;;: ?r: /) [H;f;i::;t)’ Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove All
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will be

available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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%" New Setup Wizard *

0 Configure the geometry and material of the component to inspect

Component Definition

Geometry: () Surface (@) Tube from ID
Application: (®) Generic () Air Conditioner
Material: | Carbon steel i | | Mal_\age...|
Resistivity: 21 pf-cm
Permeability: 450 p
Velocity: 5890.000 m/s
Wall thickness: 1.65 mm =
16
B " BWG

]
Qutside diameter:

Length:

Mote about selected material:

[ASTM: A178, AT79, A192, A210, A214

|x Cancel ||

Back |[p Ned
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PROBE SELECTION
In the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down
menu. More precise filtering can be done by using the Model drop-down menu. You can then
select your probe by its catalog number (PRBT-NFT-BBAD) and then click Next.

’ )

‘,'- New Setup Wizard
’l’\_, Probe Selection h |
- Select the probe that you want to use for your inspection
-
Technique: [NFF v] Model: [E-obbin v]
Probes
Tech. Model Catalog Number Y | Description ~
[u MNew... ] [@ Manage.. ]
[ Cancel | [ Back |[Pp Net |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

4% New Setup Wizard @

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Auis

Position from:

Acquisition rate: 800 Hz -

Typical probe speed:  300.0 mm/s

Acquisition Size: 600.000 s - Maxirnum

v

[x Cancel ] [‘ Back ] | ’v MNext |

%, A

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 300mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 600mm. Using an encoder will give you the exact position of the probe.
Note that the position can also be obtained by using the landmarks, but this feature will be
shown later.

The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 800 Hz for NFT, but depending on drive frequency used to inspect, the
actual acquisition rate may differ. The system will automatically readjust this value if needed.
For standard NFT probes, the acquisition rate can always be set at 800 Hz.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For instance, with an acquisition rate of 2000 Hz, the pulling speed needs to be less that Tm/s
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to have at least two points per millimeter. If you do not use a pusher-puller, the pulling speed
won't be constant. Therefore, it is recommended to target a lower pulling speed to be able to
reach your axial resolution target. Also, the typical probe speed should be set as close as
possible from its real value. This will help the algorithm that automatically detect landmarks
(explained later). The recommended pulling speed for NFT is around 300mm/s.

If you selected the position from Encoder, different fields will appear and a second Scan
Definition page will become available.

5 New Setup Wizard == 3% New Setup Wizard ===

Scan Definition i Scan Definition

Configure the type of scan you will be performing with your probe Encoder and axis settings
Scan Single Pass e
Main Scan Axis: V¥ Aois = [Quasrature =
Lot Encodes hd Resolution: 25,460 % count/mm

Detect Overspeed [ Invert direction
Typical probe speedk 3000 mmys Preset: 0000 mm B
Maximum probe speed:  450.0 mm/s z Apply preset on Start
Density: 2000 smpl/mm
Acquisition Size: 100000 mm % Maximur m
[ Cancel ][4 Back |[B Nex | (€ cancel | [ B2k | [p_nee

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.

Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at O mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute and Differential channels. It is important to set these parameters correctly before
acquiring the data since they are driven by the instrument and cannot be modified during the
analysis.

+" New Setup Wizard @

ﬂ Data Definition e - |

Select the channels you will be using and the necessary frequencies

Connector: 19 pins

Channels Required frequencies
MName Prefix Gain (dB) Prefix  Val (Hz) Ampl (V)
Absolute ABS- 60.0 F1 300 5.00 @
Differential DIF- 50.0

[x Cancel ][‘ Back “P Mext |

L. r

By default, Magnifi suggest a frequency of 300Hz, but frequencies and drive voltages can be
changed by replacing their values in the Required frequencies table. Up to 4 frequencies can be
set at the same time. And the sum of their amplitude cannot exceed 10V.

Make sure that the chosen frequencies are within the probe limits that you can find in Table 1.
If one of the frequencies is not within the recommended probe frequency range, you can either
remove it by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly
used to detect indication close to support plates. They are built with 2 frequencies of a same
channel type to attenuate the effect of the support plate and to be able to size an indication
at this location more accurately. Mixes are not typically used with NFT since this technology
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allows the detection of inside diameter indications only. Therefore, the support plates are not
typically detectable.

i ™y
+" New Setup Wizard @
ﬂ Data Definition | - |

* Configure the channel mixes for your inspection
Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal
[ Cancel || Back |[Pp Nex |
b "

Click on Next.

DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to
every channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters
parameters after data acquisition, so it is always possible to fine tune the filters parameters
during analysis.
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" New Setup Wizard @

Data Processing |

<7

Select the processings that you want to apply to the channels you have selected

[T Individually configure all the channels

Low Pass Median High Pass
MName ) Cutoff (mm) Window Size (mm)
ABS- [ 60 ] 1500
DIF- [ s0 ] 1500

[x Cancel ] [‘ Back l | ’v Mext |

L ’,

The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won't remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off
variations of the probe within the tube, changes in material, geometry or thickness. As a rule-
of-thumb, the width of high-pass median filter should be set to at least three times the longest
flaw that may be encountered. Data should be examined in its filtered and unfiltered states. It
is important to keep in mind that the high-pass median filters can distort phase. More
information about median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to
have functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

r R
5 Mew Setup Wizard ﬂ
9 Detect Landmark e - |

9 Configure landmarks detection

Exit i Exit
Detection Channek R_ABS-F1 - (Exit iz e far

TS1 sequence only) TS2
L ]
Pasition From: @ Start Record () Stop Record w I I—
[T Negative Positioning: From | 0.0 mm - StOp Start
Record |4 : Record

position from

Detection Engine: [LEQEC&’ 'l Length 0

Landrark Table (in the order seen by the probe during data acquisition)

MName Type Pos. (mm) Min Qty Max Qty Shape Component Thresheld (V) P2P (mm) Enable

Exit Exit -25 p - 10000.00 Disabled @
T52 T52 0 p =) 10000.00 Enabled @
T51 TS1 6000 p - 10000.00 Enabled @

Paositioned Landmark

Import... H Export...

[ Cancel || Back |[Pp Nex |

L A

Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or on the place you stop to
record (usually the operator side).
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(Exit i d ff Exit
Detection Channel: R_ABS-FL -] (Exitis “36": 'ﬁr .
TS1 sequence only) mSZ
Position From: @) Start Record _) Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record i: : Record
position from
Detection Engine: Extended Len gth 0
(Exit i d fi Exit
Detection Channel: R_ABS-F1 - (=xitis “Se'{fr .
TS1 sequence only) TS2
Position From: _) Start Record @) Stop Record I I—
[T] Megative Positioning: From |0.0 mm - StOp Start
Record I ;I Record
position from
Detection Engine: Extended O Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering in the tube. It is enabled only when doing the
acquisition. As it can trigger the data recording, it is not included in the resulting data file and
is not available at the subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TS1 is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t’s important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.

The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above
example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.
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Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known. The Legacy mode is recommended for NFT.

Click Next when you are done.

CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s).

Calibration points can also be imported with the Import button.

" New Setup Wizard @
Calibration Paints I
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (36) -

Calibration points

Mame Side Size

HOLE Through 1000 (%
REH-75 D 750 (%
REH-50 D 50,0 (%
REH-25 D 250 (%
GR-30 D 300 (X
GR-60 D 60.0 X
SUPPORT Unknown 00 X

[x Cancel ] |‘ Back | [ ’ Next ]
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Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).

CALIBRATION

The Calibration page is used to define reference signal(s) that will be used to set the
amplitude(s) and phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by putting it at 1V and 90° on the
differential channel. The absolute channel is calibrated on the 60% groove by putting it at 6V,
Q0°. However, the calibration can be done differently on each channel type. It can also be done
individually for each frequency by selecting the Individually configure all the channels option.
Different reference signals can be set to calibrate the phase and the amplitude independently.

f ™y
+" New Setup Wizard @
6 Calibration e - |
A Configure parameters to calibrate channel amplitude and phase
[T Individually configure all the channels
Amplitude Phase
MName Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS- 6.00 GR-60 pp 90.0 GR-60 Pp
DIF- 1.00 HOLE pp 90.0 HOLE Pp
|9 Cancel || Back |[p Ned
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Absolute (A):

Uses a straight line from the Lissajous
origin to the main cursor position to
measure amplitude.

Absolute Horizontal (AH):

Uses only the horizontal component,
from the Lissajous origin to the main
cursor position to measure amplitude.

. Absolute Vertical (AV):

Uses only the vertical component,
from the Lissajous origin to the main
cursor position to measure amplitude.

. Absolute Peak (AP):

Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

. Absolute Peak Horizontal (APH):
Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

. Absolute Peak Vertical (APV):
Uses only the vertical component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

Average Peak (MP):

Takes the distances from points at the
extremity of the cursor to the peak of
the data selection to build an average
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10.

1.

12.

13.

When you'll select the reference signal, the system will use the selected measurement method
to apply a rotation and a gain. Here is a short description of the available options:

vector. Used only, and recommended,
for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Average Peak Vertical (MPV):

Uses the vertical component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Peak to peak (PP):

Uses the combination of the vertical
and horizontal component to
measure the maximum amplitude.

Horizontal (PPH):
Uses only the horizontal component
to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to
measure the amplitude.

Peak to peak First Transition (PPF):
Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure
maximum amplitude. The firsts signal
transition is from the base of an
indication to its peak.

Click on Next went the parameters in the table are set according to your requirements.



SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each
line in this table.

i ™
5+ New Setup Wizard ﬂ

Sizing Curves e * |

Add and configure the sizing curves necessary for your inspection

D MName Source Measurement
ABS ABS-F1 Amplitude (%
DIF DIF-F1 Amplitude (%

[ Cancel || Back |[Pp Nex |

L i

The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals (amplitude only for NFT) obtained with your calibration standard. Magnifi will give you
the interpolated flaw size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve
properties. The name of the curve will be shown in the upper left corner of the page (ABS in the
example below).
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" New Setup Wizard &

Sizing Curves | ,

Configure the properties of the ABS sizing curve

Measurement method: [ pp - | Select the curve’s points:
Shape: [ BFL ,| MName Side Size
[C] Report as remaining wall GR-30 D 300 T
Force to zero GR-60 D 60.0 4
[F] RBH-25 D 25.0
[C] REH-50 D 50.0
[F] REH-75 D 75.0
[C] HOLE Through 100.0
[] SUPPORT Unknown 0.0

[x Cancel |[‘ Back ||’ Mext |

L A

The measurement methods options are the same as the one described in the calibration page
section of this document. By default, the option peak to peak (PP) is set for the absolute and
the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short
description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relationship with phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.
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5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):

Polynomial (degree 2) interpolation with two segments for both ID and OD side of the

curve. Need at least three points.

The linear options are mostly used when little data points are available, while the options Best

fit (Dual Polynomial) is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select

the curve points for each sizing curves previously created. The order in which the points appear

in the list may influence your sizing cure. Make sure that the measured values of the calibration

points are in ascending order in the list. You can set Magnifi to show the remaining wall instead

of the defect size by checking the box Report as remaining wall thickness.

Click Next when you are done.

INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when

analyzing the data.

-

5" New Setup Wizard

===

— Indication Codes

- T e e e T Tl [ ey
Code Description Type
COR Corrosion Defect
CRK Crack Defect
DMNT Dent Defect
DsI Distorted support indicatic  Defect
ERO Erosion Defect
NDD Mo defect detected MNa indication
OBS Obstructed Feature
PIT Pitting Defect
PLG Plugged Feature
RST Restricted Feature
WLL Wall loss lang Defect
WLS Wall loss short Defect
WLT Wall loss taper Defect

Automatic Colar

[ Red

I.‘ Brown
I Yellow

(3¢ ¢ 3¢ (3¢ 3¢ <) (¢ ¢ 3] 3¢ ¢ ) o

| L Import | | == Add |

[x Cancel ][< Back ]l’ Mext |

o
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When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done

DISPLAY
The first Display window is used to set how the data is displayed during and after the acquisition.
(5% New Setup Wizard S5
Display I |
I_!TE] Configure display and layout properties
General options Lissajou / Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

Zoom to full scale

[ 3

Proportion: 33.00 % -
() Zoom to content
Display Direction: Bottorn to Top A
@ Keep current scale
Strip chart duration: 6000 mm -

|3 Cancel || Back |[p Nex

b, &

The Display Direction is the direction in which data appears on the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.
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The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one to the another via the

layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code
indication zone.

r ™
=+ New Setup Wizard u
Display = s
Select the layout that you want to use to display your inspection results

2 Strip charts, 1 Lissajous 2 Strip charts, 2 Lissajous

L

Yl s|s| [ llds]s

4 Strip charts, 2 Lissajous

L

[:]CSSSS

. : Default layout

(3 Cancel |[4 Back | [/ Finish

L.

Layout with the blue background will be the one opened by default.

Layouts can be readjusted at any time.

Click Next to complete the setup wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
* * AW L ] o] —
Sl G @B Y 8 A NS EHE

MNew Locks Comp Probe Scan Data Process  Landmark pC_aI Calibration  Sizing  Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.

TUBE LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list
of tube.

This list can be created in the Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Row, Col ']

001001.magdata E‘o I__Q

Create Mew :
List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.
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Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to your list.

r .
I File List Creator - = 8 |
File List Configuration
Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 -
Row Interval: 1 -
Mumber of Celumns per Row:
Row Mb. of Columns
1 1
Column Interval: 1 .
Include first and last column of each row
Files to Create: 1
Filename Preview: 001001
[+ Create & Mew ] |\f Create | [ 4 Cancel

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in the
Tubepro software (available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume

button.
2. Click on Connect button under the Instrument tab. This will open the Instrument

configuration page. Click on the line showing the instrument on which you want to
connect and then click on Connect.

M| OE 4 ¥ =

o Home Setup Advanced Instrument

SR e

Connect Setup  Disable Ch. Setup Info /o

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

r A
Instrument Connection (Ectane) ﬂ
Type Maodel MAC Address Host Details
Ectane2 | E128RNMI | EC923300:01:43 (1)

nnect Cancel

L

) ——

Instrument Configuration

Metwork Informatian Embedded Software Update

Mode: Atomatic - @ lse the embedded software that comes with Magnifi

P address:  |[192.168.13 .10 Use custom embedded software

Subnet Mask: | 255.255.255.0

Gateway: |0 0 0 .0

Two acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode. The
Setup Mode is used to scan your calibration tube and make the necessary adjustments on your

—
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setup without saving the data automatically. The acquisition mode is used for the inspection.
When in this mode, the software automatically saves the acquired data using file names based
on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

o1

4. Plug the NFT probe on the Ectane 19-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

6. Bring the probe head outside of the tube and start the acquisition by clicking on the
Acquire button under the Home tab or by pressing the F2 on your keyboard.

Pull the calibration tube at approximately 12”/s (300 mm/s)

8. When it's done, press the Stop button or again F2 on your keyboard

o

N

/] OFE 4 ¥ < Magnifi®4.4RS - [Setup from original data file]..\Default\DemoDatad 2\NFT-BBAD. magdata
o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View &lu[em
* * o L (-] & =
* * =
A v BB P E A NS E
Mew  Locks Comp  Probe  Scan Data  Process Landmark C3l  Calibration Sizing Indication Display
Points
~
g‘ ‘ [-] Jees.[r)] [t oeov ] [L] L] or.] 7l [t ooov J4] [] [ ees] 71l T 3917 [1 1000V
b i 300 Hz |
e T T Y T T
i)
=
A | T TR UUPTN | OSTPSSND. 1RSSRt
]
g
=
=
z 1
z i
® |
5.00v 90° i ? %g
|Upp‘| ’pp‘|3|2P|M| ‘ CDR‘| CC)R‘|
[] Jor ] | |
300 Hz i
]
]
]
i
4.57v 900 i ? %bg
il |Vpp‘| ’pp‘lcle‘lMl \ :DF!‘| :C)F!‘|
) Notification center Information Documentation Report
T o ET(md  [oGmp)  [@(mm)  [Almm) [V Im (mm) [Speed (mis) [AR (F)
I";" MIET! | 013 | 1402 5258 904 |T51;860‘4 0298 800 © ~ NFT-BBAD o

Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These
buttons are used for the channel selection.

1. 2. 3. 4
- DIF | F1

Fl Fl F Fl

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated
Strip chart to this channel.

PR EREEER R PR ED R AT
158.4 kHz 158.4 kHz ;

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

| | [ oF | Fi.

158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
FIDIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only
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STRIP CHARTS AXIS ORIENTATION

The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from

one axis to another, click on the box showing an arrow at the upper right corner of the Strip
chart.

- . CIF L] F1,

1 400V |
158.4 kHz (

/OOMING

On the strip chart, hold the right button of your mouse and drag on the zone of interest to
zoom in this section.

BERERE [[ 2oy [5] PEREIE EET e
158.4 kHz 158.4 kHz

J o JE
| 1584 ki _

| ,
==

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent

u NIE G [t 2oy [=)
_____ ]

4 Previous Zoom
®, Full Bxtent

% Adjust Cursor Size
G BestFit

e

Horizental

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

o | Ry IREXN BB BREY
158.4 kHz F1DIF 158,4 kHz
r

#

£
£
&

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 2. 3. 4
Ve | e | 3| 2P

"

=

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Hold and drag the left button of your
mouse to draw a vector in your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your and dragging it around the rotation axis. Note that is operation cannot be
performed on the raw channels since these channels have no gain or rotated applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,

make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard.
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CALIBRATION AND SIZING CURVES

CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the Calibration window

3. In the Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

BRERER [t woov 4]
7% Calibration [
@ Channel 7

() Channel and Sizing Curves

() Landmark

Exit
GR-60
HOLE
TS
TS2

[ Calibrate ]

[ Reset ]

4. Select the signal name in the list

5. Click on the green arrow button to associate the measured signal to the calibration
point

6. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of
them

7. When all your calibration points are checked marked, click on the Calibrate button
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SIZING CURVES

The following section describes how to build your sizing curves.

1. Go the Calibration tab and click on the Sizing curve button
2. Go over the signal in your Strip chart and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is display on the
Lissajous to show the defect size. To have the correct interpolated point, the measurement
method also needs to be the same as the one used for the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.

3. Select the signal name in the list

Click on the green arrow

Redo the previous steps for all the other indications in the list
Click on the Calibrate button

o Uk

PRERER TR

r 5
% Calibration @

) Channel A

@ Channel and Sizing Curves

) Landmark

Exit
GR-30
GR-60
HOLE
RBH-25
RBH-50
RBH-75
TS
TS2

v
v

[ Calibrate ]

[ Reset ]
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Sizing curves can also be adjusted manually. To do so, go the Calibration tab, and click on View
Curves. The sizing curve window will appear. Each sizing curves you asked magnify to create will
be listed in the drop-down menu. If an invalid notification is present on the curve, it means that
either you haven’t entered the sizing points yet or that Magnifi failed to create the curve. To
adjust the sizing curve manually, enter the value in the table.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws
in the Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw
size does not appear, it means that you are not in a channel where a sizing curve was set.

LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TSTand TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).

Once the landmarks are calibrated properly the system should be able to recognize them
automatically.

Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your
inspection file. Note that when a data is saved, the setup is also saved with it.
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i A
. Save Setup As u
F Setup
0 Save setup in current inspection Browse...
File name:  MNew setup
MName
| \/ QK | [ x Cancel ]

L A

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.
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INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1.
2.

6.
7.
8.

Connect Magnifi to your instrument.

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFT probe on the Ectane 19-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

Pull the tube at approximately 12”/s (300 mm/s)

When it's done, press the Stop button or again F2 on your keyboard

Repeat step 4,5,6 and 7 for all the tubes to inspect in you bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two landmarks are needed to use this feature. These landmarks are created by default

when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1.

2.

Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

Click on Settings ...
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o

8.

( E Sequence @1 rQ Manual Sequence Configuration @1

Sequence

/\ Type: ) Mene @ Landmark
Start Recording Landmark:
Launch .

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

' Pushing
' Pulling/Recording
' Waiting for Mext

0K | [ Cancel

You must be
connected to an

0 instrument to start
the sequence,

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button

or use a timer. Select the desired option in the Restart section.
Click on OK.

To use the manual sequence:

1.

2.

Connect Magnifi to the instrument

Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFT probe on the Ectane 19-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press Fé on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab

Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.
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7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

8. Pull the probe until it goes out of the tube. This will trigger the last landmark detection
that will stop the data recording.

9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.

TUBE LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously
in the Tube list section of this document. To do so, checkmark the Automatic File Recording
option that can be found by clicking on the Acquisition preferences button in the Data window.
This option is selected by default.

1 total, 0 acquired

EIEDES

@ Acquisition preferences:
E:]a: Automatic File Heu.:ording
Please activate [T Auto Create new file on Next

Process. [] Automatic Next on Stop acquisition
Keep re-scan files

The list of tube is also shown in the Data window.
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Data T X
Row| Col

» 001 001 =)

b 002 001

b 003 001

b 004 001

4 total, 0 acquired

(4] (%2 (%)
MIEDIRYD

Tubes can be added or removed by using the first line of buttons of this window.

A common practice is to rescan your calibration tube and balance on it periodically. You can
save this new calibration tube data by adding a new tube in your tube list (999 001 for example).
Or you can go out of the acquisition mode, scan your tube, and click on the Save Cal As... button
under the Calibration tab to save your data. You can then go back to the acquisition mode to
continue your inspection and to save automatically the acquired tubes in your bundle.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to
the tube description.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in
the Home tab.

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename
option.
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LOADING A FILE

1. First disconnect your computer from the Ectane by clicking on the Disconnect button
under the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab. Note that double-clicking on a tube when you are still connected to an
instrument will start the data recording.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired

or| (% [
A [0 ] [ 0] sort order:

4 File name »

DQV
Please activate DQV an [~ Reverse order

process.
Sort by creation date

V| Show re-scans
| Show messages
[¥| Show screenshots
(¥ Next skip re-scan
("] Show only tagged files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an
entry in the report. These two buttons indicate the code that is associated to the defect to
enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the
Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type
of defect to enter.

3. Click on the defect button to add an entry to the report.

4 4 4 4 4 F

158.4 kHz 158.4 kHz !

1 DIF | F1, I 148V 1 1 DIF Fi_| (I 2753° I 148V
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, DNT
"""""""""""""""""""""""""" & DSl
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Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
‘e 3 ! B E e = =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.
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i ™
. Generate Report u r. Generate Report u1

1% Section Selection
“= Sections to Include in Report

@ eddyfi

Report Summary

1 ShwEmpty o cao )
Instrument Settings
z Component Type = | Bundle Eddyfi @
Component Information h h
E] i Component S/N Za| <enter values @ i

Picture:
Site » | Eddyfi Quebec

Report Summary
Configure the Summary Section

Inspection Summary

Date and Signature Comment
Screen Captures
# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
[C] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

Component Information Inspection Summary

e ——— e B
-

Tube Material THanim Tube 0D 19.05 mm # Tube Tested Total mumbes of tested tubes E)
Tube T 124mm Tube Length 6000 mm nop io dafuet datactac i dauow
< 10% Tuibes reported in range < 10% wall koss 4 5%

ToinL o ot kien ™ 10% - 19% Tues regorted n range 10% - 19% wall ks 0 0%
P 2% - 1% Tubes reported n range 2% - 29% wall ks 0 0.0%

0% - 39% Tubes reported In rangs 3% - 39% wall ks 0 0.0%

a0 4 Tuises reported in range 4056 - 49% wall lexs 0 0.0%

s0% - 8% Tues reported in range 507% - $9% wall loxs 0 0.0%

60 - 6% Tubes reported in range 6% - §9% wall loss o 0.0%

0% - 7% Tues reported in range 7056 - 79% wall loss o 0.0%

0% - 9% Tubes: reported in range 80% - 895 wal loss o 0.0%

> 9% Tuhes reportad in range > 90% wallloss 3 2%
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Analysis Report @ eddyﬁ Analysis Report C\ eddyﬁ
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric
O ASMEInverted = —--- - ) Imperial
Jo0
_| EDF

System Readback
|:| Do not display data during loading
Speed:
) Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

Q) Reset to checked after loading a data file

General

Setup Wizard Path:  Ch\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logao

Preview:

= (V' eddvyfi

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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RFT Application Guide
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RFT Single-Driver Probes RFT Single-Driver Boiler Probes

Vo

RFT Double-Driver Probes RFT Single-Driver Flexible Probes
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INTRODUCTION

This document presents how to use an RFT probe with Magnifi 4.4R5 on an Ectane test

instrument.

Eddyfi offers four types of RFT probes. The following was made using a dual-driver probe (RFT-
DDST) but can also be applied to all other types of RFT probes.

EQUIPMENT

The RFT probes use a 19-pin connector that can be connected on an Ectane with the “ERNM"”

option. The absolute and differential signal from the probe will provide Strip charts, Lissajous

and Voltage planes.

A wide range of probe diameter is offered (see the tubing probe catalog for more details).
Different frequencies ranges are also available to allow inspections of tubes of different

thickness and material.

From the following table, the best probe for your application can be selected.

Table 10 - RFT-DDST probes diameter selection table

TUBE WALL THICKNESS (BWG, mm, in)

BWG 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
mm 605 559 516 457 419 376 340 305 277 241 211 18 1656 147 124
in 0238 0220 0206 0180 0185 0148 0135 0120 0109 0095 008 0072 0065 0058 0.049
15.87 mm 0.625in = = = = = = = = = 100 100 110 110 110 120
ww 19.05mm 0.750in - - - — - 100 110 110 120 120 130 130 140 140 140
@@ 222mm| 08B - 100 100 110 120 130 130 140 140 150 160 160 160 170 170
2 % 2540mm | 1.000in 120 120 130 140 150 150 160 170 170 180 180 190 190 190 200
&3 31.75mm | 1260l 180 180 180 200 200 200 220 220 220 240 240 240 240 240 260
= 3810mm| 1500l 220 240 240 260 260 260 280 280 280 280 300 300 300 300 300
5080mm | 2000in 340 360 360 380 380 380 400 400 400 420 420 420 420 420 440
Table 11 - RFT-DDST probe frequency range selection table
TUBE WALL THICKNESS (BWG, mm, in)
BWG 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
|— mm 605 589 516 457 419 376 340 305 277 241 211 183 165 147 124
in 0.238 0.220 0.206 0180 0.165 0.148 0135 0120 0109 0095 0.083 0072 0.065 0.058 0.049
Carbon steel A178, A179, A192, A214 IF LF IF LF MF MF MF MF MF MF MF MF MF MF WMF
_ Castion (g MF MF MF MF MF MF MF MF MF MF MF HF  HF HF  HF
= Ductle iron IF LIF LF MF MF MF MF MF MF MF MF MF MF MF HF
= Nickel 200 MFE MF MF MF MF MF MF MF MF MF MF MF  MF  HF HF
= Stainless stesl 439, A268, TP439 MFE MF MF HF HF HF HF HF HF HF HF HF HF  HF HF
Stainless steel duplex (2205), 3REG0,A780 HF HF HF HF HF HF HF HF  HF HF  HF HF HF HF  HF
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Table 12 - RFT-DDST Frequency range

CODE FREQUENCY IN Hz
Min. Max. Central
LF 10 400 50
MF* 50 2000 300
HF 500 20000 2500

* Standard frequency range

The RFT calibration tube used in this document includes the following indications:

External groove, 40% and 60% of wall loss
Hole, 100% of wall loss

OD Flat Bottom Hole (FBH), 60% depth
OD 4 x FBH, 20% depth

A support plate

But, other combinations can be used to calibrate the probe and to build sizing curves.

Note: Fill factor and selection tables may differ for other type of RFT probes. Please refers to the

tubing probe catalog on our website to find out more.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your
setup, data and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done
at a refinery shutdown and be named Refinery_Shutdown_May_2018. The second level of file is
the Inspection folder. Inspection folders are saved in the project file. An inspection folder can
include the data specific to the inspection of a tube bundle with a specific technology and could
be named CS_075x0.083_RFT for instance. This inspection folder groups the setup, the tube list,
the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

___________  E— l .l..

INSPECTION 2 INSPECTION X

| |
| |
| |

|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
| <«—> DATA |
| LIST I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi 4, the first page displayed is called the Backstage.

Magnifi® 43R10

General
Project / Inspection Information
Earer! Project Folder: C:\Users\daube.QTEC\Magnifi\Projects\Support FAE Probe: Unable to detect
Inspection Folder: Default .c.) .5 Application:  Generic
Open/Add Add/Open e
Project Inspection Tube Dimensions:
oD: 19.05mm
Setup / Data
Setup Loaded: [unsaved) WT: 1.65 mm
z 3 5 1
Report Summary Setup Location:  C:\Users\daube.QTEC\Magnifi\Projects\Support FAE -3 = Length: 1400 mm
Create Setup Open Setup Open Data .
Data Loaded: Material:  Stainless Steel304
Frequencies:
Acquisition
Filename: [Row, Cal &
001001.magdata
Create New

Material Database List Import List
Report

Documentation Name: [Report.mdb =) ~ .
Table Profile: [ Tubing IRIS - © -

Generate Export Report
[] Take screenshot with report entry Report
Preferences

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an
existing project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project
file. Select New, Folder and enter the chosen name. You can then select the newly
created folder and click on Select Folder.

Bl select 2 project =

@‘\J'l » Computer » 0S(C:) » Users » daube.QTEC » Magnifi » v|4,|\ Se o

Organize v New folder =- @
It Favorites

& Downloads i

& OneDrive i

%l Recent Places E L

B Deskiop

Projects e

i Libraries @] shoeut

3 Documents 5 Microsoft Access Database

= Magnifi Data E B | Bitmopimage

* Magnifi Setup -

o Music = Micresoft Word Document

LIS View v Microsoft Access Database

Project:
QE‘] =9 Sortby v Microsoft Praject Document
Videos
Group by r Microsoft PowerPoint Presentation

- " Refresh Microsoft Publisher Document
% Computer

P Pate SonicWALL Global VPN Client Decument

3 ArchivesZetec (\srvarchives) (K Paste shortcut Rich Ted Format

8 QAData (Wsrvdata) (L) Undo Delete Ctrlez | | TedDocument

55 Mechanical (\srvdlata) (M) Share with R () | PPN

59 SoftwareProducts (srvdata) (N:) Microsoft Bxcel Workshest

@ Client (\\srvdata) (O:) New v Briefease

52 PublicShare (\srvdats) (P:) R

L Nualibe M eredatal (00 w2

Folder Magnifi

Select Folder
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name
of your inspection.

- Al
. Manage g

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|/ select | |3 Ciose |

3. Hit Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In

the System tab, you can change the measurement units from metric to imperial and vice versa.

For the metric units, you can choose to use meters, centimeters, or milimeters in the General
tab. And, for imperial units, you have to use inches. When finished, click on Preferences again

to go back to the General window.

Preferences

General

Analysis

System (Computer Related)

Measurement Convention Measurement Units
@ ASME @ Metric

) ASME Inverted == O Imperial

O EDF o Preferences
Readback

[] Do not display data during loading

Speed:

7 Actual Inspection Speed

@ Maximum

System

“Keep Current Setup” Button Behavior:
7 Retain check state

© Reset to checked after loading a data file
Setup Wizard Path:  C:\Users\daube.QTEC\Documents\MagnifilSetup
Automatic Features

[] Allow to save setup in original location

Ask to save setup when the first data file is recorded

General

Logo
Preview:

£. (@ eddyfi

Shartcuts

Keyboard.. |
Remate.. |

Analysis

General (Setup Related)

Measurement Units

Report Units: | Millimeter - |

Channels
Full Channel Scale: 2000V p-p =
Hide Raw Channel
Precision
[ Enable

Amplitude: | 2 decim...

Phase: 0 decim... ¥
Acquisition

Automatic File Recording

Auto Create new file on Mext
Automatic Next on Stop acquisition
Keep re-scan files

To create a new setup, it's strongly suggested to use the Setup Wizard process. Click on Create
Setup to start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open a scrolling menu. Select the material of the tube to be
inspected. If the material is not in the list, you can click on Manage... to open the List of
Available Material window.

5" New Setup Wizard *

Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: () Surface (® Tube from ID
Application: (@ Generic () Air Conditioner
Material: Carbon steel L
Resistivity: 21 pll-cm
Permeability: 450 p
Velocity: 5850.000 m/s
Wall thickness: 1.65 mm -
16
() CBWG
6 24
Qutside diameter: 19.05 mm =
Length: 6000 mm B

Mote about selected material:
ASTM: A178, ATT9, A192, AZ210, A214

To add a new material, click on Add. A new line will appear in the list. You can give it a relevant
name. Change the material resistivity and permeability to its theoretical value. The ultrasound

velocity is used to set IRIS parameters only. It doesn’t need to be set if an IRIS inspection is not
performed on this material.

323|Page



You can add a note about the material to specify things like its application or composition.
When you are done, click OK.

(] List of Available Materials S|

Custom Maternals

Materials - Copy
i Velody (n/9) (crem) Pemesbilty
Stainless Steel 321 - ET ONLY 0.000 715 1| & Remaove All
Stainless Steel 430 - ET OMLY 0.000 63 100 | 3¢
Stainless Steel Duplex - ET OMLY 0.000 74 75 | %

Stainless Steel 9041 - ET ONLY 0.000 o4 75 (&
Titanium 6070.000 486 1 (%
Ti-BAI-4V - ET ONLY 0.000 123 1 (%€
Zirconium 4650.000 a1 1 |

Motes About Selected Material

v ok ][ conce

You will be back to the Component Definition window. If you added a new material, it will be
available in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the
slider. Enter the tube outside diameter and length.

These tube properties will help magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, you have to select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down
menu. More precise filtering can be done by using the Model drop-down menu. You can then
select your probe by its catalog number (PRBT-RFT-DDST) and then click Next.

[ 5% New Setup Wizard §1
I,’\_, Probe Selection b—! |
- Select the probe that you want to use for your inspection
-
Technique: [RFF v] Model: [Dual Driver v]
Probes
Tech. Model Catalog Number Y | Description
[H MNew... ] [‘; Manage.. ]
(3 Cancel || Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the
acquisition rate and the typical probe speed.

';- New Setup Wizard @

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Axis

Position from:

Acquisition rate: 800 Hz .

Typical probe speed:  300.0 mm/'s -

4

Acquisition Size: 600.000 = = Maximum

-

[x Cancel ] [-‘ Back ] I ’- Next |

e

The position along the tube can be defined by using either the internal clock of the system, or
by using an axial encoder. If you use the internal clock, the default position will be given
assuming that the probe is always pulled at the typical probe speed. If the typical probe speed
is set to 200mm/s, and that the time since the acquisition was started is 2 second, the system
will indicate a position of 400mm. Using an encoder will give you the exact position of the probe.
Note that the position can also be obtained by using the landmark, but this feature will be
shown later.

The acquisition rate is the number of acquisition point taken per second. By default, the asked
acquisition rate is set at 800 Hz for RFT, but depending on drive frequency used to inspect, the
actual acquisition rate may differ. The system will automatically readjust this value if needed.

The axial resolution will depend on the combination of the acquisition rate and pulling speed.
For an acquisition rate of 800 Hz, the pulling speed needs to be less that 400mm/s to have at
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least 2 points per millimeter. If you do not use a pusher-puller, the pulling speed won’t be
constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your
axial resolution target. Also, the typical probe speed should be set as close as possible from the
real value. This will help the algorithm that automatically detect landmarks (explained later).
The recommended pulling speed for RFT depends on the excitation frequency (set in the next
step) and is shown in the table below:

Excitation Frequency (Hz) Maximum
Maximum R pulling speed (in/s)

20 100 4

100 200 6

200 350 8

350 500 10

500 1000 12

1000 - 20

If you selected the position from Encoder, different fields will appear and a second Scan
Definition page will become available.

- New Setup Wizard === 3% New Setup Wizard ==

Scan Definition | Scan Definition

Configure the type of scan you will be performing with your probe Encoder and axis settings
Sean: Single Pass e
Main Scan Ais: ¥ Axis Type  [ClackDi
Fecuilines Encode) = Resolution: 2546 2 count/mm

Detect Overspeed [ Tnvert direction
Typical probespeed: 2500 mm/s Preset 0,000 mm
Masimum probe speed: | 3500 mm/s : 9] Apply preset on Start
Density: 2000 smpl/mm
Acqisition Size: 100000 mm 5| (7] Masimum
(3¢ cancel | [ Back | [p Nex (3¢ cancel | (4 Back | [P Net

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to
be entered. The Maximum probe speed is the maximum acceptable speed for your probe and
the Density is the number of acquired points per millimeter (axial resolution). These values will
be used to set the acquisition rate and to optimize the acquisition processes used by the Ectane.
Note that if your probe is pulled at a speed exceeding the Maximum probe speed, data will be
lost.

The second page includes the type of encoder and its resolution. A preset can also be specified
if your acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for
the Absolute and Differential channels. It is important to set these parameters correctly before
acquiring the data since they are driven by the instrument and cannot be modified during the

analysis.

[~ ™
5% New Setup Wizard ﬂ

ﬂ Data Definition = v |
e

Select the channels you will be using and the necessary frequencies

Connector: 19 pins

Channels Required frequencies
Name Prefix Gain (dB) Prefix  Val (Hz) Ampl (V)
Absolute ABS- 56.0 F1 247 5.00 @
Differential DIF- 66.0

(9t

[ Cancel |4 Back |[p Nex |

[

By default, Magnifi suggest a frequency theoretically calculated with the tube parameters
previously entered.

But frequency and drive voltage can be changed by replacing their values in the Required
frequencies table. Up to four frequencies can be set at the same time. And the sum of their
amplitude cannot exceed 10V.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If the
suggested frequency is not within the recommended probe frequency range, it means that
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either the probe that you are using is not appropriate for your tube or that one of the tube

parameters previously entered was not set correctly.

Another thing to consider when selecting the frequency is the frequency of the power outlet at

the location where you are performing your inspection. Under a certain frequency, it is
recommended to avoid the harmonics of the outlet frequency to prevent noise issues. The

figures below indicate which frequency to avoid.

BW =8 Hz BW =10 Hz BW =15 Hz BW =20 Hz BW =25 Hz
SPD =0.1m/s || SPD = 0.15 m/s SPD = 0.22 m/s SPD = 0.3 m/s SPD = 0.35 m/s
A S SN S (NS S S SO SN L
30 50 75 85 135 165 195 225 255 200 310 355! | 500
—
0 60 120 180 240 300 360 420 480 540 600
Frequency (Hz)
- Frequency range to avoid - Frequency range allowed
Figure 43 - Recommended frequencies for power outlet at 60Hz
BW =8 Hz BW = 10 Hz BW = 15 Hz BW =20 Hz BW =25 Hz
SPD =0.1m/s || SPD = 0.15 m/s SPD = 0.22 m/s SPD = 0.3 m/s SPD = 0.35 m/s
30 40 60 85 115135 165 205 215 240 260 295 305 500
e T e B e T e T e S
0 50 100 150 200 250 300 350 400 450 500 550 600

Frequency (Hz)

- Frequency range to avoid - Frequency range allowed

Figure 44 - Recommended frequencies for power outlet at 50Hz

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly

used to detect indication close to support plates. They are built with two frequencies of a same

channel type to attenuate the effect of the support plate and to be able to size an indication

at this location more accurately.

329 |Page



5% Mew Setup Wizard

Configure the channel mixes for your inspection

P Oxt= Deinition ]

Input Channel 1 Input Channel 2 Output Mixed Channel
DIF-F1 DIF-F3 MK

Mixed Reference Signal
REF

|x Cancel ||‘ Back | | b

Net |

If you do not wish to use mix channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which
input you want to use the mixed channel. Note that Input Channel 2 has to have a lower
frequency than Input Channel 1. Mixed channel can be built for both absolute and differential

channels.

You can rename the mixed channel by modifying the Output Mixed Channel field.

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix
channel. The system will apply processes to the chosen input channels and will subtract them

to attenuate the reference signal.

Click on Next.
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DATA PROCESSING

The Data Processing window used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to
every channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter
choice can be changed without any problem during data analysis, while wrong parameters
choice for the data acquisition can mislead the analysis. It is possible to change the filters
parameters after data acquisition, so it is always possible to fine tune the filters parameters
during analysis.

% New Setup Wizard ﬁ

'Ll‘ Data Processing | |

! Select the processings that you want to apply to the channels you have selected

[] Individually configure all the channels

Low Pass Median High Pass
Mame ‘ Cutoff (Hz) Window Size (smpl)
ABS- 12 O] 532
DIF- 12 [C] 533
MIX1 12 [[] 533

Suggest

[x Cancel l[‘ Back ll’ Mext |

The low pass filter eliminates part of the signal that is above a certain frequency. As an example,
it is useful when your defect signal has a lower frequency content than the background noise.
In this case, using a filter will remove part of the noise without removing the defects signals.
This may help to analyze the data. However, a cutoff frequency that is too high won’t remove
much noise, and a too low cutoff frequency will filter out the defects signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off
variations of the probe within the tube, changes in material, geometry or thickness. As a rule-
of-thumb, the width of high-pass median filter should be set to at least three times the longest
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flaw that may be encountered. Data should be examined in its filtered and unfiltered states. It
is important to keep in mind that the high-pass median filters can distort phase. More
information about median filter for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.

DETECT LANDMARK

The Detect Landmark window is used to configure the automatic detection of features such as
tube sheets and support plates. Landmarks are not mandatory and doesn’t need to be set to
have a functional setup. They can however give relevant information on the axial position in a
tube. They can also be used by the software to trigger automatic acquisition sequences.

If you don't need the automatic landmark detection, you can delete the landmarks created by
default by clicking on the X button next to them. You can then click on Next to go the next step.

< Mew Setup Wizard X
9 Detect Landmark ]
9 Configure landmarks detection
Exit is used for Exit
Detection Channel: R_F1ABS v (Exi
TS1 sequence only) TS2
L ]
Position From: (@) Start Record () Stop Record w I I—
[] Negative Positioning: From 0.0 mm = StOp Start
Record :: : Record
position from
Detection Engine: Legacy ~ Length 0
Landmark Table {in the order seen by the probe during data acquisition)
Name Type Pos. (mm) Min Gty Max Qty Shape Component Threshold (V) P2P (mm]) Enable
Bt Bt .25 P = 10000.00 Disabled E
152 152 0 5 = 10000.00 Enabled  [3¢]
Ts1 Ts1 6000 5 = 10000.00 Enabled |E

Positioned Landmark

Import... || Export... Add

|x Cancel | |‘ Back | |’ Mext
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Three landmarks are created by default. The default channel used to detect these landmarks is
the lowest frequency absolute channel. The R_ before the channel stands for Raw. This is the
signal of the channel without software filter, rotation or software gain applied.

You can base the position of your landmarks either on the location where you start to record
(usually the tube entrance, opposite from the operator position) or on the place you stop to
record (usually the operator side).

(Exit i d fi Exit
Detection Channel: [R_ABS-FI (EXitis USS"): }O( .
TS1 sequence only) TS2
Position From: '@ Start Record _ Stop Record I I—
[C] Negative Positioning: From | 0.0 mm - StOp Start
Record I4 I Record
position from
Detection Engine: Extended Length 0
(Exit i d fi Exit
Detection Channel: R_ABS-FL -] (=xitis “SG": ﬁr .
TS1 seguence only) TS2
Position From: ) Start Record @ Stop Record I I—
[T] Negative Positioning: From | 0.0 mm - StOp Start
Record I ;i Record
position from
Detection Engine: Extended O Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer
end. It can be used to trigger the data recording (explained later). It has a negative position
because this event happens before entering in the tube. It is enabled only when doing the
acquisition. As it can trigger the data recording, it is not included in the resulting data file and
is not available at the subsequent analysis step.

TS2 is the first tube sheet encountered when the probe is pulled. TST is the last tube sheet
encountered at the end of the acquisition. These two landmark detections are enabled during
both data acquisition and analysis.

The landmark detection can be set up manually by describing the shape, component and
voltage threshold that will trigger the detection. The Shape describes the shape of the signal
when the landmark is reach. If a differential signal shape is chosen, the peak-to-peak distance
("P2P") will also be needed. The Direction is the projection axis (horizontal of vertical) of the
Lissajous signal that will be taken to trig the Landmark. And, the Threshold is the voltage
amplitude threshold.

Landmarks can be calibrated on real signals (explained later); in this case, there is no need to
change these parameters as they will be automatically measured by the software.

[t's important to set the landmarks position as accurately as possible. If the position is not
accurately set, the software might prevent their automatic detection since it won't be at an
expected position.
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The Type field is a name that associates the calibration point to the landmark. If landmarks
share the same Type, they will be calibrated at the same time using the same point and process.
To associate two landmarks with the same Type, their signal must be the same. If support plates
of the same geometry are present in a bundle, they can share the same Type. In the above
example, TS1 and TS2 doesn’t share the same Type because one is triggered when the probe
goes inside the tube and the other is triggered when the probe goes out the tube.

Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode,
all the landmarks need to be entered with the right position. The system will look for the exact
number of landmarks entered at positions close to the those entered in the table. With the
Extended mode, the system will look for a number of landmark between the Qty max and the
Qty min. With this mode, the exact number of support plate doesn’t need to be constant or
known.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These
indications will later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or
inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name,
side and size. The side and size of the flaw will be used to positioned the calibration point in the
sizing curve(s). Since RFT doesn’t allow a indication side differentiation

Calibration points can also be imported with the Import button.

= New Setup Wizard [ = |
Calibration Points r - |
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%) -
Calibration points
Mame Side Size
HOLE Through 100.0 X
FEH-80 None 80.0 [Z]
FEH-60 None 60.0 @
FEH-40 None 400 @
4% FBH-20 None 200 @
GR-40 None 400 @
GR-60 None 60.0 [Z]
SUPPORT Unknown 0.0 @
REF MNone 0.0
L Import | | <= Add |
|9 Cancel || 4 Back |[p Nea |

L r

Click Next when you have set the required calibration points for your calibration(s) and sizing
curve(s).
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CALIBRATION

The Calibration page is used to define the calibration method that will be used to set the
amplitude(s) and phase(s) of a channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by putting it at 1V and 90° on the
differential channel. The calibration can be done differently on each channel type. It can also
be done individually for each frequency by selecting the Individually configure all the channels
option. Different reference signals can be set to calibrate the phase and the amplitude
independently.

% New Setup Wizard &

6 Calibration |

A Configure parameters to calibrate channel amplitude and phase

[ Individually canfigure all the channels
Use Violtage Plane representation for absolute (ABS) channels
Link differential (DIF) channels rotation and gain to the absolute (ABS) channels normalization

Amplitude Phase
MName Voltage (V) Reference Measurement Angle () Reference Measurement
ABS- 1.00 SUPPORT PP 0.0 SUPPORT Pp
DIF- 1.00 HOLE pp 90.0 HOLE pp
ML 1.00 HOLE pp 90.0 HOLE pp

[x Cancel ] [‘ Back ] I " Mext |

A

You can use a voltage plane for the absolute channel(s) by selecting the Use Voltage Plane
representation for absolute (ABS) channels option. This option is selected by default. Voltage
planes are polar plot in which theoretical curves show the effect of depth variation on the signal.
They are used with RFT to estimate the depth and coverage of a flaw. More information on
these views can be found in Appendix 1. The voltage plane option will allow you to use the
functions offered by Magnifi to match the signal with theoretical curves. With this option,
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calibration settings will be grayed because the calibration can’t be done with a single reference
point when using a voltage plane.

A second option can be selected if voltage planes are used (Link differential (DIF) channels
rotation and gain to the absolute channel (ABS) normalization). This option links the absolute
and the differential channel. When an inspection is performed, certain tubes can have
properties that are different from the calibration tube. This will change the operation point
position and the built sizing curves won't be applicable to the inspected tube. Bringing back the
operation point to a reference point makes the sizing curves compatibles again. Automatic and
manual functions can be used to do this operation. With the second option checked, the gain
and phase rotation apply on the absolute channel will also be applied to the differential channel.
If this second option is not selected, the adjustment of the differential channel will be done
separately. The ways to perform these adjustments is explained in the Inspection section of this
document.

If the voltage plane option is not checked, the absolute channel will be calibrated with the
reference signal(s) selected in the calibration page.

When you'll select the reference signal, the system will use the selected measurement method
to apply a rotation and a gain. Here is a short description of the available options:

1. Absolute (A): 6. Absolute Peak Vertical (APV):
Uses a straight line from the Lissajous Uses only the vertical component,
origin to the main cursor position to from the Lissajous origin to the peak
measure amplitude. value of the data selection, to
2. Absolute Horizontal (AH): measure amplitude.
Uses only the horizontal component, 7. Average Peak (MP):
from the Lissajous origin to the main Takes the distances from points at the
cursor position to measure amplitude. extremity of the cursor to the peak of
3. Absolute Vertical (AV): the data selection to build an average

vector. Used only, and recommended,

Uses only the vertical component, )
for absolute signals.

from the Lissajous origin to the main
cursor position to measure amplitude. 8. Average Peak Horizontal (MPH):
4. Absolute Peak (AP): U.ses the horizontql component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.

Uses a straight line, from the Lissajous
origin to the peak value of the data
selection, to measure amplitude.

5. Absolute Peak Horizontal (APH):
Uses only the horizontal component,
from the Lissajous origin to the peak
value of the data selection, to
measure amplitude.

9. Average Peak Vertical (MPV):
Uses the vertical component of the
distances form points at the extremity
of the cursor to the peak of the data
selection to make an average vector.
Used for absolute signals.
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10. Peak to peak (PP):
Uses the combination of the vertical
and horizontal component to 13
measure the maximum amplitude.

11. Horizontal (PPH):
Uses only the horizontal component
to measure the amplitude.

12. Vertical (PPV):

Uses only the vertical component to
measure the amplitude.

. Peak to peak First Transition (PPF):

Uses the combination of the vertical
and horizontal component of the first
transition of the signal to measure
maximum amplitude. The firsts signal
transition is from the base of an
indication to its peak.

Click on Next went the parameters in the table are set according to your requirements.

SIZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each

line in this table.

% New Setup Wizard

Add and configure the sizing curves necessary for your inspection

Sizing Curves |

v] MName Source
ABS-F1 ABS-F1
ABS-F2 ABS-F2
DIF-F1 DIF-F1
DIF-F2 DIF-F2
MIX1 MIK1

Measurement
Phase
Phase
Phase
Phase
Phase

XXX X [X]

|x Cancel ||‘ Back ||’ Net |
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The sizing curve will allow you to estimate the size of a defect based on the calibration points
signals (amplitude or phase) obtained with your calibration standard. Magnifi will give you the
interpolated flaw size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be
changed. You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve
properties. The name of the curve will be shown in the upper left corner of the page (ABS in the
example below).

=+ New Setup Wizard ﬂ

Sizing Curves | v |

Configure the properties of the ABS sizing curve

Measurement method: [ PFF '] frEslifzrrean
Shape: [ BEL v] MName Side Size
- GR-60 Nene 60.0 T
[T] Report as remaining wall
GR-40 MNone 40.0 A&
[T] HOLE Threugh 100.0
[E] FBH-80 MNaone 80.0
] FBH-50 Mone 60.0
[7] FBH-40 MNone 40.0
[] 4xFBH-20 Mone 20,0
[] SUPPORT Unknown 0.0

Extrapolated curves:

Marme D Description
Leng L Long Defect
Taper T el ars Reverse order of points

[x Cancel ][‘ Back ]Eb Mext i

A

The measurement methods options are the same as the one described in the calibration page
section of this document. By default, the option Peak to Peak First Transition (PPF) is set for
absolute channels and the option Peak to Peak (PP) is used for the differential channels.
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The interpolation method can be selected with the Shape dropdown menu. Here is a short
description of the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side
calibration points in relationship with phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID
section is linear and the OD section is polynomial. The OD side of the curve will need at
least three points (including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (at least three)
calibration points.

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the
curve. Need at least three points.

The linear options are mostly used when little data points are available, while the options Best
fit (Dual Polynomial) is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select
the curve points for each sizing curves previously created. The order in which the points appear
in the list will influence your curves. Make sure that the measured values of the calibration points
are in the desired order. You can use the Reverse order points option to associate the deepest
flaw with the smallest measured value.

For the absolute channel(s), two additional extrapolated curves will be created by default for
each sizing curves. These curves will give the depth of a flaw that is considered Long or Taper.
A description of these type of flaw can be found in Appendix 1.

Extrapolated curves:

MNarme L Description
Long L Leng Defect
Taper T Taper Defect

You can set Magnifi to show the remaining wall instead of the defect size by checking the box
Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when
analyzing the data.

a

 MNew Setup Wizard X

== _ Indication Codes ]

- 0 Configure the indications codes used for the report

Code Description Type Automatic Color

COR Corrosion Defect |Z|
CRK Crack Defect g
DNT Dent Defect x|
Dsl Distorted support indicatic  Defect g
ERO Erosion Defect x|
MDD Mo defect detected Mo indication g
OBS Obstructed Feature I" Red |Z|
PIT Pitting Defect g
PLG Plugged Feature I" Brown |Z|
RST Restricted Feature I Yellow g
WLL Wall loss long Defect x|
WLS Wall loss short Defect g
WLT Wall loss taper Defect |Z|

| L Import | |- Add |

|x Cancel | |‘ Back | [P Next |

When an indication in added, its abbreviation (code) is shown in the code pane, next to the
data.

You can modify the default indications codes list by changing the parameter in the table. New
indications can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

5% Edit Setup Wizard =5

. = Display
. Configure display and layout properties

General options Lissajou / Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

Zoom to full scale

»
3

Proportion: 33.00

4

() Zoom to content

Display Direction: Down bt

@ Keep current scale
Strip chart duration: 105

4

ok | (B

b 4

The scroll direction is the direction in which data appears on the screen. If you choose downward,
the signals will go from the top to the bottom of the screen. If you choose the upward direction,
the signal will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking
the box.

The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Check marking the proposed layouts will
make them available in your setup. You will be able to switch from one to the another via the
layout tab. The " C " stands for Code, " S " stands for Strip chart, " L " for Lissajous and " V "' for
Voltage plane.
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Layout with the blue background will be the one opened by default.

Layouts can be readjusted at any time.
("% Edit Setup Wizard =

Display

-
. . Select the layout that you want to use to display your inspection results
-

2 Strip charts, 1 Lissajous 2 Strip charts, 1 Voltage plane

qs|s L DCSS v

2 Strip charts, 1 Voltage plane, 1 Lissaje || 4 Strip charts, 1 Voltage plane, 1 Lissajc

v v
ds|s [C] ds|s|s|s—
L L
. : Default layout
(3 cancel |4 Back |[w/ Finish

. )

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To
modified the parameter previously entered, you can go to the Setup tab in the Frontstage and
click on the button associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

o A 2B 9 & A N So @

Comp E’robe Scan Data Process Landmark PC_E'I Calibration  Sizing  Indication Display
oints

This will open one for the window previously described. Change the desired parameter. If
applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.
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Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are
changed by using these functions, the information shown by using the Setup tab may not
match your actual setup.

TUBE LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list
of tube.

This list can be created in the Acquisition section of the General tab of the Backstage.

Acquisition

Filename: [Rc-w, Cal 'l

001001.magdata E‘o |__©

Create Mew .
List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front
Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending of the
chosen filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval.
You can then enter the number of tube per row in the Nb. of Columns fields of the table. Click
on Create to generate the list of tube. You can also use the Create & New button to add another
set of tube to your list.
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"l File List Creator - S

File List Cenfiguration

Mumber of Rows in Component: 1
Start Mumbering at Row: 1 -

Row Interval: 1

MNumber of Columns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 -

Include first and last column of each row
Files to Create: 1 i
Filenarme Preview: 001001

[+ Create & Mew ] |\f Create | [x Cancel

b

The same principles apply to the other file formats, except for the Free format option for which
the file name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube
list file can be found in the Inspection folder. It is also possible to import a list created in the
Tubepro software (available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume

button.
2. Click on Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument on which you want to

connect and then click on Connect.

Home Setup Advanced Instrument Calibration

B R ¢ @

Setup  Disable Ch. Setup Info o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this
is the case, a white X icon will be shown in the Status field of the Instrument connection window.
To download a matching version in your Ectane, clicking on the Config. button and then hit the
Send firmware to the instrument button of the Instrument configuration window.

F N
Instrument Connection (Ectane) ﬁ
——
Type Model MAC Address Host Status QConfig Details
Ectene2 | E128RNMI - EC:92:3300:00:14 ' ' :
Connect Cancel
[
r e —_——
Instrument Configuration 4 ﬁ
- -
Metworl Information Embedded Software Update

Mode: A tomatic - @ Use the embedded software that comes with Magnifi

P address: |192.168.19 .10 lUze custom embedded software

Subnet Mask:  |255.255.255.0

Gateway: DO0OO0O0

A

Two acquisition modes are available in Magnifi: The Setup Mode and the Acquisition Mode. The
Setup Mode is used to scan your calibration tube and make the necessary adjustments on your
setup without saving the data automatically. The acquisition mode is used for the inspection.
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When in this mode, the software automatically saves the acquired data using file names based
on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button
under the Home tab. This mode is active when the Setup Mode button is grayed.

O
£3

Setup Null
Fode

4. Plug the RFT probe on the Ectane 19-pin connector.

5. If you wish to balance, bring the probe head in a clear area in your standard and
balance the probe by clicking on the Null button under the Home tab, or press F6 on
your keyboard.

6. Bring the probe head outside of the tube and start the acquisition by clicking on the
Acquire button under the Home tab or by pressing the F2 on your keyboard.

7. Pull the calibration tube at the appropriate speed
8. When it's done, press the Stop button or again F2 on your keyboard
m OF 4 & = Wagnii84.453 1 . 1. 1 a
0 ome  Setup  Advnces  Instume: n G Ansiis | AsiedAnsini  lsyout  CumentView  RAT =)
o AR EN
PBRERER [t woov o) [ ] or 5] 1 av 1] ] Jes ) - : 1 100y
§i . '
; - f
*_——_‘__\\‘ —_—
- Ty
r f L — Telelel (=
g a; ‘
L L DR R T
- _g
—
— ——*? :FF) —_ 28.28V 315 2 %a
— [l =l [] [Tcor [ cor ]
l """"""" B — e —— S
() Nolificstion ceiesinformation Documentation Report

|A[mm] |nmmm |s.m T ]lamH. ‘

+ Calibrated_data T-RFT-DDST-130M @

B i o | s

Note that a red zone in the code pane means that at least one of the raw signals is saturated.
This is usually the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes
useful functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These
buttons are used for the channel selection.

1. 2. 3. 4.
- DIF F1

4 4 4 4

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a
Strip chart are both set to 1, setting the Lissajous to DIF-F1 will also set the associated

Strip chart to this channel.

PR EREREED R PR EDE N AT
158.4 kHz 158.4 kHz S

.
;

2. Clicking on the corner with the black triangle gives the list of available channels. Click
on the desired channel to select it. Right-click or Left-click on this button to switch to
the following or previous channel in the list.

| | | oF | F1,

158.4 F1ABS

F1DIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only
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STRIP CHARTS AXIS ORIENTATION

The Strip charts are projection of the Lissajous on the vertical or horizontal axis. To switch from
chart.

one axis to another, click on the box showing an arrow at the upper right corner of the Strip

J .1 CIF ) F1,
158.4 kHz

T 400V |

/OOMING

On the strip chart, hold the right button of your mouse and drag on the zone of interest to
zoom in this section.

u L oF ]l

|1 2000V |-;|
158.4 kilz

u J ooF [

158.4 kHz

1 2000V |-'|

[,‘] | DIF ‘| F1) 000V ‘]..|
[158.4kHz |
i | /
|
J |

u NIER RN
156.4 kilz

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent. C-Scan

‘1 2000V ‘|-;|
,,,,,, I

S Previous Zoom
B, Full Bxtent

% Adjust Cursor Siz
) BestFit

~+  Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your
cursor and the full line is the center of what you have selected.

Only the selected section of your data will be shown in the Lissajous.

To adjust your cursor length, go over a dotted line with your mouse, hold the left button and
drag it. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the
same operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button
with the left button (decrease scale) or the right button (increase scale) of your mouse.

o | Ry IREXN BB BREY
158.4 kHz F1DIF 158,4 kHz
r

#

£
£
&

Another way to modify the scale is to hold and drag (up or down) the right button of your
mouse on the scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the
measurement method. A short description of the measurement methods can be found in the
above calibration section of the setup wizard.

1. 2. 3. 4
Ve | e | 3| 2P

"

=

1. Clicking on the corner with the black triangle gives the list of measurement method for
the amplitude of the signal. Click on the desired method to select it. Right-click or
Left-click in this button to select the following or the previous method in the list.

2. Same as 1., but for the phase measurement
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t
measure the phase with the right orientation.

4. Take the two same points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Hold and drag the left button of your
mouse to draw a vector in your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left
button of your and dragging it around the rotation axis. Note that is operation cannot be
performed on the raw channels since these channels have no gain or rotated applied by
definition. Also, rotating the signal will affect your calibration. If you perform this operation,

make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous
background and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor on a point where you want the
data to be centered and press on the space bar on the keyboard.
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CALIBRATION AND SIZING CURVES

FREQUENCY VALIDATION

The injection frequency (set in the Data definition section) will influence the phase angle
separation between flaws of different depth. It can also affect the signal-to-noise ratio of
certain flaws.

If this frequency is too low, the phase angles of your flaws will be close to each other. Therefore,
it will be difficult to build accurate sizing curves because a small variation of the phase will lead
to a significant change of depth estimate.

Multiple methods can be used to validate that the injection frequency was correctly set. Here's
two of them:

e There is approximately 1° per percentage of wall loss between two grooves of different
depth. The two grooves must not be too close in term of depth.

e There is approximately 65° between a through wall hole and a 4 x FBH 20% depth

With Magnifi, the automatic calibration process can also recommend you the right injection
frequency. You can go through these steps (described later) before adjusting your frequency.

To adjust the injection frequency:

1. Click on the Data button under the Setup tab.

o Home Setup Advanced Instrument Calibration Analysis

ok o iy B B o

Mew Locks Comp Probe Scan Data Process Landmark

2. Toincrease the phase angle spread between your flaws, increase the injection
frequency. Decrease the injection frequency to lower the phase angle spread. Refers to
Figure 1 and 2 for the frequencies to avoid.

Click on Next and then click on Finish

Rescan your calibration tube

Verify that your injection frequency is right

Redo step 1to 5 until your have an acceptable frequency

CALIBRATION BASED ON SCALE PROCESS

o kA

The following section describes how to calibrate the channels that doesn’t use a voltage plane.

1. Go to the Calibration tab and click on the System icon

2. Select Channel in the calibration window

3. In the Strip chart, go over the signal to calibrate and adjust the cursors to see only the
desired signal.
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Note: The system calibrates the signal with a measurement method that is defined in the
calibration part of the setup (previous step). It is recommended to read the data with the same
method as the system when you select your calibration point. This will allow you to see what
the system is using to make its calibration. If for some reason the measurement is not taken
properly, you may be able to readjust your cursor to have right measured values.

'gg_' IER [t coov | 4]

% Calibration A

@ Channel "y

_) Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

[ Calibrate ] g

[ Reset |

4. Select the signal name in the list

5. Click on the green arrow button to associate the measured signal to the calibration
point

6. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of
them

7. When all your calibration points are check marked, click on the Calibrate button

CALIBRATION BASED ON VOLTAGE PLANE PROCESS

The following section describes how to calibrate the channels that use a voltage plane. Magnifi
offers two methods to do this operation.

MANUAL METHOD

1. Put your cursor in a sound area of your calibration tube.
2. Click on the normalize button in the voltage plane window. This should bring the
operation point of the probe to the theoretical nominal point on the Voltage plane.

felers
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Since this operation depends on how the probe was built, it is possible that the operation point
of the probe doesn’t reach the theoretical nominal point. If this is the case, right-click on the
voltage, click on Reset Nominal button and continue to the next step.

3. To adjust the signal manually, Magnifi uses a vector drawn by the user that represent
the effect of a completely blocked signal. This vector must start at the operation point
of the probe and must go in the direction of the support plate. Its length must initially
be set to twice the length of the support plate for a dual driver probe. For a single
driver probe, it must be set to the length of the support plate. To draw this vector, click
on the manual measurement button " M ", click on the operation point of the signal,
hold the left button of the mouse and drag it to the desired location. Once the vector
is correctly drawn, click on the normalise button again. Magnifi will put the origin of
the vector to the theoretical nominal point. It will apply a gain of 1/(vector amplitude)
and a phase rotation of —(vector phase). If, for instance, the drawn vector as an
amplitude of 0.8 and a phase angle of 10 deg, the system will apply a gain of 1.25

(1/0.8) and a rotation of -10 deg to the system.
=] [I=ln] ‘ e

BRENE

850 Hz

_—
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S : 52.8%4
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4. The signal may not be perfectly adjusted after the previous steps. You can adjust the
signal again by drawing a new vector and by clicking on the normalization button until
the signal is set correctly. In the examples below, the calibration tubes included two
360° grooves and we can see that both grooves reach the theoretical 360° coverage
line. This can be a relevant indication to determine if a voltage plane is calibrated

correctly.
PRER G [t sssv , Cll =1
0.9 kHz 0.9 kHz B
Grooves touching
the 360° line the 360° line
T:?2% sossa
i e——X 5
4.02V 06° Ext: 360.0° S:2 t:/«:q Angle correction: 0.0° . L:2%
g ey =y g olelo THETR 3.71V 99° Ext: 360.0° $:2 %4
Leloicii] — Telele]  [wjor) it e mer_ i -
Dual driver probe

Single driver probe

5. Save your calibration by clicking on the Save Nominal button

[eTa[o]

You can go back to your calibration settings at all time by clicking on the Back to Nominal
button.

[ela]e]

AUTOMATIC METHOD

Another way to calibrate a voltage plane in Magnifi is to use the automatic calibration tool.
This feature requires the following indications:

e One point of type [360°, non-taper] or

e Two points of types [360°, taper] or [non-360°, non-taper]
e Asupport plate signal

e A nominal point

Also, one point must be 360° and one must be non-taper.
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To define the calibration point that will be used by the algorithm, go to the RFT tab and click
on Calibration Settings.

L al
. RFT Calibration Configuraticn M

Calibration channels:

Channels Cut Off (Hz)
R_ABS-F1 16
[] R_DIF-FL 1a

Mominal tube reference;
Support plate: SUPPORT =

Calibration points:

Mame Size 360° Taper
GR-60 B0

(]
| B &

ok || Ccancel |

[ ]

1. Checkmark the raw channel(s) that will be use to calibrate the signal.

2. Select from the drop-down menus the signal name that correspond to your nominal

point and to your support plate (If these signals were not created, you can go back to

the Calibration Points window via the Setup tab).

Click on Add and select the reference signals that will be use by the algorithm

4. In order to make the algorithm work, the user must associate the calibration points to
the real signal. This operation is done at the same time as the sizing curves calibration
process. Go to the Sizing Curves section of this document and follow the steps using
the signals entered previously. This will trig the automatic calibration.

b

Tip: For the calibration, when selecting the support plate with a dual-driver probe, it is
recommended to take the straight part of the signal that goes from the nominal point to the
first signal transition.
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5. Once the automatic calibration process will be done, the systemn may recommend you
a drive frequency. If this is the case, you can change your frequency, rescan your
calibration tube and repeat the previous steps.
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)
Magnifi® [

Calibration is done. However, the main frequency (F1) produces not enough
phase shift to allow appropriate depth sizing.

: It is recommended to increase F1 frequency to around 1123 Hz.

Select a frequency value that is 20 Hz away from a multiple of the power
outlet,

Adjust others frequencies accordingly.

The automatic calibration will give you access to the Frequency Check option that can
recommend you another inspection frequency in case the inspected tube has properties that
are too far from your calibration tube. This feature is shown in the inspection section of this
document.

Note that the automatic calibration tool doesn’t only adjust the signal to match theoretical
curves but it also dynamically compensates the change of tube properties by recalculating the
theoretical curves. This increase the precision of the sizing.

It is possible to use the automatic calibration and the manual calibration on the same setup.
The automatic calibration process will create a new channel with which the calibration curves
will be readjusted according to a theoretical model. The new created channel(s) will have the
letter " m " (for model) added at the end of the channel name (example: ABSm-F1 for absolute
channel with frequency 1).

NOMINAL POINT VARIATION TOLERANCE

After scanning a tube, you can select a sound point in the data and click on the normalize
button in a voltage plane. This will bring this point to the nominal theoretical point. The angle
correction will then be shown at the lower left corner of the voltage plane window. It will become
red If it's not within an acceptable range. To set this range, click on the voltage plane window,
go in the Current View tab and enter the value in the Tolerance parameter.

Layout Current View RFT
)—l | i | <]-Tu:ulerance: s
e Reset

ninal Mominal

SIZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button
2. Select Channel and Sizing Curves in the calibration window
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3.

Go over a signal in your Strip chart and adjust the cursors to see only the desired part o

the signal.

Note: The system calibrates the signal with a measurement method that is defined in the

calibration part of the setup (previous step). It is recommended to read the data with the same

method as the system when you select your calibration points. This will allow you to see what

the system is using to make its calibration. If for some reason the measurement is not taken

properly, you may be able to readjust your cursor to have right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the
Lissajous to show the defect size. To have the correct interpolated value, the measurement

method also needs to be the same as the one used for the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.

4. Select the associated signal name in the list

5. Click on the green arrow

6. Redo the previous steps for all the other indications in the list

7. Click on the Calibrate button
PREE IEER R IR Toanv
0.9 kHz 0.9 kHz

74| Calibration (]
) Channel )
@ Channel and Sizing Curves
) Landmark
——
4 % FBH-20
"""""""""""""""""""""""""""""""""""" Exit
FEH-60
W GR-40
GR-60
HOLE
T51
Ts2
v
T:?7%
Angle correction: 0.0° L:7?%
1.85V 108° Ext: 360.0° 5:?0%q
Voo | J 2 elelo cor | com
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Error messages after creating the phase sizing curves can appear. The main cause of these
errors is the measurement direction.

The image below shows two different measurements. On the left, you can see that the
measurement arrow is pointing toward the liftoff signal. In this case, the measured phase is
rotated of 180° from the right value. When one or more points were measured in the wrong
direction, Magnifi cannot build the sizing curve and will generate an error message.

On the image on the right, the arrow is pointing from the liftoff signal to the defect signal,
which is correct. However, in this picture, the arrow starts quite far from the middle of the liftoff
variation signal, which will cause an error in the measurement. In this case, we suggest you to
move the cursors until your measurement is taken from a point near the base of the signal.

[ JesJr) 1 223V BREI R 2nv ||
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The arrow is
pointing towards
the liftoff signal
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the arrow is not on
the nominal point

Angle correction: 0.0°
q 1.94V 112° Ext: 360.0°

[ wlolv] ARAER [cor J cor )

Angle comrection: 0.0°
1.81V 2889 Ext: 360.0°

[ ] = Jo]u] [e]a]o] [er]c

0o
Ve
g2

B
e
a

EIEESS

To adjust you sizing curves and remove the error messages, go the Calibration tab, and click on
View Curves.
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The sizing curve window will appear. Each curve you asked magnify to create will be listed in
the drop-down menu. If an invalid notification is present on the curve, it means that either you

haven’t entered the sizing points yet or that Magnifi failed to create the curve. To adjust the
sizing curve manually, enter the value in the table.

In the above example, the entered phase angle for the 40% groove is 270°, but the correct
phase angle is 90°. The defect has an 180" bias due to wrong measurement direction. In this
case, we can simply change the angle value from 270° to 90 in the table to fix the sizing curve

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws
in the Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw
size does not appear, it means that you are not in a channel where a sizing curve was set
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Built sizing curves can give you access to the phase-depth indications on the Lissajous and the
Strip Charts. To activate this option, click on a window (Strip Chart, or Lissajous), go to the
Current View tab and check the Depth-P. option.
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LANDMARK

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks showed in
the Landmarks window the same way as you calibrated the sizing curve(s) points. You can use
the Land channel to do so. The positions of TSTand TS2 are described in the Landmark window
in the Setup tab (TS2 is the far side tubesheet, that is, the first one encountered by the probe
while pulling it back; TS1is the nearside tubesheet).

Once the landmarks are calibrated properly the system should be able to recognize them
automatically.

Note that in order to calibrate the default Exit landmark, a data that includes the probe exit at
the far end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save
Setup button under the Home tab. The displayed window will allow you to give an appropriate
name to your setup and to save it at the desired locations. The save location is, by default, your
inspection file.

You can also save the data of your calibration standard by clicking on the Save As button under
the Home tab.

INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to your instrument.

2. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.

The Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the RFT probe on the Ectane 19-pin connector.

4. If you wish to balance, bring the probe head in a clear area in your standard and
balance the probe by clicking on the Null button under the Home tab, or press F6 on
your keyboard.

5. Bring the probe head outside of the tube to inspect and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your
keyboard.

6. Pull the tube at the appropriate speed.

When it’s done, press the Stop button or again F2 on your keyboard

8. Repeat step 4,5,6 and 7 for all the tubes to inspect in you bundle.

b

~
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MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the
landmarks and can trigger the acquisition start/stop and the data recording automatically. At
least two landmarks are needed to use this feature. These landmarks are created by default
when going through the Setup Wizard process and are shown in the Detect Landmark section
of this document.

To set the manual sequence:

1. Click on the Manual Sequence button under the Calibration tab.

2. If a warning message is shown in this window, change the parameters until no warning
are shown. The system will guide through the different windows to do so.

3. Click on Settings ...

f E Sequence ﬁ-‘ rQ Manual Sequence Configuration @1

Sequence

A Type: ) Mene @ Landmark
Start Recording Landmark:
Launch -

Start Recording Delay: 10s -

Stop Acquisition Landmark:  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s :

' Pushing
' Pulling/Recording
' Waiting for Mext

0K | [ Cancel

You must be
connected to an

0 instrurment to start
the sequence.

4. Select Landmark in the Type section

5. In the drop-down menu choose the Landmark that will start the data recording. If you
kept the default landmarks, you can select the Exit landmark that will be trigger when
the probe will go out of the tube when the probe is pushed.

6. You can enter a delay to start the acquisition after the first landmark is detected
(Start Recording Delay) and a delay to stop the acquisition when the last landmark is
detected (Stop Acquisition Delay).
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7. Two options are available to restart the acquisition: The user can either push a button
or use a timer. Select the desired option in the Restart section.
8. Click on OK.

To use the manual sequence:

1. Connect Magnifi to the instrument

2. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab.
The Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plug the ECT probe on the Ectane 4-pin connector.

4. Bring the probe head in a clear area in your standard and balance the probe by clicking
on the Null button under the Home tab, or press F6 on your keyboard.

5. Open the Sequence window by clicking on the Manual Sequence button under the
Calibration tab

6. Put your probe in the tube to inspect and click on the Launch button. This will start the
data acquisition.

7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will
start the data recording.

8. Pull the probe until it goes out of the tube. This will trigger the last landmark detection

that will stop the data recording.
9. Acquisition restart:

a. If you selected User Input in the settings of the Manual Sequence Configuration,
the system will wait for the user to enter an information on the tube to restart the
acquisition. Click on NDD or Review. This will add a tag on the inspected tube and
it will restart the acquisition. Redo step 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a
countdown will be trigger after the last tube acquisition was taken. The acquisition
will start after this timer has elapsed. Redo step 6 and 7 for all the other tubes to
inspect in the bundle.

When doing your inspection, you may encounter some tube that can’t be scanned completely.
If this is the case, you won't be able to catch the landmark that trigs the data recording at the
end of the tube. In this situation, you can click on the Target button in the Sequence window to
start the data recording.

TUBE LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously
in the Tube list section of this document. To do so, checkmark the Automatic File Recording
option that can be found by clicking on the Acquisition preferences button in the Data window.
This option is selected by default.
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process.
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Acquisition preferences:
Automatic File Recording

[] Auto Create new file on Next

[] Automatic Next on Stop acquisition
Keep re-scan files

The list of tube is also shown in the Data window.

Data
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» 001
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001
001
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4total, 0 acquired
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Tubes can be added or removed by using the first line of buttons of this window.

A common practice is to rescan your calibration tube and balance on it periodically. You can
save this new calibration tube data by adding a new tube in your tube list (999 001 for example).
Or you can go out of the acquisition mode, scan your tube, and click on the Save Cal As... button
under the Calibration tab to save your data. You can then go back to the acquisition mode to
continue your inspection and to save automatically the acquired tubes in your bundle.

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to

the tube description.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in

the Home tab.

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename

option.
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FAST NORMALIZATION SETTINGS

The opened data may not have been already adjusted to match your sizing curves. Magnifi
offers a tool to do these adjustments in an efficient way.

Go the RFT tab and click on the Settings button. The displayed window will show the channels

using voltage planes and standard scale process.

n

. RFT Normalization Settings 23
Channels based on voltage plane process
Channels Shortcut
AB5-F1 A
ABS-F2 A
Channels based on scale process
Channels Amplitude (V)  Angle (%) Shortcut
DIF-F1 200 20 D
DIF-F2 2.00 20 D

[ Measure Reference l

| ok || cancel |

LS 4

The channels using a standard scale process will only be shown if the option to link the
differential channels to the absolute was not selected in the Calibration part of the setup wizard.

F

%"+ Edit Setup Wizard — -

6 Calibration

/ \ Configure parameters to calibrate channel amplitude and phase

A~

Individually configure all the channels
Uze Voltage Plane representation for absolute (4B5) channels
[ Link differential (DIF) channels rotation and gain to the absolute (ABS) channels normalization
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Keyboard shortcut next to the channels can be customized to normalize the associated channel.
To normalize the process using a voltage plane, select a sound area in the tube and push on the
keyboard shortcut. To normalize the channels using a standard scale process, select the
reference (normally a support plate) and click on the keyboard shortcut. The system will adjust
the selected reference to the value set in the RFT Normalization Settings window (Amplitude
and Angle).

LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button under
the Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also
be done by selecting the file in the list and by clicking on the Load button under the
Home tab. Note that double-clicking on a tube when you are still connected to an
instrument will start the data recording.

3. You can open the next or the previous file in the list be clicking on the Previous or Next
button of the Home tab.

The data files can be filtered by using the Filter button of the Data window.

10total, 10 acquired

BA | |2 » | | ¥o»| Sort order:

4 File name »

DQV
Please activate DQV an [~ Reverse order

process. 2
| Sort by creation date

/| Show re-scans

\¥| Show messages

'¥| Show screenshots

(V] Next skip re-scan

("] Show only tagged files
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an

entry in the report. These two buttons indicate the code that is associated to the defect to

enter. They do the same thing but can be set to different flaws.

To add an indication on a data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the

Lissajous includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type

of defect to enter.

3. Click on the defect button to add an entry to the report.
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Indications can also be added to a tube to indicates, for instance, that it has no flaw or that it

is plugged.
To add an indication to a tube:

1. Load the file
2. Click on the appropriate indication button available under the Analysis tab

o Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

|
> oBs
to 3 | B E e m-(n =1
io o > s o '=EBo. = | @l |E Eg
Previous  Mext Review Mo Defect I RST Completion Inset  Export Display Profile Subtraction | Infofield Cal. Infofield

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

issisted Analysis Layout Current View

Data Motification  Information

Report fDocumentation DOV Screening Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone Row Col.” Code Size Side Ampl. (V) Angle () ChanneliC-scan Y pos. (mm) LMK Y pas. Offset Y pos. (mr Y leng. (mm) Comment

1 0 0 0.00 0.00 o 00 00 00 x

2 0 0 Q.00 .00 o 00 00 oo b 4

A\ 2 new notifications  Informatiol

Entries in the report can be modified by changing the value in the table. You can also delete an

entry be clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the
Frontstage.

2. Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tube in
component is used to show the percentage of tube in each category.
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Defect Table Format: .
@ eddyfi

Report Summary

) ShowEmpy o coo )
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TR Component Type ¥ | Bundle Eddyfi @ H

Component Information h h
Picture: E] (| e |

Inspection Summary it | e -

Date and Signature Comment

Screen Captures

# of tubes in component: 2 - : :

[Rese’(toDefauIt] [Impor‘t] [Export]

|
P Next ] Display in File Explorer

4. Click Finish to generate the report.

This will create a PDF report that will show information such as the list of indications in your
bundle and a report summary with a pie chart.

Analysis Report @ eddyfi Analysis Report @ eddyfi

‘Component information Inspection Summary

e ———— e B

Tube Material Tianium Tube 00 1905 mm # Tube Tested Total pumber of tested e ® s
Tube wr 124mm Tube Length 6000 mm oo o cafict dabucied 32 Lo
<10 Tubes reported i range < 10% wall oss i s
Totat o ottnkien »; 10% - 19% Tubes rep0rted in fange 10% - 19% wal loss ] 0.0%
- 2 Tubes reports i range 20% - 29% wal logs o oom
3% Tute reportse i range 30 - 395 wal oss of oo
e Tt repore i range 40 - 495 wal sz of oo
s - 3580 Tt reorted n range 50% - 39% wal lexs of oo
oo 6o Tube reporte i ange 80% - 69% wal less of oo
05 758 Tubes repored i range 70% - 70% wal loss o oo
oy Tubes reported i range B0% - 39% wal loss o oo
> oms Tubo roporod i range > 90% wall ks FI T
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The report logo can be modified by clicking on the Select Company Logo that can be found
under the System tab of the Backstage.

System (Computer Related)
Measurement Convention Measurement Units
Preferences @ AsME @ Metric
O ASME Inverted === == O Imperial
360
") EDF

System Readback
|:| Do not display data during loading
Speed:
! Actual Inspection Speed
9 Maximum
“Keep Current Setup” Button Behavior
_! Retain check state

General

O Reset to checked after loading a data file
Setup Wizard Path:  ChUsers\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
DAIIow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo

Preview:

- ]
| (Y edd

The report table file in the Inspection folder can also be imported in other reporting software
such as Tubepro.
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APPENDIX 1 - VOLTAGE PLANE

The two following equations describe the through-wall transmission behavior of RFT:

B=B, e =B,e V™o ¢ =d./rfou,u,

The phase lag equation shows that the signal is influenced by the tube properties (d, x) but

B = Magnetic field strength at a depth ¢ = Phaselag
corresponding to phase lag (¢) # = u,pu =Permeability
, = Initial magnetic field strength d = Thickness
¢ = Phaselag /= Frequency
c = Conductivity

also depends on the frequency (f) at which the tube is inspected. Given a tube of constant
permeability and conductivity, and using a fixed inspection frequency, the phase lag will be
proportional to the thickness of the tube.

The magnetic field strength (B) will depend on this phase lag. For an infinite theoretical
thickness, the resulting magnetic field will be null. The explanation being that the field is
completely blocked and that nothing is caught by the receiver(s).

The voltage plane is a graphical representation of these formulas. The curves built on a voltage
plane show the effect of the thickness variation on the signal. There are four curves that
represent a flaw coverage of 90°, 180°, 270° and 360°. The point crossing the horizontal axis is
the nominal point. This is the signal obtained when the probe is in a sound area of the tube. It
has an amplitude of 1V and a phase of 0°.
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When you first scan your calibration tube, this point doesn’t match the nominal point of your
theoretical curve. You must calibrate the signal to match your probe signal to the theoretical
curve(s). This operation is called normalization.

A bundle of tube may include tubes that has different properties. The permeability, for example,
may be different for some tube. This will affect the nominal point position and the built sizing
curves won't be applicable to this tube.

If the nominal point moved not too far from the theoretical nominal point, the common
practice is to renormalize and to size the flaw with the built sizing curves.

If the nominal point moved far from the theoretical value, it means that the tube properties
are significantly different from the calibration tube. Therefore, the phase lag for a given flaw
will also be significantly different and this will generate an error in the sizing that must be
considered. In this case, it is recommended to change the drive frequency to put the nominal
point back to the renormalization zone.

374|Page



| s e [t woov ]

3 AL [e]s]o] [=le)
A common practice is to set the threshold angle at which the inspection frequency needs to be
changed to 30°.
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ECA Application Guide
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INTRODUCTION

The intent of this guide is to provide the user with the necessary knowledge to set up and
properly operate an ECA probe.

QQUICK PROBE SELECTION GUIDE

MECHANICAL DESIGN

Eddyfi offers several models of ECA probes. The 3 most popular probe types are described below.

Probe type Picture Purpose

Best suited for flat and curved
surfaces, both concave and convex.
Conform to outside diameter of 41
cm (16in.) or more (depending on
Semi-flexible probe model).

Combines part the flexibility of the

flexible probe and the ruggedness

and wear resistance of the rigid
solutions.

Best suited for uneven surfaces that
are reasonably smooth.

Padded Suited for smooth weld. Designed to
adapt to weld crown of 5 mm (0.2
in.) or less.

Ultra-flexible probe. Can conform to
curved surfaces with a bend radius

Flexible

of 20 mm (0.787 in.) or more
(depending on probe model).

Probe types
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TOPOLOGY

The term topology refers to how the coils are organized inside a probe and how they are
activated. The table below describes some of the strengths and weaknesses of the most

commonly used topologies.

Topology

Impedance
Absolute (IMP or
ABS)

Coil arrangement

S
o
Co
Do

(+)

Non-directional
(sensitive to defects
in all orientations)
Sensitive to short,
long and gradual
defects

Fewer number of
channels compared
to transmit-receive
modes

(-)

Very sensitive to
surface condition,
probe handling
Sensitivity to lift-off
(distance between the
coils and the inspected
surface)

Can’t discriminate
orientation of short
defects

Long Single Driver
(LSD)

Typically used for
detection of
subsurface defects
Good performances
on carbon steels
(surface-breaking
only)

Good tolerance to
lift-off

e More limited in terms
of smallest detectable
flaw compared to the
SDD topology

Short Double
Driver (SDD)

Good sensitivity to
short and shallow
defects

More sensitive to lift-
off than LSD
topology, but less
than IMP topology

T = Transmitter, R = Receiver

e Limited performances
on ferromagnetic
materials, especially
for long defects

379 |Page



With the impedance absolute topology, each coil generates one channel.

1 coil =1 channel <

%8
gg
o

-

—
Scan axis

Coil layout - Impedance Absolute topology

The transmit-receive topologies (SDD and LSD) produce 2 different groups of channels each,

the axial and the transverse. The transmit-receive groups are mostly sensitive to flaws oriented

along the transmitter-receiver axis. Therefore, the axial group is mostly sensitive to axial flaws

and the transverse group is mostly sensitive to transverse flaws. They are both sensitive to

volumetric flaws as well. Each receiving coil produces one channel.

Axial group <
(SDDA)

Axial group <
(LSDA)
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Transverse

group (SDDT)

—
Scan axis

Transverse

group (LSDT)

Coil layout - Long Single Driver topology
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COIL DIAMETER

The coil diameter have an impact on the followings:

e  Minimum detectable flaw

e Depth of penetration

MINIMUM DETECTABLE FLAWS

As a rule of thumb, one could use the following formula to estimate the length of the shortest
surface-breaking defect that can be detected. The distance to be considered is the distance
between the transmitter and the receiver. In the case of the Impedance Absolute topology, the
diameter of the coils could be used as an estimate.

Center — to — center coil distance

Minimum detectable defect = 2

Note that this represent an approximation and that real performances will vary according to
many parameters such as the surface conditions, lift-off, permeability variations, etc.

00000

Center-to-centre coil distance

00000

DEPTH OF PENETRATION

The depth of penetration is directly related to the coil diameter. Generally, the capability of a
coil to discriminate defects of different depths increases with the coil diameter. For instance, a
2 mm coil could discriminate defects having depths ranging between 0 and 2 mm. Past 2 mm
deep, the signal amplitude may remain the same. Note that this represent an approximation
and that real performances will vary according to many parameters such as the surface
conditions, lift-off, permeability variations, etc.

Typically, you could consider that far-side defects could be detected if they have a depth of at
least 25% of the wall thickness and a length of 1to 2 times the wall thickness. Again, you should
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consider this as an approximation to get started. Of course, real performances will vary
according to many parameters such as the surface conditions, lift-off, permeability variations,
etc.

For far-side defects, you could also use the following formula as a first approach to estimate a
potential operating frequency. Of course, the frequency range of a probe is typically related to
the size of the coils.

l6xp

Where f is the operating frequency in kHz, p is the resistivity of the inspected material in uf -
cm and t is the remaining ligament of material between the surface (inspection side) and the
bottom of the defect, in mm.

Important: With the currently available range of ECA probes, subsurface defects can't be
detected in carbon steel or other ferromagnetic materials having a high magnetic permeability,
even if they are very close to the surface.
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PROBES DESCRIPTION

|-FLEX™ PROBES

DESCRIPTION

1. Flexible body
Scan direction arrow
Encoder holder slot

|-Flex encoder holder

High precision standard

\_ encoder

ECA-IFG-056-250-048-N03S with encoder

|-FLEX TOPOLOGIES

/Up to three topologies can be
activated:

< 1. Impedance Absolute
2. Short Double Driver

\_ 3. Long Single Driver

ECA-IFG-056-250-048-N03S - PCB

Topology
S Long Coil OD Channels Central
Probe model Double Single : (mm) (according freq. (kHz)

Driver Driver ’ to topo.)
ECA-IFC-128-005-033-N03S L N 6.0 32 5
ECA-IFG-079-250-048-N03S o ] o 5.0 60, 59, 32 250
ECA-IFG-079-050-048-N03S o e ] 5.0 60, 59, 32 50
ECA-IFG-056-250-048-N03S o ] o 3.5 60, 59, 32 250
ECA-IFG-056-050-048-N03S o o o 3.5 60, 59, 32 50
ECA-IFG-034-500-048-N03S o o L 2.0 60, 59, 32 500

* Axial channels only

|-Flex topologies
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PADDED PROBE

DESCRIPTION

Encoder slot

Scan direction arrow
Padded sensitive area
Coverage indicators

NN N

ECA-PDD-034-500-032-N03S

TOPOLOGIES

Each padded probe can operate a single topology. It has either a Short Double Driver or a Long
Single Driver configuration, depending on the model.

Topology
Probe model Shogr::\)/:]ble Lorl]:?ri\s,ienrgle C((:TI]IW?)D l\lcl;r::ﬁ;l(s)f
ECA-PDC-058-250-032-N03S [ 3.5 59
ECA-PDD-056-250-032-N03S ® 3.5 60
ECA-PDC-055-500-050-N03S [ 2.0 95
ECA-PDD-054-500-050-N03S [ ] 2.0 96
ECA-PDC-035-500-032-N03S [ 2.0 59
ECA-PDD-034-500-032-N03S ® 2.0 60

Padded probe topologies
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SEMI-FLEXIBLE PROBE

DESCRIPTION

Encoder slot

Scan direction arrow
Semi-flexible sensitive area
Coverage indicators

NN N

ECA-SFC-064-005-017-N0O3S
TOPOLOGIES

Each semi-flexible probe can operate a single topology. It has either a Short Double Driver or a
Long Single Driver configuration, depending on the model.

FIre) 92 (et = Short Doubong Single SOt SumBerof
Driver Driver (mm) CRANNEIS
ECA-SFC-128-005-033-N03S o 6.0 32
ECA-SFC-064-005-017-N03S [ 6.0 16
ECA-SFC-058-250-032-N03S [ 3.5 59
ECA-SFD-056-250-032-N03S (] 3.5 60
ECA-SFC-071-500-064-N03S ([ 2.0 123
ECA-SFD-070-500-064-N03S @ 2.0 124
ECA-SFC-035-500-032-N03S o 3.5 26
ECA-SFD-034-500-032-N03S ([ 2.0 60

Semi-flexible probe topologies
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SETUP

LOAD / CREATE SETUP
1. Open Magnifi.

2. Inthe backstage, click on Open Setup
3. From the Default Master List section, select the setup corresponding to the probe to be
used.

(%) Recent Files (6)

(¥) Master List (46)

(Eé Default Master List (60)

(%) Inspection for thes ETO-1246 (1)

4. Connect the 160-pin array connector to the Ectane™ or Reddy™ unit.

5. Connect the 18-pin encoder connector to the Ectane unit or the 12-pin encoder
connector to the Reddy.

&

6. For the Ectane instrument, connect the instrument to Magnifi by clicking on the Comnect
button located in the Instrument ribbon in the front stage.

7. For the Reddy instrument, the connexion to Magnifi is automatic.

8. Once connected, you will see in the General section of the backstage that the probe is
detected.

Information

Probe: ECA-IFG-056-250-043

A\ Incompatible with current setup. |

Application:  Generic

Surface Dimensions:
WT: 2,11 mm
Width: 1000 mm
Length: 1000 mm

Material: Stainless Steel 316

Frequencies: 500.0 kHz

Default I-Flex Setup in Default Master List

The I-Flex probe is detected by the instrument
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Note that you will get a warning message if the currently loaded setup is not compatible with
the probe. The appropriate setup is not loaded automatically when a probe is connected. Make

sure to select the probe number that fits exactly with the one detected by the instrument, some
model numbers in the list are very similar.

[ oper *
. Setup

0 Select a Setup

Mame Location o

(%) Current Inspection (3)

(%) Recent Files (1)

(%) Master List (46)

(%) Default Master List (60) ———————————————

® Gear (3)
(®) I-Flex 6)

ECA-IFC-128-005-033

ECAIFG-034-500-048
ECAIFG-056-050-048
ECA-IFG-056-250-048 ]
ECA-IFG-073-050-048
ECA-IFG-07-250-048

Alternatively, a setup can also be created using the setup Wizard by clicking on Create Setup

Create Setup

from the General section of the backstage.

Note that all the steps of the Wizard are already filled with default values when creating a new
setup or when loading one from the Default Master List. In any case, all the steps of the Wizard

always remain accessible through the Setup ribbon in the front stage if you want to apply
modifications to your setup.

Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
* AN L B & =
ol & 5 B Q) AL
7 ||%e ! Y AT A
Locks Comp Probe Scan Data Process Landmark pc'alt Calibration Indication Sizing  Display
oints

All the Wizard steps are accessible in the Setup ribbon
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The table below presents the principal settings and their respective Wizard steps.

Wizard step Parameters

Encoder settings
C-Scan size

Scan Oversampling (interpolation)
Gain
ﬁ Topology
Frequenc
Data . 9 4
Driver voltage
]
Y Filters
Process
Calibration points
Cal P
Points

Calibration settings

Indication Codes

Sizing curves
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ENCODER SETTINGS

1. In the frontstage, go to the Setup ribbon and open the Scan 5= menu.
2. To enable the encoder, set the parameter Position from to Encoder. To disable the
encoder, choose Clock from the drop-down list. Click Next.

P

Scan Definition
Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: X Axis

Position from: Encoder “| [J Absolute
Detect Overspeed

Typical probespeed: 1000 mmys

Maximum probe speed: | 200.0 mm/s

Density: 2,000 smpl/mm

| [B e

Scan Definition, page 1

3. On the second page of the Scan Definition step, in the Encoder section, make sure
your encoder resolution matches the one set in the software:

P

Scan Definition
Encoder and axis settings

X Axis ¥ Axis
Offset: 0000 mm : Offset 0.000 mm
Displayed Resolution: |0.500 mm/smpl CrelizfzeroT  Larameye
Displayed Resolution:  0.938 mm/smpl
Size: 1000.0 mm :
Size: 59.1 mm
Oversampling: 2x
Encoder Made in Cansds ~ ——
Type: Quadrature -
Resolution: | 2546 2 count/mm
) Tnvert direction
Preset: |0.000mm o
Apply preset on Start

[ cancel |[d4 Back |[p Next |

Scan definition, page 2

4. Depending on the orientation of the encoder relative to the probe and scanning
direction, you might have to Invert direction to make sure that the positions provided
by the encoder are going in the same direction as the probe scanning axis.

5. Click Next on all the following pages, then Finish.
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IMPEDANCE ABSOLUTE LAYOUT

w

C-Scan - Impedance Absolute

Impedance Absolute layout

A probe used in Impedance Absolute mode produces a single group of channels and therefore
the setup has a single C-Scan. Each horizontal line in the C-Scan represents one channel.

The C-Scan view displays the vertical component of the Lissajous view since the signal
component selector (arrow button at the top right of the C-Scan) is set to vertical by default.
Only one channel at a time is displayed in the Lissajous view. It corresponds to the C-Scan line
under which the horizontal cursor is located.
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TRANSMIT-RECEIVE LAYOUT

rduances

C-Scan - Axial channels

C-Scan - Transverse channels

» NewFie

Transmit-receive layout

A probe used in Transmit-Receive mode typically produces 2 groups of channels and therefore
the setup has 2 C-Scans. Each horizontal line in a C-Scan represents one channel.

The C-Scan view displays the vertical component of the Lissajous view since the signal
component selector (arrow button at the top right of the C-Scan) is set to vertical by default.

Only one channel at a time is displayed in the Lissajous view. It corresponds to the C-Scan line
under which the horizontal cursor is located.
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OPERATING FREQUENCY SELECTION

The selection of the right frequency can greatly affect the results.

By default, the frequency set by the Wizard is simply the central frequency of the coils. Note
that depending on the material under test and the target defects’ type and dimensions, the
optimal frequency can vary. You can consult the first section of this document to guide you
through the selection of the operating frequency.

The following steps will suggest a typical workflow that can be used when adjusting the
frequency. Ideally, a representative sample of the material to inspect with a target defect would
be used.

1. Some probes like the I-Flex offer several topologies. Open the Data P step and
validate that you are using the desired topology.

5% Edit Setup Wizard x

b Data Definition
lf-tl Select the C-scans you will be using and the necessary frequencies
-

Connector: ® 160 pins
Gain: 3248
C-scans Required frequencies
Mame Prefix Prefix_Val (kHz) Ampl (V) Phase (%)
Impedance IMP F 2500 5.00 00 E
[ Longfsial LSDA
[] LongTransverse LsoT
[ ShortAxial SDDA
ShortTransverse SDOT,

Data definition page

b
O

2. Still in the Data g step, select the desired frequency. Click on Finish.

3. Make sure that no filter is applied. Indeed, the filters could remove the signal coming
from the lift-off, which needs to remain visible for the frequency selection and
validation. To disable the filters, verify that the filter options are unticked in the

]
Y

Process menu Process

<

4. Deactivate the encoder. To do so, open the Scan menu **" and set the Position from
to Clock.
5. Place the probe on a flawless portion of the sample applying an even pressure and null

your probe by clicking on the Null button ™' .
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6. Start the acquisition M and collect a material-air signal by lifting the probe away

from the sample’s surface. This is the lift-off signal.

Material

Performing a lift-off with the I-flex probe

7. Without stopping the acquisition, put the probe back on the material and scan over a
target defect. In the picture below, the defect is a long notch, but ideally the defect
would be representative of the target defects.

Scanning the notch

o

8. Click on Stop acquisition Hop

Note that the data shown below were acquired using an Impedance Absolute topology over
stainless steel material. These images are used to illustrate the frequency selection concept.
However, you should keep in mind that the shape of the signals will vary according to many
parameters such as the topology, the frequency, the material, the defect type and dimensions,
etc. and could be quite different than those shown here.
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-off signal, as shown below.
=] LI Te T

7 Material

Air
.

Lift-off signal

10. In the Lissajous view, rotate the signal so that the first portion of the lift-off signal is
horizontal. The material operating point should be on the right, with the first portion of
the lift-off going towards the left. You can use the rotation button at the top-right
corner of the Lissajous.

“o|PPEIGE

rrrrrrr

Rotation button

First portion of

lift-off signal

T

Saturated (see next step)

10,409 190,00
ol 2 X E2 [ o]

Lift-off signal, rotated

11. The previous image shows that the signal is saturated. Depending on the application,
it might be acceptable, especially if very little lift-off variations are expected during the
scans. However, it could be a good practice to avoid saturation. To do so, open the

i

Data definition page P , decrease the Gain and perform another acquisition.

Decrease the Gain by small steps until a non-saturated signal is obtained.
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Note: Inversely, you can increase the gain (or voltage) if the signals are too small.

7~ Edit Setup Wizard

b Data Definition
I I Select the C-scans you will be using and the necessary fre
-

o 160 0in
Gain: (3248 =] l

C-scans

Name Prefix

Impedance IMP
[ LongAvial LSDA
[J LongTransverse LSDT
[J shortaxial SDDA
[ ShortTransverse SDDOT

Lift-off signal, rotated, without saturation

12. In the C-Scan view, place the cursor over the lift-off and defect signals so you can
observe both of them simultaneously in the Lissajous. You might want to modify the
frequency in order to improve the detection of the target defect or to increase the
phase separation between the lift-off signal and the defect signal. The frequency can
be modified in the Data definition page Pst= .

Note that changing the frequency will modify the shape and rotation of the signals, so you will
need to repeat all the previous steps every time you modify the frequency.

Lift-off signal and notch signal
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CALIBRATION

In order to obtain optimal detection, a probe calibration should be performed. This step requires
a calibration plate or block with a long notch. The purposes of the probe calibration are:

e Adjusting the overall rotation and amplitude of the signals so that target defects provide
the desired amplitude and phase.

e Uniformize the response in amplitude and phase for all the channels so they provide the
same response over the same defect.

CALIBRATION PLATE PREPARATION

Prepare the calibration plate. It must have a notch at least 20 mm longer than the total
coverage of the probe to facilitate the manipulations and also make sure that the channels at
both ends of the array are not seeing edge effects.

The coverage in millimeters is indicated in the probe acronym. For example, the coverage of the
probe ECA-PDD-056-250-032-N03S, is 56 mm. Therefore, it would be recommended to have a
notch with a length of approximately 76 mm.

Also, the notch should be located far enough from the edges of the plate to ensure that the
calibration scans can be performed without reaching the edges.

Finally, the dimensions of the notch (width and depth) should ideally be similar to the
dimensions of the target defects.

CALIBRATION OF TRANSMIT-RECEIVE CHANNELS

Important: The frequency selection must be performed prior to the calibration. See previous
section.

Also, note that the data shown below were acquired using a Short Double Driver topology over
stainless steel material. These images are used to illustrate the probe calibration concept.
However, you should keep in mind that the shape of the signals will vary according to many
parameters such as the topology, the frequency, the material, the defect type and dimensions,
etc. and could be quite different than those shown here.

With the transmit-receive topologies, two groups of channels have to be calibrated, the axial
channels and the transverse channels. The following steps will show how to:

e Properly acquire the reference signals for calibration of each group of channels;

e Adjust the rotation so that the lift-off is horizontal (as shown in the previous section).
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1. Inthe Process menu Precess  turn off the median filters.

=

2. Inthe Scan menu 5" | set the Position from to Clock.

3. Place the probe on a flawless portion of the plate and click the Null button ™"

o

Acquire

4. Start the acquisition and perform a material-air signal (lift-off signal).

Material

Performing a lift-off with the I-flex probe

5. Without stopping the scan, perform a scan with the probe parallel to the notch. This
signal will be used for the calibration of the transverse channels since it simulates a
transverse indication.

Scanning the notch to produce a transverse indication

6. Without stopping the scan, rotate the probe 90° and place it back on the plate as
shown on the next figure.

N

Null ™" the probe again.

8. Perform a scan with the probe perpendicular to the notch. This signal will be used for
the calibration of the axial channels since it simulates an axial indication.
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Null again here
Scanning the notch to produce an axial indication

O

9. Click on Stop acquisition top

Important: If your C-Scan is not long enough to perform the lift-off signal, the transverse notch
signal and the axial notch signal, increase the C-Scan size in the Scan menu, in the Encoders

=

Scan

and axis setting page

10. Place your cursor on the lift-off signal.

-------

Lift-off

eV
TP I = G |

Short double driver - Lift-off and notch signal
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11. For both the axial and the transverse channels, in the Lissajous view, rotate the signal
so that the first portion of the lift-off signal is horizontal. The material operating point
should be on the right, with the first portion of the lift-off going towards the left. You
can use the rotation button at the top-right corner of the Lissajous.

/i

#} Rotation button

First portion
of lift-off
signal

L7y 1706

> [er o

Short double driver - Lift-off and notch signal - rotated signal

Now, the following steps will show how to:
e Set the target values of amplitude and phase for calibration;

e Perform the calibration.

1. In the Lissajous view, click and hold the Amplitude measurement button, a contextual
menu will open.

Phase measurement button

= _
L= ErE ]

Amplitude measurement button
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2. From this menu, select the amplitude measurement method. It is recommended to use
Peak to Peak (Vpp).

Absohte (Va)
Huscide Hotzontal (Vah)
Abscide Vedtical (Vav)
Absciute Peak (Vap)
Absoite Peak Horzontal (Vaph)
Abstite Peak Vestical (Vapv)
Bwerage Paak (Vimg)
Average Peak Horizontal (Vmph)
Average Peak Viertical (Vimpv)

1'_?* Peak 1o Peak (Vpp)

i Paak 15 Paak Honzortal (Voph) |

Peak to Peak Vestical (Vpov)
Peak 1o Peak First Transiticn (vppf)

3. In the Lissajous view, click and hold the Phase measurement button, a contextual
menu will open.

4. From this menu, select the phase measurement method. It is recommended to use
Peak to Peak first transition (Vppf).

5. Place your cursor over the first notch indication which represents a transverse
indication.

6. From the transverse Lissajous view, look at the measured amplitude and phase of the
indication. You should move the cursor up and down in the C-Scan to look at the
different transverse channels and should notice an average value of amplitude and
phase. Note those average values for later.

T

™ Fisobai

n.owY 17.10

¥ Lol = IET=1v] I
DREDER T T

EEm

Amplitude = 3.08V

3,08V 10.5¢
P P P

Phase = 10.5°

Cursor placed over the “transverse” notch
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7. Place your cursor over the second notch indication which represents an axial indication
and repeat the previous step.

Amplitude = 2.18 V

o.ssv

ssv 20260
> Lmlw Jo]w] ]

Cursor placed over the “axial” notch

A

Calibration

@

In the Wizard ribbon, open the calibration step
9. Enter the amplitude and phase values that were noted at the previous steps in their
respective fields. Make sure to use the axial reference for the axial C-Scan and the
transverse reference for the transverse C-Scan. Also, it is recommended to use the
Peak to Peak measurement method for amplitude and Peak to Peak first transition for
phase.

Note that you can adjust the amplitude to a desired target value, it does not have to be exactly
the same as what was previously measured. However, it is recommended to enter an amplitude
value that is close to the initially measured value. If the desired target value is far from what
has been measured, it could be a good practice to adjust the voltage and/or gain accordingly
and repeat the previous steps. For the phase, it is recommended to use a number as close as
possible to what was previously noted to make sure that the lift-off keeps the right orientation.
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7+ Edit Setup Wizard *
6 Calibration

/ \ Configure parameters to calibrate C-scan amplitude and phase
-

[T Individually configure all the C-scans
[] Enable Auto Liftoff

Amplitude Phase
Mame Voltage (V) Reference Measurement Angle (%) Reference Measurement SG
SDDA 2.00 MNOTCH-AXIAL PP 150 MNOTCH-AXIAL PPF |
SDDT 3.00 MOTCH-TRANS PP 15.0 MOTCH-TRANS PPF |

56 : Single Gain and Phase

Calibration page

10. Click on Finish.

T
[ -3

11. From the Calibration ribbon, open the System Calibration menu ***" . This button will
open the following menu.

7% calibration X

) Cesean @
=

NOTCH-AXIAL
NOTCH-TRANS

Calibrate

12. Keeping this menu open, in the C-scan, place your cursor over the transverse
calibration notch signal. Make sure that the horizontal cursor is wide enough to
encompass completely the indication, but not too wide to avoid grabbing the lift-off
signal or other sources of noise near the indication.

13. Select the transverse calibration reference from the opened calibration menu, press

the green arrow
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14. In the C-scan, place your cursor on the axial calibration notch signal. Make sure that
the horizontal cursor is wide enough to encompass completely the indication, but not
too wide to avoid grabbing the lift-off signal or other sources of noise near the
indication.

15. Select the axial calibration reference from the opened calibration menu, press the

green arrow .
16. Click on Calibrate.

#| Calibration X
() C-scan

(@) C-scan and Sizing Curves

" NOTCH-AXIAL
" NOTCH-TRANS

Calibrate

Calibration window, 2 channels to calibrate

17. Perform a quick calibration check. Place the cursor over the indications to validate
that the measured amplitude and phase correspond to the parameters configured
previously. Your probe is calibrated.

Bl =1 = ]

™ Fistoats

Amplitude =2.00 V

Phase = 15°
Amplitude and phase
/ Measurement
2000 methods

| [ow [ w Jo]e]w]
7] ]
v

0.55V 205.9°
> Dm ] w[2]=]w] wr ] e )]

Transverse notch signal after calibration
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CALIBRATION OF IMPEDANCE ABSOLUTE CHANNELS

You should follow the same procedure as explained previously for the transmit-receive channels.
The only differences are that:

e Only the first pass over the notch is required since there is only one group of channels
and it is equally sensitive to all orientations.

e The menus will have only one reference signal, as shown below.

* Edit Setup Wizard X
6 Calibration

/ \ Confiqure calibrate C- litude and phase
.

[ Individually configure all the C-scans

Amplitude Phase

Name Voltage (V) Reference Measurement  Angle (%) Reference Measurement  5G

IMP 2.00 NOTCH PP 150 NQTCH PP O
[#¥ calibration s
() C-scan @
(@ C-scan and Sizing Curves

W NOTCH
SG: Single Gain and Phase | e ‘
| Ree |
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CALIBRATION WITH SINGLE GAIN AND PHASE

If no calibration plate with a long notch is available, it is therefore impossible to perform a full
calibration of your array probe. However, if a sample with a target defect is available, it remains
possible to perform a partial calibration using the Single Gain and Phase mode.

This type of calibration will not uniformize the response in amplitude and phase for all the
channels so there will remain variations from one channel to the others.

However, it will at least allow for an adjustment of the overall rotation and amplitude of the
signals so that target defects provide approximately the desired amplitude and phase.

To perform a Single Gain and Phase calibration, follow the same steps as for the full calibration
of the transmit-receive channels, but in the Calibration page of the Wizard make sure to check
the SG option (Single Gain and Phase) for all the groups.

#+ Edit Setup Wizard X
6 Calibration

/ \ Configure parameters to calibrate C-scan amplitude and phase
.

[] Individually configure all the C-scans
["] Enable Auto Liftoff

Amplitude Phase
MName Voltage (V) Reference Measurement Angle (7] Reference Measurement 5G
SDDA 2.00 MOTCH-AXIAL Pp 15.0 MOTCH-AXIAL PPF
sDoT 3.00 MNOTCH-TRANS PP 15.0 MOTCH-TRANS  PPF

5G: Single Gain and Phase
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ACQUISITION

The following steps suggest a standard acquisition workflow. In this case, a smooth stainless

steel weld will be scanned with an I-Flex probe.

1. If the filters have been disabled to perform the frequency selection and calibration,
]
Y

make sure to re-enable them by going In the Process menu Freess

Also, you can re-activate the encoder if desired. In the Scan menu *#" | set the

2.
Position from to Encoder.

3. Inthe Home ribbon, uncheck the Setup Mode "** .
In the Data tab on the left side of the front stage, add an Inspection file, by clicking on

4.
the green cross. If the Data tab is not available, go to the Layout ribbon and enable it

L_E_:I

by clicking on the Data button Pata

11 total, & acquired
) [X]
A

Adding an inspection data in the data list

"I the probe on a flawless section of the weld and start the acquisition.

5. Null
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the same axis

Scanning a weld with the I-Flex probe

6. During the scan, you should try to keep a constant pressure. Also, you should try to

keep the same index position (up-down) when scanning a constant feature such as a

weld, an edge, a radius, etc. This will generally provide better data quality.

Stop the acquisition.

8. Your data file is automatically saved in your Inspection file (if the Setup mode is
disabled and the Automatic File Recording option from the General Preferences section

in the backstage is enabled).

N

MAINTENANCE

e The probes are not watertight. Do not immerse in water, as this may cause the probes
to malfunction.

e To clean the probes, use a soft, humid cloth. Do not use harsh chemical cleaners, as it
may damage the probes.

e The probes must be used with adequate setup file.
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Sharck™ G2 Application Guide
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PROBE DESCRIPTION

BUTT WELD

1. Keypad (see section 1c) 5. Removable embedded encoder (see

. section O for cleanin
. Active area markers 9)

6. Wheels (see section O for cleaning)

Removable frame to clean fingers (see
section 0)

8. Fingers with TECA™ elements (22)

2
3. Scan direction
4. Strap attachment

Figure 45. Sharck-Butt Weld features
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FILLET WELD

1. Keypad (see section 0.) 7. Spring loaded embedded encoder

2. Active area markers 8. Wheels (see section O for cleaning)

3. Scan direction 9. Removable frame to clean fingers (see
4. Spring loaded side wheels section 0)

5. Side wheels adjustment buttons (see 10. Adjustable module fingers (6)

section 0 V) 11. Fixed module fingers (6)

6. Adjustable module screw

Figure 46. Sharck-Fillet Weld features
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KEYPAD

1. LED: Green LED turned on during an acquisition
(not functional on 1st generation of Ectane®)

2. Start/Stop an acquisition
3. Null the probe
4. Calibration wizard
5.

Magnifi)
KEY CHARACTERISTICS
Type of defect

Conformability
Coverage
Channels requirements

Minimum pipe OD

Detection capabilities

Sizing capabilities

Temperature

Maximum probe speed
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Save data (currently not functional on Reddy®,
but will be implemented in a future version of

Figure 47. Keypad features

Fatigue cracking
(axial and transverse to weld)

Conforms to weld
53 mm (2.1in)
64

25.4 mm (10 in) for circumferential scans
40.6 mm (16 in) for axial scans

Axial and transverse
From 3 x 0.5 mm (0.12 x 0.02 in)

Axial only

From 12.5 x 1 mm (0.5 x 0.04 in)
Up to 7 mm (0.28 in) deep

Up to 3 mm (0.12 in) Lift-off
100 deg C (212 F)

Up to 200 mm/s (7.9 in/s)



MATERIAL COMPATIBILITY

The User Mat calibration that will be discussed later in this User guide is mainly useful to
compensate for permeability changes which may occur during scans, either along a same part
being inspected or simply, between alloys having different properties. Permeability changes
affect signal amplitude for a given flaw, this is then the reason why there is a need to
compensate for it, assuring accurate depth sizing on each individual crack. The Sharck probes
were primarily designed for the assessment of surface breaking cracks in carbon steel material
and welds. Those can also be used to derivates to a certain extend.

Carbon steels (most of construction steels)

o Reliable detection.

o Reliable length and depth sizing.
Alloy steels

o Reliable detection

o Reliable length sizing but possible underestimation of depth sizing (specifically
Nickel based one).

Note: A dedicated sizing matrix, hence setup file can be produced for specific alloys
providing a sample with EDM notches is made available to Eddyfi.

High strength low alloy (HSLA) steel

o Reliable detection.
o Reliable length and depth sizing.

Note: Forged steels can be carbon steels, alloy steels or HSLA steels. Same
capabilities as mentioned above.
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MAGNIFI SETUP

Make sure to use Magnifi 4.4 or Magnifi GO 1.5 (or a more recent version).

Click Open setup % and select the setup corresponding to the probe in the Default
Master List.

Connect the 160-pin ECA probe connector to an Ectane or Reddy unit.

Connect the 18-pin encoder connector to the Ectane I/O connector or the 12-pin encoder
connector to the Reddy I/O connector.

r)
For Ectane only: connect & the instrument to Magnifi.
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DATA MANAGEMENT

This section suggests a convenient way to manage and save automatically large amounts of
data files during an inspection. The following steps can be done in advance in Magnifi (or
Magnifi GO), before getting to the inspection site.

In the backstage of Magnifi, in the Inspection menu, select a project folder and an

inspection folder G

In the Acquisition menu, select the Prefix filename option.

Click Create New List@.

Select the prefix for the data file list, the number of files in the list, the index for the first
data file and the index increment between each file. The example below shows a data file
list based on the following parameters:

Selected parameters: Resulting datafile list:
Prefix: TECA Prefix Index
Number of elements: 4 TECA 010
Element start number: 10 TECA 012
Element increment: 2 TECA 014

TECA 016
Click Create.

In the frontstage, in the Layout tab, make sure the Data button is checked. The data
file list will be displayed on the left side of the screen.

At the bottom of the data file list, click Acquisition preferences ['1"' , and check the

following two options:
Automatic file recording.
Automatic Next on Stop Acquisition.

When an acquisition is stopped, these two options allow to automatically save the data
file and select the next one in the list. The user can then start the next acquisition, without
any other action required.

Once the setup parameters and preferences are settled and the probe has been

£

calibrated (see section 4), uncheck Setup Mode & in the Home tab.

In the data file list, select the first file to be acquired. The inspection can then begin.
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A few more information about data management in Magnifi and Magnifi GO:

. The small icon beside each data file indicates its current state:
Icon Definition
7 The datafile was acquired and saved, but has not been analyzed
yet

The datafile was acquired, saved and analyzed, and it was
reported as being defect-free

The datafile was acquired, saved and analyzed, and defects
have been reported

The datafile has not been acquired yet (empty file)

]

The datafile is tagged for further review

For more information on data analysis, refer to section 7 of this user guide.

. At any time during the inspection, the user can click Add data (+] or Delete data

% | at the bottom of the datafile list. Datafiles added with this button wil keep
the same prefix, and their index will be incremented by the number selected in the

index menu [El. To create datafiles with a new prefix, go back to the backstage

and click Create New List.

o To re-scan a datafile that has already been acquired and saved, right-click on the
datafile (or hold the Reddy’s touchscreen) and click Re-scan. To choose whether the
original datafile should be kept or erased, select the corresponding option in

Acquisition preferences @|
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LAYOUT

1. Dp-Proc C-scan: Visualisation of axial cracks with material permeability and lift-off
compensations. Each horizontal line corresponds to a channel of the probe.

=  Used to localize axial cracks indications, in combination with Lg C-scan.

2. Dp-Raw Lissajous: Raw impedance signal of the channels underneath the cursor in the
Dp-Proc.

=  Used for depth measurement of axial cracks.

3. Lg C-scan: Visualisation of axial cracks ends.

=  Used to localize axial crack indications quickly, in combination with Dp-Proc C-scan,
and size the cracks length.

4.  Lg Lissajous: Signal of the channels underneath the cursor in the Lg C-scan.
5. Tr Strip chart: Superimposed strip charts of the transverse channels.

=  Used to detect transverse crack.

6.  Compensated Depth: Depth measurement of the axial crack, up to 7 mm (0.28 in), with
compensation for lift-off and permeability.

7. Length: Length measurement of the axial crack.

8. Lift-off: Local lift-off measurement, up to 3 mm (0.12 in).

o-Proc =1 1] [] L] oeren ] 1 1000V ,

1.53V 130.0°

e S Y EE D [or ] o,

- =[] [ w ] [t oor Tt tooov,
ool o5l 050 oo o - g

=1 — : :

40 v //

b @ | ] ' s

rzu

-8

, v

g .

5.26V 134.1°

«
[ ) 1 ooov [1] Cﬂmpen(?na':‘e)d Depth Length (mm) Liftoff (mm)

(5)
— - —~ S 2.3 11. 0.0
0

Figure 48. Sharck BW / FW acquisition and analysis layout

Note: To change the settings of any of these windows or to access the Transverse C-
Scan, select it and go to the Current View tab.
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PROBE CALIBRATION

CALIBRATION FROM THE SHARCK MENU

The following calibration should be performed before beginning a new inspection:

)] Place the probe in the air, away from any metallic surface, then click Null @

1)) In the Sharck menu, click Calibration 8 .

[ll) Keep the probe in the air and click [ Airreference block |,

IV)  Put the probe in the middle of the aluminum plate supplied for calibration purposes and
apply pressure to ensure that all wheels are in close contact with the surface, then click

Aluminum

Notel: For the Fillet Weld probe, make sure that the adjustable module is set flat.

NoteZ2: Ensure the Aluminium plate is placed away from any conductive material prior
to performing the calibration.

Figure 49. Sharck probes on aluminium plate

V)  Place the probe on the weld to be inspected.

Note: For the Fillet Weld probe, ensure the adjustable module is set correctly to the
weld cap under assessment.

VI) Click [ CaonSteel | 5nd move the probe along the weld.

V“) C|IC|<[ Calibrate l

VIlIl) Close the Sharck calibration window.
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Figure 50. Sharck probes on carbon steel weld

CALIBRATION FROM THE PROBE KEYPAD

It is also possible to calibrate the probe using the calibration button £ on the probe’s keypad.
The overall process does not change; only the clicking operations change:

1)

Il
1

Place the probe in the air, away from any metallic surface, then press the Null button '@'
on the probe.

—
1
———

Press the calibration button on the probe.

Put the probe in the middle of the aluminum plate (supplied for calibration purposes) and
apply pressure to ensure that all wheels are in close contact with the surface, then press

—
(101
———

the calibration button on the probe.
Place the probe on the weld to be inspected.

Press the calibration button 2= on the probe and move the probe along the weld.

Press the calibration button &=L on the probe to calibrate the probe.

Press any button on the probe to close the calibration window.
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ACQUISITION

BUTT WELD

) Null the probe in the air.

II)  Place the probe on the weld. Use the marker lines on top of the probe to center it on the
weld, and the marker line on the cable side of the probe to align the x=0 position with the
beginning of the area to scan.

Figure 51. Scan position x=0 aligned with the marker line on the probe side

[lI)  Start the acquisition.

IV)  Acquire data by moving the probe along the weld following the direction indicated by the
arrow on the top of the probe.

V)  Stop the acquisition.
Notel: The total scan length can be changed in Setup = Scan.

Note2: Always Null the probe before performing an acquisition.

FILLET WELD

) Null the probe in the air.
IIl)  Set the angle of the adjustable module (This can be done before step I).

[lI)  Place the guiding wheels on the edge of the weld, near the bottom toe.
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Figure 52. Probe guiding wheels leaning against weld toe

IV)  Press the side wheel adjustment buttons.

Figure 53. Pressing the side wheel adjustment buttons will trigger the mechanism

V)  Align the marker line on the probe with the beginning of the area to scan.

Figure 54. Scan position X=0 aligned with the marker line on the fillet weld probe

VI)  Start the acquisition.
VIl) Acquire data by moving the probe along the weld.

VIIl) Stop the acquisition.
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Note: To perform a full inspection, a second pass is carried out on the wall by turning
the probe and carrying out steps | to VIl again.

ANALYSIS

The analysis is performed in three simple steps: user material calibration, detection and sizing.

Note: The Sharck BW and FW probes are designed to detect both axial and transverse
cracks but only axial ones can be sized. Transverse cracking would need to the
scanned axially to be fully assessed.

USER MATERIAL CALIBRATION

To compensate for the magnetic permeability of the inspected material, a "user material
calibration" should always be performed before analyzing data. This will help with the detection
of defects and will ensure the accuracy of the depth sizing.

) Open the C-scan cursor as large as possible in the middle of the C-scan. To compensate
properly, it is very important that every channel contains more data from clean material
than from apparent defects within the width of the horizontal cursor (see Figure 56).

Il)  On the Dp-Raw Lissajous, verify that you are on a real channel and not an interpolated
channel. If you are on an interpolated channel, move the cursor up and down until the
channel name appear on the screen.

F1Dp17

1.67V 128.7°

[]

£.0 mm
A BT

—& 2.0 mm

1.535V 127.6°

Figure 55. Identification of a real channel. On top, the channel F1IDp07. Below, an interpolated
channel, identified as “-"
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1) Inthe Sharck menu, click the Ag UserMaterial button.

J8 IS IS

Figure 56. Top: Good user material calibration, with the C-scan cursor widely opened; Middle:
Good user material calibration, cursor contains only one specific crack, but opened wide enough
(at least three times the length of the crack) providing a local averaging; Bottom: Bad user
material calibration, cursor too closed around the crack signal. The user material is not well
measured because there is not enough safe material information in it, averaging mostly
calculated on the crack signal.

DETECTION OF AXIAL CRACKS

The detection of axial cracks must be done with both Dp-Proc and Lg C-scans. The Dp-Proc C-
scan detect a crack along its entire length, while the Lg C-scan shows its ends.

An indication is considered as an axial crack when it presents these criteria:
o Positive vertical signal (yellow/orange/red) in the Dp-Proc C-scan.

o Blue and red dots in the Lg C-scan. Note that the blue dot is always to the left (first
end) of the red dot (last end). If the red dot is to the left of the blue dot, it is not an
axial crack (can be linked to a transverse crack or a geometrical indication).

° Correlation between the two C-scans: The blue and red dots must be at the
beginning and end of the yellow/orange/red signal.
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Figure 57. Detection of axial cracks. 3 cracks detected in this example (2 deep and 1 shallow)

On the DP-Proc C-scan, the green color represents the base material (amplitude close to 0.00
V). Crack-like defects are associated to a positive signal that is proportional to their depth
(increasing order of crack depth: yellow, orange, bright red, dark red).

The color palette is a visual threshold directly related to the depth of the cracks. To enhance
the contrast of the cracks, the color scale can be lowered manually. However, this will also
enhance the noise caused by permeability variations, weld geometry, or other surface
conditions.

Fesal

: Color scale: #2.50 V

Figure 58. Same cracks displayed with 2 different color scales in Dp-Proc C-scan

In previous version of Magnifi the Lg C-scan is not compensated for lift-off. When lift-off is
detected, it is recommended to reduce the scale of Lg C-scan color palette to help with the
detection.

424 |Page



Fi0
o

E 'E“ .
—— I ., il Pl
=== % I
£ E—
Fi0

- |

§ [ “ ] ‘- .
o
i . d AL 8 i WAl EE O TALF O THEE S TR R

Figure 59. Same cracks displayed with 2 different color scales in Lg C-scan
DEPTH SIZING AND REPORTING OF AXIAL CRACKS

Sizing information

During the analysis of a data file, the sizing of axials cracks is shown in the lower right corner of
the screen. This information is updated in real time as the cursor is moved in the C-scan views.

T Josov
2 ]| e
526V 134.1°
—— ' i 190 / i ¥ (3 i, 5 4
, - ‘ ; » e = IZ[F V]
PR 000V Compensated Depth Length (mm) Liftoff (mm)
(mm)
< ‘ 23 | 11.3 | 0.0

Figure 60. Magnifi automatically maximise the cursor position and measure the depth of crack.

Sometimes, there could be several blue and

red dots closed to each other. The black ' '
arrows on both Dp-Proc and Lg C-scans F“—]
show which blue and red dots are used for

the crack length sizing. This can be adjusted
if necessary by the user. Figure 61. Length arrows on the Lg C-scan
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Local user material calibration:

To improve the depth sizing of an axial crack, it is recommended to perform a local user material
adjustement (close to the indication) before reporting it.

) Click close to the crack in the Dp-Proc or Lg C-scan to center the cursors on the crack.

[I)  Open the cursors around three times the length of the defect.

i i i " .
E ] i

o jhon

Figure 62. Step Position and size of the cursors on a potential axial crack

)  Verify that the user material calibration has been done properly around the defect (see
Figure 63).

Figure 63. Correct and incorrect user material calibration

Note: When correctly applied the background of the Dp-proc C-scan is green around
the defect, and the dashed line in the Lissajous is close to the horizontal centreline.
When not applied correctly, two yellows stripes are seen around the crack signal, and
the dashed line in the Lissajous is far from the horizontal centreline.

IV) If the user material calibration is not correct, perform a local material calibration by

clicking the Ag UserMaterial pbutton without moving the cursors.
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Precision sizing and entry report

CRK | scc

a

[) Use the indication code buttons in the lower right corner of the Lissajous
window (for example “CRK"” or “SCC") to add the automatic analysis
tool inside the region of interest. If the option “Take a screenshot with report entry” is
checked in the backstage, a screenshot will be taken at this point.

[-] .] oeraw ] [t 1000v ]

F1Dp17

Indication buttons

1.78V 128.6° \

EEYEED [ carc | 1oec |

Figure 64. Add indication buttons. The indication code of the button can be changed by
clicking the small arrow at the lower right corner of the button

In the backstage of Magnifi, make sure the selected Table Profile in the Report options is Sharck
Array. With this option, the report will include the measured depth, position and local lift-off.
This will trigger two events (if the “Defect Tuning” =5 option is selected):

Data within the cursors are scanned and the cursors get centered over the indication

giving the deepest sizing.

Figure 65. Cursor positioning prior to (top) and after (bottom) clicking the indication button

The TECA Tune Calculations window opens.
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B TeCA Tune Caleulations a M

Baseline Level 005V -
Indication Start  60.0 mm -
Indication End ~ £9.5 mm -

[Add Entr}rl[ Cancel ]

Figure 66. TECA Tune Calculations window

)  In most cases, the automatic process will give the optimized results, so no adjustment is
needed in the TECA Tune Calculations windows. However, in the rare cases that the
automatic process is not optimal, this window gives the user the choice to adjust some
parameters, making sure the sizing is accurate. If such a case happens, the user can
manually adjust:

i) The baseline level, if it seems incorrect on the Lissajous. This can occur if there is a
lot of background noise or if there is a rapid change of material properties near the
crack or if the cursors are set too tight around the crack signal.

4.0 mm_—" i i
8.0 mm_— 4.0 mm_—

Too high

N\

Figure 67. Baseline level (dashed line). Set too high (1), too low (2), or correctly (3)

if)  The start and/or end of a crack. The start/stop position might not be correct for
intermittent cracking but also cracking occurring at the edge of the scan. The gray
arrows on the C-scans will move as these parameters are adjusted (Figure 61).

[) Click “Add Entry” to add the analyzed indication in the report or click “Cancel” to close the
TECA Tune Calculations windows without adding the indication to the report.

Y

Mo Defect

Notel: If a datafile contains no defect indication, you can click

Note2: To add or remove indication codes, go to Setup = Indication.

DETECTION OF TRANSVERSE CRACKS

The detection of transverse crack can rapidly be done using the TR strip chart, at the bottom
of the default layout. Note that the TR strip chart is not compensated for the lift-off. If lift-off
is detected, it is recommended to reduce the scale of the strip chart to avoid missing a defect.
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Figure 68. Detection of transverse cracks (four in this example)

If you wish to see the approximated length of a transverse crack and its position, select the TR

C-scan.

o5 37150

W] w [B]F ] [or [ ]

FL-— Bl 1T =1
—" = 5
el
0.14Y 10647
= = v [ w Jo =] n e | e,
j L BRI Compenzated Depth Length {mm) Liftalf (mm}

0.0 6.8 0.0

Figure 69. Transverse cracks visible on TR C-scan

If a transverse crack is detected an additional scan along the defect will be necessary (if the

geometry enables it) to obtain sizing information.
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MAINTENANCE

PROTECTION FROM ABRASIVE SURFACES

If the component to be inspected is abrasive or rough, it is recommended to protect the probe
with a tape (polyolefin, Teflon or other non-conductive abrasion resistant material). If the
sample has a flat surface, the tape can be put directly on the probe fingers. The lift-off
compensation will ensure a good measurement even if not all fingers are in contact with the
surface, as long as the lift-off is 3 mm (0.12 in) at most.

Figure 70. Protective tape applied on probe active area

If the weld cap is too high, causing a lift-off superior to 3 mm (0.12 in), it is best to put it on the
sample, to allow the probe sensors to be in contact with the surface.

Figure 71. Protective tape applied directly on weld
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BUTT WELD PROBE MAINTENANCE

When used on dirty surfaces, dust can accumulate on the encoder wheel and between the
fingers. To clean the encoder, unscrew it with a small flathead screwdriver from the probe
housing and clean it with a soft cloth or air spray. To clean the fingers, disassemble the
removable frame to loosen the fingers and remove the dust between them with a soft cloth or
air spray. Make sure to reassemble all the parts prior to carrying out further inspection.

Figure 72. The encoder and the removable Figure 73. With the 1st frame removed, the
frame can be dismantled to clean the fingers are looser and can therefore be
probe. Supporting wheels can also be separated for an easy cleaning

remove if necessary

FILLET WELD PROBE MAINTENANCE

To clean the fingers of the fillet weld probe, follow the same procedure as the one for the butt
weld probe. Since the encoder is spring-loaded, it is not possible to remove it from the probe

housing.

© - < ¢ - £ Y
Figure 74. Both modules have a removable Figure 75. Guiding and supporting wheels
frame to help the fingers cleaning can also be unscrewed if it is necessary to
clean them
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ENCODER CALIBRATION

If the encoder resolution included in the Magnifi setup is different from its real resolution, the
data in the C-scan will be slightly distorted (misalignment of indications and zigzag shapes, see
Figure 76 below). The length measurement and defect positioning can be affected.

In such a case, a simple calibration can be performed to apply a correction factor to the encoder
resolution:

Start an acquisition.
Move the probe in a straight line and on a flat surface and stop the acquisition.

Notel: A longer travel distance will lead to a more precise calibration.
Note2: It is not required to scan a metallic surface for this calibration.

Measure precisely the traveled distance.

A

In the Calibration menu, click on the Encoder % calibration button.
Enter the measured traveled distance and click Enter.

Click Calibrate and click OK. The correction factor is now applied to the setup
configuration.

Zigzag shapes due to wrong
encoder resolution

Figure 76. a) Before encoder calibration (small error on the encoder’s resolution); b) after
encoder calibration
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Sharck™ Pencil G2 Application
Guide
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PROBE DESCRIPTION

Figure 77 : Sharck Pencil G2 models. Straight (ST) (left), Right Angle (RA) (middle), and Toothbrush
(TB) (right).

MATERIAL COMPATIBILITY

The User Mat calibration that will be discussed later in this User guide is mainly useful to
compensate for permeability changes which may occur during scans, either along a same part
being inspected or simply, between alloys having different properties. Permeability changes
affect signal amplitude for a given flaw, this is then the reason why there is a need to
compensate for it, assuring accurate depth sizing on each individual crack. The Sharck probes
were primarily designed for the assessment of surface breaking cracks in carbon steel material
and welds. Those can also be used to derivates to a certain extend.

Carbon steels (most of construction steels)

o Reliable detection.
o Reliable depth sizing.
Alloy steels
o Reliable detection
o Possible underestimation of depth sizing (specifically Nickel based one).

Note: A dedicated sizing matrix, hence setup file can be produced for specific alloys
providing a sample with EDM notches is made available to Eddyfi.

High strength low alloy (HSLA) steel

J Reliable detection.
J Reliable depth sizing.

Note: Forged steels can be carbon steels, alloy steels or HSLA steels. Same
capabilities as mentioned above.
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SETUP

[) Make sure to use Magnifi® 4.3 or Magnifi® GO 1.4 (or a more recent version).

II) Click Open setup 16 and select the setup corresponding to the probe in the Default Master
List.

[l1) Connect the pencil probe to the Ectane® 41-pin connector or to the Reddy® 19-pin connector.

7,
IV) For Ectane®only: connect ¥ the instrument to Magnifi®.

DATA MANAGEMENT

This section suggests a convenient way to manage and save automatically large amounts of
data files during an inspection. The following steps can be done in advance in Magnifi (or
Magnifi GO), before getting to the inspection site.

In the backstage of Magnifi, in the Inspection menu, select a project folder and an
inspection folder .(.) .

In the Acquisition menu, select the Prefix filename option.

Click Create New List l—_zo\

Select the prefix for the data file list, the number of files in the list, the index for the first
data file and the index increment between each file. The example below shows an example
of data file list based on the following parameters:

Resulting data file list
Selected parameters: )

Prefix: TECA Prefix Index
Number of elements: 4 TECA 010
Element start number: 10 TECA 012
Element increment: 2 TECA 014
TECA 016
Click Create

In the frontstage, in the Layout tab, make sure the Data button is checked. The data file
list will be displayed on the left side of the screen.

At the bottom of the data file list, click Acquisition preferences , and check the
following two options:

Automatic file recording
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Automatic Next on Stop Acquisition

When an acquisition is stopped, these two options allow to automatically save the data file
and select the next one in the list. The user can then start the next acquisition, without any
other action required.

Once the setup parameters and preferences are settled and the probe has been calibrated

(see section 4), uncheck Setup Mode G in the Home tab.
In the data file list, select the first file to be acquired. The inspection can then begin.
A few more information about data management in Magnifi and Magnifi GO:

e The small icon beside each data file indicates its current state:

Icon Definition
v The data file was acquired and saved, but has not been analyzed
yet
- The data file was acquired, saved and analyzed, and it was

reported as being defect-free

The data file was acquired, saved and analyzed, and defects
have been reported

The data file has not been acquired yet (empty file)

8 v O

% @ | The data file is tagged for further review

For more information on data analysis, refer to section 0 of this user guide.

e At any time during the inspection, the user can click Add data [+ or Delete data (%]
at the bottom of the data file list. Data files added with this button will keep the same
prefix, and their index will be incremented by the number selected in the index menu

EL To create data files with a new prefix, go back to the backstage and click Create
New List.

e Tore-scan adata file that has already been acquired and saved, right-click the data file
(or hold the Reddy’s touchscreen) and click Re-scan. To choose whether the original
data file should be kept or erased, select the corresponding option in Acquisition

preferences [z|
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LAYOUT

1. Dp-Proc strip chart: Visualisation of axial cracks with material permeability and lift-off
compensations.

o Used to localize axial cracks indications quickly, in combination with Lg strip chart
2. Lg strip chart: Visualisation of axial cracks ends

o Used to localize axial crack indications quickly, in combination with Dp-Proc strip
chart, and size the axial cracks length

3. Dp-Raw Lissajous: Raw impedance signal within the cursor of the strip charts.
o Used for depth measurement of axial cracks

4. Compensated Depth: Depth measurement of the axial crack, up to 7 mm, with
compensation for lift-off and permeability.

5. Length: Length approximation of the axial crack

o The length approximation is based on the manual scan speed. To be accurate, the
scan must be done at exactly 50 mm/s.

6. Lift-off: Local lift-off measurement, up to 4 mm

Lg Lissajous: Signal of the Lg channel within the cursors of the strip chart.

e ean ‘

© @ SHARCK BW053-G2.001 ]

RPN il A O G

Figure 78 : Acquisition and analysis layout
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PROBE CALIBRATION

[) Place the probe in the air, away from any metallic surface, then click on Null 0

I) In the Sharck menu, click Calibration LR

[ll) Keeping the probe in the air, click on | Airreference block |

IV) Put the probe in the middle of the aluminum plate supplied for calibration purposes

Notel: Place the probe in the center of the Aluminium plate with the tip flat on the
surface

NoteZ2: Ensure the Aluminium plate is placed away from any conductive material prior
to performing the calibration.

V) Click on | Aluminum |

T TN L9V

Figure 79: Sharck pencil probe on the aluminum plate

VI) Place the probe on the material to be inspected.

VII) Click on [ Cabonsteel .| gnd move the probe on the material.

Note: During this calibration step, keep the probe flat on the surface, in the HAZ.

VIIl) Click on L Caliorte |

IX) Close the Sharck calibration window.
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ACQUISITION

[) Null the probe in the air.

II) Place the probe on the weld.

Figure 80 : Probe tip position on the weld. Flat on in the HAZ (left), with an angle on the toe (center),
and flat of the top of the Weld (r|ght)

[ll) Start the acquisition.

IV) Scan the weld with the probe so that the long side of the tip of the probe is parallel to the
weld, in the direction of the arrow featured on the pencil’s casing.

Note: Scanning speed should be approximately 50 mm/sec (2 in/sec)

Note: It is recommended to do two scans on the toe. The first scan with the tip flat on
the surface, in the HAZ, leaning on the toe of the weld. The second scan with the tip
at mid-angle between the weld and the HAZ.

V) Stop the acquisition

Notel: Always Null the probe before performing an acquisition.

Note2: To detect transverse cracks on the top of the weld turn the probe 90°

Figure 81 : Probe tip position for the detection of transverse cracks.
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ANALYSIS

The analysis is performed in three simple steps: user material calibration, detection, and sizing.
USER MATERIAL CALIBRATION

To compensate for the magnetic permeability of the inspected material, a "global user material
calibration" should always be performed before analyzing data, to help with the detection of
defects. A "local user material calibration" will ensure the accuracy of the depth sizing (see
section 0).

[) For a global calibration, open the strip chart cursor as large as possible in the middle of the
Dp-Proc strip chart. To compensate properly, it is very important that the signal within the
cursors contains more data from clean material than from apparent defects or lift-off.

1) In the Sharck menu, click the /g UserMaterial button.
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Figure 82 : Top: Good user material calibration, with the C-scan cursor widely opened; Middle: Good
user material calibration, cursor contains only one specific crack, but opened wide enough (at least
three times the length of the crack) providing a local averaging; Bottom: Bad user material calibration,
cursor too closed around the crack signal. The user material is not well measured because there is not
enough safe material information in it, averaging mostly calculated on the crack signal.

DETECTION OF AXIAL CRACKS

The detection of axial cracks is made using both the Dp-Proc and the Lg strip charts. The Dp-
Proc strip chart shows the depth of the crack, while the Lg strip chart shows its beginning and
end. To be certain that an axial crack is present, it must meet these criteria:

- Positive peak in the Dp-Proc strip chart.
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Negative and positive peaks in the Lg strip chart. Note that the negative peak is always
to the left of the positive peak. If the positive peak is to the left of the negative peak, it
is not an axial crack (can be linked to a transverse crack or a geometrical indication).

Correlation between the two strip charts : The negative and positive peaks in the Lg strip
chart must be at the beginning and end of the positive peak in the Dp-Proc strip chart

: o [ )
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Figure 83: Detection of axial cracks. The ends of the crack are correlated on both strip charts.

DEPTH SIZING AND REPORTING OF AXIAL CRACKS

SIZING INFORMATION

During the analysis of a data file, the sizing of axials cracks is shown between the two Lissajous.
This information is updated in real time as the cursor is moved in the strip charts.

Compensated Depth Length {(mm) Liftoff |
(mm)

4.4 11.3 01

Figure 84 : Example of sizing information displayed in the infodields. In this example, the
compensated depth of the crack is 4.4 mm, the length is 11.3 mm and the lift-off is 0.1
mm.

LOCAL USER MATERIAL CALIBRATION

To improve the depth sizing of an axial crack, it is recommended to perform a local user material
adjustement (on or close to the indication) before reporting it.

[II) Click on the crack in the Dp-Proc or Lg strip chart to center the cursors on the crack.
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IV) Open the cursors to at about three times the length of the defect.
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Figure 85 : Position and size of the cursors on a potential axial crack

V) Verify that the user material calibration has been done properly around the defect.

200k

M ——

200k

Figure 86 : Good vs bad user material calibration. On the top (good calibration), the dashed line in the
Lissajous is near the horizontal null mark line. On the right (bad calibration), the dashed line in the
Lissajous is far from the horizontal null mark line.

V1) If the user material calibration is not correct, perform a local material calibration by clicking
the g UserMaterial button without moving the cursors.

PRECISION SIZING AND ENTRY REPORT

VIl) Click on one of the indication buttons in the lower right corner of the Lissajous (“CAPC”
written in red in Figure 87). This will open the TECA Tune Calculations window (Figure 88)
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Figure 87: Indication buttons in the Lissajous window

TECA Tune Calculations ﬂ

N

e

Baseline Level -0.04V -

[Add Entr}f” Cancel l

Figure 88: TECA Tune Calculations window

VIIl) In most cases, the automatic process will give the optimized results, so no adjustment is
needed in the TECA Tune Calculations windows. However, in the rare cases that the
automatic process is not optimal, this window gives the user the choice to adjust some
parameters, making sure the sizing is accurate. If the baseline seems incorrect on the
Lissajous, the user can manually adjusts it. This can occurs if there is a lot of background
noise or if there is a rapid change of material properties near the crack or if the cursors are
set too tight around the crack signal.

4.0 mm— 6.0 mm _— 4.0 mm_— m— 4.0mm —

Too high Correct

Too low

Figure 89 : The baseline level (dashed line). It can be too high (left), too low (middle), or spot on
(right).

IX) Click on “Add Entry” to add the analyzed indication in the report or click on “Cancel” to close
the TECA Tune Calculations windows without adding indication to the report.

v

Mo Defect

Notel: If a datafile contains no defect indication, you can click
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Note2: To add or remove indication codes, go to Setup =2 Indication.

MAINTENANCE

If the component to be inspected is abrasive or rough, it is recommended to protect the probe
with a tape (polyolefin, Teflon or other non-conductive abrasion resistant material). However,
make sure to remove the tape before a full calibration (section 0)
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Sharck-HR Application Guide

445|Page



PROBE DESCRIPTION

SHARCK HR

1. Scan direction

Buttons for curvature adjustment

Paired encoded wheels

Flexible shoe with protective 0.125 mm (4.9 thou) polyolefin tape

Beginning of coverage mark (Y = 0.0 mm (0.0 in))

o oA LN

End of coverage mark (Y =71.2 mm (2.80 in))

Figure 90. Sharck HR features
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KEY CHARACTERISTICS

Type of defect

Conformability

Coverage
Channels requirements

Resolution

Detection capabilities

Sizing capabilities

Temperature

Maximum probe speed

Short and shallow cracking
(longitudinal to scan axis)

Conforms to curvature
From 254 mm (10 in)

71 mm (2.8 in)
64

T1to 2 mm (0.04 to 0.08 in) axially
3 mm (0.12 in) circumferentially

Axial only
From 1.5 x 0.25 mm (0.06 x 0.01in)

Axial only

From 6 x 0.25 mm (0.06 x 0.011in)
Up to 3 mm (0.12 in) deep

Up to 2 mm (0.08 in) Lift-off

100 degC (212 F)

Up to 600 mm/s (24 in/s)

447 |Page



MATERIAL COMPATIBILITY

The User Mat calibration that will be discussed later in this User guide is mainly useful to
compensate for permeability changes which may occur during scans, either along a same part
being inspected or simply, between alloys having different properties. Permeability changes
affect signal amplitude for a given flaw, this is then the reason why there is a need to
compensate for it, assuring accurate depth sizing on each individual crack. The Sharck HR probe
was primarily designed for the assessment of surface breaking cracks in alloy steels.

Alloy steels

° Reliable detection.
o Reliable length and depth sizing.
Note: It can currently be used on Grade B, X42, X46, X52, X56 and X60.

MAGNIFI SETUP

I) Make sure to use Magnifi 4.4 or Magnifi GO 1.5 (or a more recent version).

II) If the probe is being used for the first time, click Open setup % and select the file
SHARCK-HR-1048-071 from the Default Master List.

[ll)  Connect the 160-pin ECA probe connector to an Ectane® or Reddy®.

IV)  Connect the 18-pin encoder to the Ectane I/O connector, or the 12-pin encoder to the
Reddy I/O connector.

7,
V)  For Ectaneonly: connect the instrument to Magnifi 3

448 | Page



DATA MANAGEMENT

This section suggests a convenient way to manage and save automatically large amounts of
datafiles during an inspection. The following steps can be done in advance in Magnifi (or Magnifi

GO), before getting to the inspection site.

X)  In the backstage of Magnifi, in the Inspection menu, select a project folder and an
inspection folder L3

Xl)  Inthe Acquisition menu, select the Prefix filename option.

XIl) Click Create New List.

XII) Select the prefix for the datafile list, the number of files in the list, the index for the first
datafile and the index increment between each file. The example below shows an example
of datafile list based on the following parameters:

Selected parameters: Resulting datafile list:
Prefix: SCC Prefix Index
Number of elements: 4 SCC 010
Element start number: 10 SCC 012
Element increment: 2 SCC 014

ScC 016

XIV) Click Create

XV) Inthe frontstage, in the Layout menu, make sure the Data button is checked. The datafile
list will be displayed on the left side of the screen.

XVI) At the bottom of the datafile list, click Acquisition preferences [i!" , and check the
following two options:

i) Automatic file recording

ii)  Automatic Next on Stop Acquisition

When an acquisition is stopped, these two options allow to automatically save the datafile
and select the next one in the list. The user can then start the next acquisition, without
any other action required.

XVIl) Once the setup parameters and preferences are settled and the probe has been calibrated

o
(see section 4), uncheck Setup Mode i in the Home menu.
XVII) In the datafile list, select the first file to be acquired. The inspection can then begin.

449 |Page



A few more information about data management in Magnifi and Magnifi GO:

. The small icon beside each datafile indicates its current state:
Icon Definition
7 The datafile was acquired and saved, but has not been analyzed
yet

The datafile was acquired, saved and analyzed, and it was
reported as being defect-free

The datafile was acquired, saved and analyzed, and defects
have been reported

The datafile has not been acquired yet (empty file)

]

The datafile is tagged for further review

For more information on data analysis, refer to section 7 of this user guide.

. At any time during the inspection, the user can click Add data (+] or Delete data

% | at the bottom of the datafile list. Datafiles added with this button wil keep
the same prefix, and their index will be incremented by the number selected in the

index menu [El. To create datafiles with a new prefix, go back to the backstage

and click Create New List.

o To re-scan a datafile that has already been acquired and saved, right-click on the
datafile (or hold the Reddy’s touchscreen) and click Re-scan. To choose whether the
original datafile should be kept or erased, select the corresponding option in

Acquisition preferences @|
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LAYOUT

1. Processed C-Scan: Visualization of the cracks with material permeability and lift-off
compensations. Each horizontal line corresponds to a channel of the probe

=  Used to localize crack indications quickly

2. Processed strip chart: Superimposed strip charts, each of them representing 1 of the
probe’s 64 channels

= Used to display the profile of the cracks, measure their length and localize the
strongest indications (deepest cracks)

3. Lissajous window: Raw impedance signal of the channels underneath the cursor in the C-
scan

=  Used for depth measurement of axial cracks.

4.  Compensated depth: Depth measurement of axial cracks, up to 3 mm (0.12 in), with
compensation for lift-off and permeability

5. Lift-off: Local lift-off measurement, up to 2 mm (0.08 in)
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Figure 91. Sharck HR acquisition and analysis layout

Note: To change the settings of any of these windows, select it and go to the Current
View menu.
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PROBE CALIBRATION

The following calibration should be performed before beginning a new inspection:

[) Hold the probe in the air, and press on the 2 buttons for curvature adjustment to make sure
the flexible shoe is completely flattened.

Il

lll) In the Sharck menu, click Calibration

V)
V)

V)

Vil

Vil

Hold the probe in the air, away from any metallic surface, and click Null 03

—
([
—

Keep the probe in the air and click | Air reference block |

Put the probe in the middle of the aluminum plate supplied with the probe and apply
pressure to ensure that all four wheels are in close contact with the surface. Click

[ Aluminum ]

Press the 2 side buttons to lock the spring-load mechanism. Then, hold the probe on the
pipe’s surface by applying a very light pressure on it. This will curve the shoe to the OD of
the pipe.

Release the buttons. If the mechanism seems to block, try the last step again by applying
a lighter pressure on the probe. Make sure the shoe is now curved correctly.

Put the probe on the carbon steel surface and apply pressure to ensure that all four wheels
Carbon Steel

are in close contact with the surface. Click

Click [ Calibrate l

Close the Sharck calibration window.

Figure 92. The three probe calibration steps
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[) Use the buttons on the probe to adjust the curvature of the flexible shoe according to the
surface to inspect (see steps VI and VIl in section 6).

IIl)  Null the probe in air.

[ll)  Align the front surface of the probe with the beginning of the area to scan.

Figure 93. Scan position x=0 aligned with the front of the probe

IV)  Start the acquisition.

V)  Move the probe in the direction indicated by the arrow on the casing. Apply enough
pressure on the probe during the acquisition to make sure that all wheels are rolling at all
time. Data acquisition will be disabled if the encoded wheels are not rolling.

VI)  Stop the acquisition.

Note: The total scan length can be changed in Setup =2 Scan.

453 |Page



ANALYSIS

The analysis is performed in three simple steps: user material calibration, detection and sizing.

Note: The Sharck HR is designed specifically to detect and measure the depth of
cracks oriented along the axis of the pipe. Other crack orientations can be detected,
but the accuracy of their depth measurement will not be accurate.

USER MATERIAL CALIBRATION

To compensate for the magnetic permeability of the inspected material, a “user material
calibration” should always be performed before analyzing data. This will help with the detection
of defects and with the accuracy of the depth sizing.

Note: If a C-scan contains multiple SCC colonies, a user material calibration should
be performed locally for each colony, in order to always compensate for the local
permeability.

[) Place the C-scan cursor on a “clean” area of the C-scan (i.e. area without any SCC,
corrosion or major permeability variations). Open the horizontal cursor in a way to include
only clean material on all 64 channels of the C-scan. If possible, this clean area should be
located near the SCC indications to analyze.

Alternatively, place the cursor directly on the SCC indications to analyze, and extend the
width of the cursor to include clean material on both sides of the SCC.

The data points inside the horizontal cursor will be used to evaluate the material
permeability on every individual channel. To compensate properly, it is very important
that every channel contains more data from clean material than from SCC within the
width of the horizontal cursor.

Figure 56 on next page shows a few examples of correct and incorrect C-scan cursor
positioning for the user material calibration.

&
A"
UserMaterial

1)) In the Sharck menu, click on
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Figure 94. Top: Good user material calibration, with the C-scan cursor located in a clean,
defect-free area directly besides a SCC colony; Middle: Good user material calibration, with the
cursor located on the SCC colony, and opened wide enough to include more clean material than
SCC indications on all channels; Bottom: Bad user material calibration. The top half of the C-
scan is calibrated correctly because the area within the width of the horizontal cursor is mostly
clean, but the bottom half of the C-scan contains mostly SCC indications within this width. The
white color in these channels is an indication of a bad user material calibration.

In the rare situations where SCC indications cover most of the C-scan, it may be impossible to
place the cursor in a way to have clean material on all channels. Figure 95 on next page shows
an example of such a situation.

In these cases, the ideal solution is to re-scan the area, this time including clean material before
or after the SCC colonies. If re-scanning is not possible, the other alternative is to perform
multiple partial user material calibrations:

[lI)  Adjust the vertical cursor to cover only the channels on which to perform the partial user
material calibration. Adjust the horizontal cursor to cover clean material on these
channels.

&
IV)  Inthe Calibration menu, select System 2 Then click C-scan, CursorUserMat, Click-on
, and Calibrate.
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V)  Repeat steps | and Il in a different area, until the user material calibration has been

1(‘

performed on all channels:

Partial user material calibration #1:

clean material on channels 1 through
17

Partial user material calibration #2:
clean material on channels 18
through 26

Partial user material calibration #3:
clean material on channels 27
through 64

Figure 95. Example of data without any area with clean material on all channels. Three partial
user material calibrations are required to calibrate all channels.

DETECTION OF AXIAL CRACKS

The detection of cracks is done mainly using the Processed C-Scan, in which the lift-off is
automatically compensated.

The green color represents the base material (amplitude close to 0.00 V). Cracks and crack-like
defects are associated to a positive signal that is proportional to their depth (in increasing order
of crack depth: yellow, orange, bright red, dark red). Areas of corrosion with missing material
are generally associated to a negative signal and displayed in white in the C-scan:
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White area d

(corrosion) Q

Axial cracking

Deepest point indications
(dark red)

Figure 96. Processed C-scan used for the detection of cracks

The color palette is a visual threshold directly related to the depth of the cracks. To enhance
the contrast of the cracks, the color scale can be lowered manually. However, this will also
enhance the noise caused by corrosion, permeability variations or other surface conditions. For
most typical cases of stress corrosion cracking (SCC), the color scale should be adjusted
between +0.50 V and +2.00 V for optimal results.

,”Color scale: +0.50 V B Color scale: +1.50 V

Figure 97. Same crack displayed with 2 different color scales

The strip chart below the C-scan represents a cross-section (side-view) of the C-scan. It can be
used to visualize the depth profile of the cracks. The options to display a single channel, all
channels inside the C-scan vertical cursor, or all 64 channels are available in the Current View
menu.

[[1.] ] Processes.) 1 200v [ 1]

Figure 98. Strip chart window displaying all 64 channels from the C-scan in Figure 57
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DEPTH SIZING AND REPORTING OF AXIAL CRACKS

Magnifi contains a powerful analysis tool that allows the automatic localization and
depth sizing of the deepest crack within a given SCC colony. To facilitate its use, make =

sure the Defect Tuning button in the Sharck menu is left unchecked. _F’Ef?‘—'t
uning

The software uses the area delimited by the C-scan cursor as the region of interest for
the detection of the deepest crack indication. Simply by changing the position and size of the
cursor, the user can choose to localize and measure the deepest indication either in an entire
SCC colony, or to focus only on a sub-area of a colony. The position of the deepest crack within
the cursor area is automatically indicated by a double triangle P 4:

2
~ e Deepest
lindication

Deepest
indication

Figure 99. Magnifi will localize and measure the depth of the deepest crack within a) the entire
SCC colony; b) only the lower-left section of the colony. For the situation in b), the analysis tool
can be used multiple times to localize and measure individually the deepest cracks within the
other sub-colonies.

Before analyzing either an entire SCC colony or a smaller sub-colony, Magnifi needs to define a
reference baseline in order to measure the maximum signal amplitude within the region of
interest and convert it into a depth measurement. This reference baseline is displayed as a
horizontal dashed line in the Lissajous and the strip chart windows. It is obtained from the
“clean” (i.e. defect free) material surrounding the cracks.

Defining the baseline correctly is key to obtain an accurate depth sizing of the cracks. To achieve
this, Magnifi offers two different options:

D) Automatic baseline calculation:
To use this option, go to the Sharck menu and make sure the Lock Baseline P>
button is left unchecked. /’E
Lock

The baseline calculation requires that the horizontal C-scan cursor is opened
large enough to include clean material on both sides of the SCC colony. The
signal from this clean material forms the “root” of the cracks signal in the Lissajous.

Bazeline
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The width of the cursor should be at least twice that of the colony. This will allow Magnifi
to define the reference baseline with the data points from the clean surface. If the
horizontal cursor is not opened large enough, Magnifi will use signal from SCC to define
the baseline, which will lead to an under-sizing of the crack’s depth.

55 T30 R-F1TR18 2.0 mm "

Correct baseline
0.68V 137.2°

EEEE D [ pr ] cre,

Compensated Depth (mm)

R-F1TR18 20mm—" 1.0 mm—

Incorrect baseline
(too high)
0.47V 116.6°

ESEYEED [ pr ] cre,

Compensated Depth (mm)

< [ »

Figure 100. a) The horizontal cursor includes enough clean material on both sides of the SCC
indication, allowing a correct baseline calculation and an accurate depth sizing of the crack
(0.8 mm (31.5 thou)); b) Horizontal cursor too narrow, leading to an incorrect baseline
calculation and major under-sizing of the crack’s depth (0.2 mm (7.9 thou)).

) Manual baseline adjustment:

To use this option, go to the Sharck menu and make sure the Lock Baseline

button is checked (grayed). ’ﬂ"z

Lock

The manual baseline adjustment is particularly useful to analyze large SCC | o — L

colonies without much clean material surrounding the indications. Locking the
baseline ensures that Magnifi never recalculates the baseline: it will stay at the same level
in the Lissajous, independantly of the C-scan cursor’s position and size. The user is
responsible of adjusting it by dragging it manually in the Lissajous window.
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Figure 101. Step one: place the cursor on a clean area and adjust the position of the baseline on
the “clean” signal by dragging it in the Lissajous; Step two: move the C-scan cursor on the
indication to be measured. The baseline level will remain unchanged and the depth sizing will
be accurate as long as the baseline is not moved again.

To the more practiced users, Eddyfi recommends to always keep the baseline locked and adjust
it manually before reporting an indication (option Il). When analyzing a large area or a large
SCC colony, it is important to make sure that the baseline level remains the same within the
whole area covered by the C-scan cursor. For that reason, it is recommended to analyze smaller
sub-colonies individually, and adjust the baseline manually each time. This will lead to more
accurate depth measurements.

Finally, the presence of corrosion or strong variations of permeability can make the baseline
more difficult to adjust. In these cases, the stripchart below the C-scan can be of great help:

Baseline aligned with the base of /’
the signal

Figure 102. Using the strip chart view can be useful to position the baseline at the right level.
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In summary, the procedure to measure the depth of axial cracks and add them to the report

goes as follows:

D) Place the cursor on the SCC indication to be measured, and adjust its size to cover only

the region of interest (either an entire SCC colony or a smaller sub-area);

Note: If a datafile contains no defect indication, you can click

Y

Mo Defect

ll)  Make sure the baseline is correctly adjusted (either automatically or manually);

) Use the indication code buttons in the lower right corner of the
Lissajous window (for example “CRK"” or “SCC") to add the automatic
analysis tool inside the region of interest. If the option “Take a screenshot with report

entry” is checked in the backstage, a screenshot will be taken at this point.

Note: To add or remove indication codes, go to Setup = Indication.

RK SCC

4 4

In the backstage of Magnifi, make sure the selected Table Profile in the Report options is Sharck
Array. With this option, the report will include the measured depth, position and local lift-off.
See below an example of the information reported in the case of an analysis by individual SCC

sub-colonies:

SCC-001
SCC-001
SCC-001
SCC-001
SCC-001

L= T B SR T

SCC-001

sCC
sCC
sCC
sCC
sCC
sCC

Size

0.9 mm
0.9 mm
0.8 mm
0.5 mm
0.4 mm

0.5 mm

Lift-Off
{mm)

0.1
0

X pos.
{mm)

274.5
281
280.3
293.3
306.3
319

Y pos.

{mm)

37.3
52
67.2
68.9
41.8
41.8

Figure 103. Summary table displayed on the first page of the report, containing information
about all the defects that were reported in the current inspection. This is usually followed by
individual screenshots and information of all the reported defects.
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LENGTH MEASUREMENT OF AXIAL CRACKS

The Sharck HR does not automatically measure the length of the cracks. However, it can be
measured manually:

[) Inthe C-scan, put the cursor on the axial crack to be measured
) Inthe strip chart, adjust the width of the cursor to the length of the crack’s signal

[l)  The center position of the cursor (X and Y) is displayed at the bottom of the screen. It
corresponds to the position of the crack relatively to the beginning of the scan.

IV)  The aperture of the horizontal cursor (Ax) is also displayed at the bottom of the screen. It
corresponds to the length of the crack.

Indication to measure

\HI

o

4 m

[ -] ] Processed | 1 oaov | 1]

Crack X and Y position

A% Crack length (Ax)

X (mm)  JAX (mm) @Y (mm) LY (mm) 15 (mm/s)
85.0 6.3 51 9.6 536.34

Correct cursor adjustment

Figure 104. Position and length measurement of an axial crack

In a similar way, the size of SCC colonies can be measured by opening the horizontal and vertical
C-scan cursors around it:

A
t;r;r;] —» Colony’s length
o E;r;] —» Colony’s width

Figure 105. Measurement of a SCC colony
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MAINTENANCE

To protect the probe from eventual damage and to ensure an accurate lift-off monitoring, the
probe should always be used with a 0.125 mm (4.9 thou) thick polyolefin layer covering its shoe.

When used on very rough surfaces, this protective polyolefin layer can wear out rapidly. Make
sure to replace it before the probe gets damaged.

Five replacement layers are provided with the probe. If a different material is used, it should be
0.125 mm (4.9 thou) thick. A layer with a different thickness will lead to inaccurate lift-off
measurements, and possibly to signal saturation.

Figure 106. Sharck HR with protective polyolefin layer and 5 spare parts

Note: When storing the probe, it is recommended to set the probe shoe flat.
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ENCODER CALIBRATION

If the encoder resolution included in the Magnifi setup is different from its real resolution, the
data in the C-scan will be slightly distorted (misalignment of indications and zigzag shapes, see
Figure 76 below). The length measurement and defect positioning can be affected.

In such a case, a simple calibration can be performed to apply a correction factor to the encoder
resolution:

[) Start an acquisition.
I[)  Move the probe in a straight line and on a flat surface and stop the acquisition.

Notel: A longer travel distance will lead to a more precise calibration.
Note2: It is not required to scan a metallic surface for this calibration.

[ll)  Measure precisely the traveled distance.

A

IV) Inthe Calibration menu, click on the Encoder -~ calibration button.
V)  Enter the measured traveled distance and click Enter.

VI) Click Calibrate and click OK. The correction factor is now applied to the setup
configuration.

5o BN R

Zigzag shapes due to wrong
encoder resolution

Figure 107. a) Before encoder calibration (small error on the encoder’s resolution); b) after
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This guide and the product and programs it describes are protected by the Copyright Act of Canada, by laws of other countries,
and by international treaties, and therefore may not be reproduced, in whole or in part, whether for sale or not, without prior
written consent from Eddyfi NDT, Inc. Under copyright law, copying includes translation in another language or format.

This document was prepared with particular attention to usage to ensure accuracy of the information contained therein. It
corresponds to the version of the product manufactured prior to the date appearing on the title page. There may, however, be
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